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1 安全と個人情報保護についての注意事項

この章では、本製品の使用目的、対象ユーザー、安全に関する情報および個人情

報保護について説明しています。

ETAS Safety Advice(Help > Safety Advice) とユーザードキュメントに記載され

ている安全上のご注意に従ってください。

1.1 安全に関する情報

本製品を使用する際には、作業者の負傷や物的損害などを避けるため、「ETAS 
Safety Advice - 安全上の注意事項」、および下記の注意事項をよくお読みいただ

き、その指示に従ってください。

1.2 本書の対象ユーザー

本書は、組み込み制御システムの機能領域およびソフトウェア開発を専門とす

る、訓練を受けた従業員向けの内容となっています。

INTECRIO を使用するユーザーは、Windows® 8、Windows® 8.1、Windows® 
10 の操作方法を理解している必要があります。メニューコマンドの実行やボタ

ン操作の方法に加え、Windows のファイルシステム、特にファイルやディレク

トリで構成される階層構造についての知識が必要です。また Windows ファイル

マネージャや Windows エクスプローラ等の使い方、さらに「ドラッグアンドド

ロップ」操作に習熟していることも必要です。

Microsoft Windows のマウスおよびキーボード操作に慣れていない方や、一般

的なファイルのナビゲーション方法についてご存知でない方は、まずそれらにつ

いて学習した後に INTECRIO をご使用いただくことをお勧めします。Windows 
オペレーティングシステムについての詳しい説明は、マイクロソフトのドキュメ

ントを参照してください。

INTECRIO がサポートしている BMT（ASCET や MATLAB/Simulink）について

の知識も必要条件となりますが、さらに、プログラミング言語、特に ANSI-C の

知識があれば、INTECRIO を一層効率的にご使用いただけます。

1.3 使用目的

INTECRIO は、車両組み込みコントロールシステムのプロトタイピング向けの統

合プラットフォームです。ASCET、MATLAB、Simulink、C コードなどのさま

ざまなソースから、ECU 上にアプリケーションソフトウェアを統合できます。

バーチャルプロトタイピングは、開発時間を短縮するということから、非常に重

要視されています。INTECRIO のバーチャルプロトタイピング能力を使用する

と、複雑なプロトタイピングハードウェアを必要とせずに、システムモデルの分

析が可能となります。

INTECRIO のラピッドプロトタイピング能力を使用すると、実際の状況下、また

実車両において、制御、診断機能の確認や検証が可能です。プロトタイプは、

ETAS ラピッドプロトタイピングハードウェアを介して、既存の ECU 車両ネッ

トワークに統合することができます。ETK、XETK、FETK、XCP を介したバイ

パスアプリケーションにおいて、INTECRIO は、ラピッドプロトタイピングハー

ドウェアがシミュレーションコントローラーとして使用され、ECU の新機能に

用いるパラメーターの計算をします。
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製品の不適切な使用や安全に関する注意事項に従わないことにより生じた一切の

損害について、ETAS GmbH は責任を負いません。

1.4 安全に関する注意事項の記述書式

安全に関する注意事項は以下の書式で記述されます。これらの情報は必ずよくお

読みいただき、指示に従ってください。

危険

記載事項を守らないと死亡または重傷のリスクが高い危険性について説明して

います。

警告

記載事項を守らないと死亡または重傷のリスクを招く可能性のある危険性につ

いて説明しています。

注意

記載事項を守らないと軽～中程度の負傷のリスクを招く可能性のある危険性に

ついて説明しています。

ご注意ください！

記載事項を守らないと物的損害を招く可能性のある状況について説明していま

す。
8
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1.5 安全に関する注意事項

ユーザーの怪我や所有物の損傷を回避するため、安全に関する注意事項（「ETAS Safety 
Advice - 安全上のご注意」）、および下記の注意事項をよくお読みいただき、その指示に

従ってください。

ETAS 製品を安全にご使用いただくための注意事項（「ETAS Safety Advice - 安
全上の注意事項」）は、以下の方法でもご覧いただけます。

• インストールパッケージで以下のファイルを開く

Documentation\General\ETAS Safety Advice.pdf

• プログラムで Help > Safety Advice を選択する

1.6 個人情報保護に関する注意事項

ユーザーの個人情報保護の問題は ETAS にとっても重要な案件であるため、本項

では、INTECRIO 内でどのようなデータが処理されるか、どのような種類のデー

タを INTECRIO が使用するか、また個人情報の保護のためにユーザー自身がどの

ような技術的対策を講じるべきか、といった内容について説明します。さらに、

本製品が個人データを保存する場所や、それらのデータの削除方法についても説

明します。

1.6.1 データの処理

本製品の使用時には、個人データが処理されます。本製品の購入者は、GDPR
（General Data Protection Regulation： EU の一般データ保護規則）の Article 4 
No. 7 に従ってデータ処理を行う法的責任があります。製造者である ETAS 
GmbH は、当該データの不適切な扱いに関して、いかなる場合も責任を負いま

せん。

1.6.2 データとデータカテゴリ

本製品は、エラー解析や外部プログラムとのやり取りなどの目的で、ソースライ

ブラリを参照するファイル名とパスを含むファイルを作成します。

警告

不適切に初期化された NVRAM 変数は、車両やテストベンチの予期しない挙動

を招く恐れがあり、そのような挙動により人身事故や物的損害が発生する危険

性があります。

E-Target（実験ターゲット）の NVRAM 機能を使用する INTECRIO システム

においては、ユーザー定義された初期化プロセス内で、すべての NV 変数の値

がカレントプロジェクトに対して有効な状態になっているかを、個々の NV 変

数単位および他の NV 変数との関連性においてチェックする必要があります。

もし有効な状態になっていない場合は、すべての NV 変数をデフォルト値（有

意で安全な値）に設定してください。

データ保存に関する NVRAM の特性から、不適切な初期値が使用されることに

より人体や装置が傷付けられる可能性のある環境内（車上やテストベンチな

ど）においてプロジェクトが使用される場合は、特にこの注意事項を厳守して

ください。
9
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ファイルの名前とパスがカレントユーザーの個人ディレクトリやそのサブディレ

クトリを参照している場合は、以下のように個人データがファイル名とパスに含

まれる可能性があります。

C:\Users\<UserId>\Documents\...

さらに、試験車両内で ETAS ラピッドプロトタイピングソリューションを用いて

実センサや車載バス、ECU などに接続すると、ETAS ツールは運転者の個人デー

タにアクセスすることが可能になります。

これらのデータは、INCA-EIP や ETAS Experiment Environment（ETAS 実験環

境）によりデータロガーに保存される可能性もあります。

また、ETAS ライセンスマネージャでユーザーベースライセンスを扱うと、以下

のような個人データが、ライセンス管理の目的で記録される可能性があります。

• 通信データ： IP アドレス

• ユーザーデータ：ユーザー ID、Windows のユーザー ID

1.6.3 技術的／組織的な対策

本製品は、個人データを記録する際に暗号化を行いません。記録されるデータの

機密保持のため、ユーザー側の IT システムに適した技術的対策または組織的対

策を講じてください。

ログファイル内の個人データは、オペレーティングシステムのツールを用いて削

除することができます。
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2 INTECRIO について

昨今の ECU 開発においては、実際のターゲットハードウェアが存在しない状態

で組込み制御ソフトウェアの制御アルゴリズムを開発しなければならない、とい

うケースが多くなっています。この際、アルゴリズムは ASCET や MATLAB®/
Simulink® などの BMT（Behavior Modelling Tool： 挙動モデリングツール）、

つまり、記述されたモデルからソフトウェアコードを生成できるツールを用いて

作成されます。そして、ターゲットハードウェアに代わるものとして ETAS の

ES800 システムなどのラピッドプロトタイピングハードウェアシステムが使用

されます。

ラピッドプロトタイピング用プラットフォームである「INTECRIO」は、組み込

み制御ソフトウェアの開発に携わるエンジニアの日々の作業を支援する、新しい

ETAS 製品ファミリです。

INTECRIO は、各種 BMT で生成されたコードを統合し、ラピッドプロトタイピ

ング用にモデルプロトタイプやハードウェアの構成をセットアップして、実行

コードを生成します。

本書は、INTECRIO 製品の概要説明とともに、迅速かつ確実な結果を得るための

情報を提供するものです。

2.1 システム情報

INTECRIO 製品ファミリは以下のコンポーネントで構成されています。

• INTECRIO-IP　

INTECRIO の統合プラットフォームです。各種 BMT で記述されたモデル

を統合してプロトタイプを生成するための機能がすべて含まれています。

またチュートリアルで使用するサンプルファイルと、サードパーティ製

I/O ハードウェアの設定と操作を行うためのサンプルコンフィギュレー

ションが、INTECRIO のインストール時に指定された <sample files>
ディレクトリ（21 ページ参照）にコピーされています。

製品パッケージには以下のコンポーネントが含まれています。

– プロジェクトコンフィギュレータ（Project Configurator）– ソフト

ウェアシステムとシステムプロジェクトを定義する際に使用されます。

– ハードウェアコンフィギュレータ（Hardware Configurator）– 
INTECRIO-RP または INTECRIO-VP とともに使用され、プロトタイピ

ングハードウェアの設定や、ハードウェアとソフトウェアの接続を行

います。

– OS コンフィギュレータ（OS Configurator）– オペレーティングシス

テムを設定する際に使用されます。

– プロジェクトインテグレータ（Project Integrator）– システムプロ

ジェクトのすべてのコンポーネントを結合して実行ファイルを生成す

る際に使用されます。

– ドキュメンタ（Documentor）– システムプロジェクトのコンポーネン

トについてのドキュメント生成に使用されます。

– MATLAB/Simulink 接続機能（MATLAB/Simulink Connectivity）– 
Simulink モデルを INTECRIO に統合してラピッドプロとタイピングを

行う際に必要な機能です。
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• INTECRIO-RP　 
INTECRIO のラピッドプロトタイピングパッケージです。以下の機能が含

まれています。

– ES900 接続機能（ES900 Connectivity）– 実験ターゲット ES910、お

よびハードウェアやソフトウェアの接続についての設定を行うための

機能です。

– ES800 接続機能（ES800 Connectivity）– 実験ターゲット ES830（+ 
ES891 ／ ES892 ／ ES882 ／ ES886）、およびハードウェアとソフト

ウェアの接続についての設定を行うための機能です。

• INTECRIO-VP 　
INTECRIO の仮想プロトタイピングパッケージです。以下の機能が含まれ

ています。

– VP-PC 接続機能（VP-PC Connectivity）– PC を仮想プロトタイピン

グターゲットとして設定し、使用するための機能です。

• ETAS Experiment Environment（ETAS 実験環境） 
ETAS 製品用の以下のアドオン製品は、INTECRIO に関連するものです。必要に

応じて個別にインストールしてください。

• ASCET Connectivity – ASCET モデルを INTECRIO に統合してラピッド

プロとタイピングを行うための機能です。

ASCET V6.3 以降では、ASCET Connectivity は ASCET-MD に統合され

ています。

ASCET V6.2 以前では、ASCET Connectivity の機能は INTECRIO のアド

オン「INTECRIO-ASC」として提供され、ASCET-MD 製品に同梱、また

は ASCET-RP の一部となっています。

2.2 本書の構成

INTECRIO のマニュアルは、個々の操作を説明する『オンラインヘルプ』、イン

ストールについての説明、機能の概説、チュートリアルなどを含む『入門ガイ

ド』、そして INTECRIO でのラピッドプロトタイピングについての詳しい技術情

報をまとめた『ユーザーガイド』で構成されています。

『INTECRIO 入門ガイド』の内容は以下のとおりです。

• 第 1 章 「安全と個人情報保護についての注意事項」

本製品の使用目的、対象ユーザー、安全に関する情報および個人情報保護

について説明しています。

• 第 2 章 「INTECRIO について」（本章）

INTECRIO の適用分野についての大まかな概要について説明しています。

• 第 3 章 「インストール」

INTECRIO の製品内容やハードウェア・ソフトウェア要件、および

INTECRIO のインストール、メンテナンス、アンインストールの方法を説

明します。

• 第 4 章 「INTECRIO クイックガイド」

INTECRIO の概念を簡単に紹介します。一般的な作業に沿った操作手順を

フローチャートで示し、INTECRIO の機能や動作について概説します。
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第 5 章 「INTECRIO チュートリアル」

サンプルファイルを用いて INTECRIO の実際の操作方法を説明するもの

で、主に INTECRIO を初めて使うユーザーを対象としています。チュー

トリアルはいくつかの短いレッスンに分かれていて、レッスン 7 までは、

各レッスンを順に行うことにより一連の基本操作を学習することができ、

レッスン 8 は独立した内容になっています。チュートリアルを始める際

は、あらかじめ『INTECRIO ユーザーガイド』の「INTECRIO を理解す

る」の章の内容を充分に理解しておいてください。

第 6 章 「ETAS ネットワークマネージャ」

ETAS ネットワークマネージャについての説明です。

第 7 章 「一般的なトラブルシューティング」

特定のソフトウェアやハードウェアに依存しない一般的なトラブルが発生

した際の対処方法を説明します。

第 8 章 「お問い合わせ先」

ETAS 本社および各国支社の連絡先です。

第 9 章 「用語集」

『INTECRIO 入門ガイド』（本書）と『INTECRIO ユーザーガイド』で使用

されている略語と用語についての説明です。

『INTECRIO ユーザーガイド』の内容は以下のとおりです。

• 「安全と個人情報保護についての注意事項」

本製品の使用目的、対象ユーザー、安全に関する情報および個人情報保護

について説明しています。

• 「INTECRIO について」

INTECRIO の大まかな概要と「ユーザーガイド」の目的を説明していま

す。

• 「INTECRIO を理解する」

INTECRIO システム、および INTECRIO がサポートする開発プロセスにつ

いて概説しています。初めて INTECRIO を使用する方は必ずこの章を最

初にお読みください。

• 「INTECRIO と AUTOSAR」

INTECRIO の AUTOSAR 対応機能についての概説です。

• 「INTECRIO のコンポーネント」

INTECRIO の各コンポーネントとその機能について説明しています。具体

的な操作方法はオンラインヘルプを参照してください。

• 「SCOOP と SCOOP-IX」

SCOOP というインターフェース記述の概念と、その記述言語である

SCOOP-IX について説明しています。

• 「モデリングのヒント」

INTECRIO におけるモデリングの概念を説明し、INTECRIO でラピッドプ

ロトタイピングを行うためには BMT でどのようなモデリングを行えばよ

いかを、具体的に紹介します。

注記

ETAS では、INTECRIO を短期間でより詳しく理解するためのユーザー

トレーニングをご提供させていただきます。詳しくは担当窓口までお問

い合わせください。
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• 「お問い合わせ先」

ETAS 本社および各国支社の連絡先です。

• 「用語集」

『INTECRIO 入門ガイド』（本書）と『INTECRIO ユーザーガイド』で使用

されている略語と用語についての説明です。

2.3 INTECRIO オンラインヘルプ

INTECRIO の詳しい操作方法は、製品に組み込まれているオンラインヘルプに記

載されています。

Help → Help メニューコマンド、または  ボタンで、すべてのトピックを含む

オンラインヘルプが開きます。またファンクションキー <F1> を押すと、現在の

状況に依存するトピックが開きます。

英語版： 

注記

製品インストール時には英語版オンラインヘルプがインストールされますが、

代わりに日本語版のヘルプファイルをご使用いただくこともできます。

日本語ヘルプファイルは、ETAS ホームページのダウンロードセンター

（https://www.etas.com/ja/products/download_center.php）からご提供さ

せていただいております。日本語版ヘルプファイルとそのインストール方法を

記載したテキストファイルを含む ZIP ファイルをダウンロードしてご利用くだ

さい。

なおバージョンによっては、日本語版ヘルプのリリース時期が遅れる場合や、

日本語版がリリースされない場合があります。詳しくはサポート窓口までお問

い合わせください。
14
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日本語版：

 ヘルプウィンドウの各タブから以下の操作が可能です。

• “ 目次 ” タブ： ヘルプトピックを、その内容から検索できます。

• “ キーワード ” タブ： ヘルプトピックの索引が表示され、キーワードを入

力して希望の用語を表示することができます。

• “ 検索 ” タブ： ヘルプトピックに含まれる語を検索できます。文字を入力

して検索を実行すると、その語を含むトピックの一覧が表示され、そこか

ら任意のページを開くことができます。

• “ お気に入り ” タブ : トピックをブックマークしておくことができます。

• “ 用語集 “ タブ： 専門用語とその定義が表示されます。

注記

日本語版マニュアルは ETAS ホームページのダウンロードセンター（https://
www.etas.com/ja/products/download_center.php）からご提供させていた

だいております。

なおバージョンによっては、日本語版マニュアルのリリース時期が遅れる場合

や、日本語版がリリースされない場合があります。詳しくはサポート窓口まで

お問い合わせください。
15
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3 インストール

この章では、オフラインまたはネットワーク経由での INTECRIO と ETAS 
Experiment Environment のインストール、メンテナンス、およびアンインス

トールを行う方法について説明します。またシステム管理者の方のための情報と

して、INTECRIO または ETAS Experiment Environment をファイルサーバーに

格納してネットワーク経由でインストールできるようにセットアップする方法に

ついても説明されています。さらに、製品の構成、インストールのためのハード

ウェア／ソフトウェア要件、インストール準備に関する重要な情報も含まれてい

ます。インストールとアンインストールの方法についても、順を追って詳しく説

明されています。

各項の内容は以下のとおりです。

• 必要条件（3.1 項）

• INTECRIO のインストール（3.2 項）

• ETAS Experiment Environment のインストール（3.3 項）

• ライセンス管理についての設定（3.4 項）

• ソフトウェアのライセンス取得（3.5 項）

• INTECRIO と ETAS Experiment Environment のアンインストール（3.6
項）

3.1 準備

インストールを行う前に、製品パッケージに含まれるすべてのアイテムが揃って

いること、また使用する PC がシステム要件を満たしていることを確認してくだ

さい。オペレーティングシステムやネットワーク環境によっては、特定のユー

ザー特権が必要な場合もあります。

3.1.1 パッケージの内容

INTECRIO の製品パッケージには以下のものが含まれています。

• INTECRIO インストールディスク

– INTECRIO のプログラムファイル

– 仮想プロトタイピングに必要な ETAS 仮想 OS 実行プラットフォーム

（ETAS Virtual OS Execution Platform）／ RTA ツールセット

– INTECRIO の入門ガイド（Getting Started）とユーザーガイド（User 
Guide）、および ETAS ハードウェアのマニュアル － PDF ファイル 1

– 安全上の注意事項 - PDF ファイル 1

– ETAS Experiment Environment（ETAS 実験環境）のプログラムファ

イル

– 『Licensing End User Guide』マニュアル － PDF ファイル 1

– HSP やデイジーチェーン・コンフィギュレータなどの最新のプログラ

ムファイルを提供するダウンロードサイトへのリンク

– MDA のプログラムファイル

– INTECRIO で使用されるオープンソース・コンポーネントについての

情報

さらに、INTECRIO または ETAS Experiment Environment を使用する際にはラ

イセンスが必要です。必要なライセンスファイルの取得については、社内のシス

テム管理者の方にお問い合わせいただくか、または ETAS にライセンスポータル
16
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サイト（URL は製品に同梱されているレターに記載されています）で発行するこ

とができます。なおこのサイトでライセンスを発行するには、製品出荷時に提供

されるアクティベーション ID が必要です。

1. 〉 PDF 閲覧ソフトが必要です。

3.1.2 システム要件

INTECRIO のシステム要件は、INTECRIO のリリースノートに記載されていま

す。

ETAS Experiment Environment のシステム要件は、28 ページの 3.3.1 項に記載

されています。

3.1.3 インストールと操作に必要なユーザー権利

INTECRIO または ETAS Experiment Environment を PC にインストールする

ユーザーには管理者特権が必要です。管理者特権が割り当てられていない場合

は、システム管理者の方にお問い合わせください。

INTECRIO を操作するユーザーには特別な権利は必要ありません。

ETAS Experiment Environment を操作するのに必要な権利は、使用するター

ゲットサーバーのバージョンによって異なります。

3.2  INTECRIO のインストール

INTECRIO を使用するには、必ず INTECRIO 統合プラットフォームをインストー

ルする必要があり、さらに用途に合わせたアドオン（ラピッドプロトタイピング

用アドオン／仮想プロトタイピング用アドオン）を個々にインストールします。

ETAS Experiment Environment（ETAS 実験環境）は、INTECRIO 統合プラット

フォームやそのアドオンとは独立しており、個別にインストールして使用するこ

とができます。ETAS Experiment Environment がなくても、INTECRIO でプロ

ジェクトを設定してコードを生成することはできますが、実験を実行することは

できず、Open Experiment Environment のツールバーボタンとメニューコマン

ドは使用できません。

INTECRIO と ETAS Experiment Environment のインストール方法は、外部メ

ディアからインストールする場合もネットワークドライブからインストールする

場合も、同じです。

本項では以下の内容について説明します。

• INTECRIO の初回インストールの方法（3.2.1 項）

• 仮想プロトタイピングパッケージのインストール方法（3.2.2 項）

• コマンドラインからインストールを行う際のオプション（3.2.3 項）

3.2.1 初回のインストール

操作手順 : INTECRIO のインストーラを起動する

INTECRIO に使用できるオペレーティングシステムの一覧は、INTECRIO リリー

スノートに記載されています。非対応の OS に INTECRIO をインストールしよう

とすると、エラーメッセージが表示され、インストール処理が強制終了します。

1. インストールディスクを PC の所定のドライブに挿入します。
17
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2. 以下のいずれかを行います。

- インストーラのウィンドウから ”Main” リンクをクリックし、

さらに ”INTECRIO V5.0.*” をクリックします。

- Windows エクスプローラでメディアドライブを開き、

Installationフォルダから setup.exeというファイ

ルを開きます。

ETAS インストーラが起動します。

3. Next ボタンをクリックして次のページに進みます。

前のページに戻るには Previous、インストールを中止するには 
Cancel をクリックします。

インストーラは、PC が INTECRIO のインストール要件を満た

しているかをチェックし、その結果を “System Check” ウィン

ドウに表示します。

要件が満たされている場合は、自動的に次のページに進みます。

操作手順 : 前回インストールしたバージョンをアンインストールする

INTECRIO V5.0.2 との互換性のないバージョンの INTECRIO が PC にインス

トールされている場合は、 "Uninstall previous products" ページが開き、その

バージョンが表示されます。 
1. Uninstall now をクリックします。

現在インストールされている INTECRIO がアンインストールさ

れ、INTECRIO V5.0.2 のインストールが行える状態になりま

す。

注記

互換性のないバージョンの INTECRIO がインストールされていない場合は、

「ライセンスに関する合意文書と安全に関する注意事項を確認する」（19 ペー

ジ）に進みます。
18
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2. アンインストールが完了したら、Next ボタンをクリックして次

のページに進みます。

操作手順 : ライセンスに関する合意文書と安全に関する注意事項を確認する

ライセンスに関する合意文書と安全に関する免責条項が、順に

表示されます。

1. “License Agreement” ページに表示されるライセンスに関する

合意文書の内容をよく読み、I read and accept the items in 
the license agreement チェックボックスをオンにして同意し

てください。

この文書に同意できない場合はインストールを続行できません。

2. Next をクリックします。

3. “Safety Hints” ページに表示される安全に関する免責条項をよ

く読み、I read and accept the safety hints オプションを選択

してください。

免責条項に同意できない場合はインストールを続行できません。

4. 以下のいずれかを行います。

- Next をクリックします。

次のページに進みます。

- Proceed to Install をクリックして直接 “Ready to install”
ページを開きます。この場合、インストールするコンポーネ

ントの選択やインストール先のパス、ループバックネット

ワークアドレスの指定はスキップされ、デフォルト設定が適

用されます。

23 ページの「INTECRIO をインストールする」に進みます。
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操作手順 : コンポーネントを選択する

次の "Installation" ページには、INTECRIO のコンポーネントや、インストール

に必要なサードパーティ製コンポーネント、ETAS の各種ツール（ライセンスマ

ネージャと ETAS 仮想 OS 実行プラットフォーム）が一覧表示されます。すでに

PC にイントールされているコンポーネントについては、右側に “Already 
Installed" と表示されます。

ここでは、インストールするソフトウェアの機能範囲を指定しますが、選択や選

択解除が行えるコンポーネントは、名前が黒字で表示されているものに限られま

す。

右側のテキストフィールドには、強調表示されているコンポーネントについての

情報が表示されます。

1. インストールするコンポーネントを選択、または選択解除する

には、それぞれ該当するオプションをアクティブ化、または非

アクティブ化します。

INTECRIO で使用するモジュールを Simulink で作成するような

場合は、Rapid Prototyping および Virtual Prototyping のいず

れのパッケージも必要ありません。

2. 以下のいずれかを行います。

- Next をクリックします。

次のページに進みます。

- Proceed to Install をクリックして直接 “Ready to install”
ページを開きます。この場合、インストール先のパス、ルー

プバックネットワークアドレスの指定はスキップされ、デ

フォルト設定が適用されます。

23 ページの「INTECRIO をインストールする」に進みます。

注記

INTECRIO でハードウェアシステムを作成して設定するには、

Rapid Prototyping と Virtual Prototyping のうち、少なくと

もいずれか一方のパッケージをインストールする必要があり

ます。
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操作手順 : パスを設定する

“Installation directly” ページの 1 ページ目では、ETAS 仮想 OS 実行プラット

フォームをインストールするディレクトリを指定できます。

1. ディレクトリのデフォルト設定を変更するには、新しいパスを

入力するか、または Browse ボタンで選択します。

無効なパスを指定した場合は、そのパスが赤字で表示され、警

告メッセージ（22 ページ参照）が表示されます。

2. Next をクリックします。

“Installation directly” ページの 2 ページ目では、INTECRIO をインストールする

ディレクトリ（“<installation>"として参照されます）とサンプルファイ

ルをインストールするディレクトリ（"<sample files>"として参照されま

す）、およびコンパイラをインストールするディレクトリを指定できます。

注記

ETAS Virtual OS Extension Platform がすでにインストールされている場合、

このページは開きません。
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3. ディレクトリのデフォルト設定を変更するには、新しいパスを

入力するか、または Browse ボタンで選択します。

無効なパスを指定した場合は、そのパスが赤字で表示され、警

告メッセージが表示されます。

4. 以下のいずれかを行います。

- Next をクリックします。

次のページに進みます。

- Proceed to Install をクリックして直接 “Ready to install”
ページを開きます。この場合、ループバックネットワークア

ドレスの指定はスキップされ、デフォルト設定が適用されま

す。

23 ページの「INTECRIO をインストールする」に進みます。

操作手順 : ループバックネットワークアドレスを入力する（仮想プロトタイピ

ング用）

バックアニメーション部分の仮想プロトタイピングパッケージ（“Virtual 
Prototyping”）をインストールする場合は、仮想ネットワークボードが自動的に

インストールされるので、このボードの IP アドレスを入力する必要があります。

1. “Loopback Adapter Network Address” ページで、IP アドレス

を設定します。

ここでは必ず、未使用のアドレスを指定してください。不明の

場合はシステム管理者の方にお尋ねください。

入力されたアドレスが無効の場合、警告メッセージが表示され

ます。

2. Next または Proceed to Install をクリックします。

注記

INTECRIO 内で使用されるコンパイラには空白文字を含むパスを使用できませ

ん。空白文字を含むコンパイラパスを指定すると、そのパスは無効なものとし

てマークされます。
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操作手順 : INTECRIO をインストールする

次の "Ready to install" ページには、インストールされるコンポーネントが一覧

表示されます。内容を変更するには、"Installation" ページ（20 ページの「コン

ポーネントを選択する」を参照）に戻る必要があります。

1. “Ready to Install ” ページの Install をクリックします。

選択したコンポーネント（20 ページ参照）がインストールされ

ます。すでにインストールされているコンポーネントはスキッ

プされます。インストールの進行状況は進捗バーに示されます。 

操作手順 : INTECRIO と MATLAB/Simulink を関連付ける

インストールが終了すると、“Associate with Matlab” ダイアログボックスが開

き、サポートされている MATLAB/Simulink のバージョン（R2016a ～

R2021b、および INTECRIO V5.0.2 のリリース時点でリリースされているそれら

のサービスパック）のうち、PC 上にインストールされているものが表示される

注記

次の操作によってインストール処理が実際に開始されます。開始後は Cancel 
ボタンが無効になり、インストールを中止することはできません。
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ので（下図の (A)）、実際に使用するバージョンをここで選択します。有効なバー

ジョンがインストールされていない場合も下図 (B) のように同じダイアログボッ

クスが開きます。

1. “Associate with Matlab” ダイアログボックスで、INTECRIO に

関連付けたい MATLAB/Simulink バージョンを選択します。

複数選択も可能で、1 つも選択しなくてもかまいません。

ここで Cancel をクリックすると、関連付けは行われずにダイ

アログボックスが閉じますが、MATLAB/Simulink 接続機能の

インストールは行われます。

2. OK をクリックします。

選択された MATLAB/Simulink バージョンが INTECRIO に関連

付けられます。

INTECRIO に関連付ける MATLAB/Simulink のバージョンは、

後で変更することができます。詳しくは INTECRIO ユーザーガ

イドの「MATLAB®/Simulink® 接続機能」の項を参照してくだ

さい。

操作手順 : インストールを完了する

選択されたコンポーネントがすべてインストールされると、インストール処理を

完了するためのキー入力が要求されます。

1. Show readme when setup is closed オプションをオンにしま

す（推奨）。

2. Finish をクリックしてインストールを終了します。

Windows のスタートメニューのアプリ一覧に、以下のようなアイテムを含む  
ETAS INTECRIO 5.0 フォルダが作成されます。

• INTECRIO V5.0　

INTECRIO を起動します。

注記

ネットワークドライブ上にインストールされた MATLAB/Simulink を使用する

場合は、Help ボタンをクリックし、表示されるメッセージに従って操作して

ください。

(A)

(B)
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• INTECRIO V5.0 - Tools フォルダ

– Associate with ASCET　

ASCET でコード生成を行う際に、どのバージョンの INTECRIO を対

象とするかを指定します。

– Associate with MATLAB　

インストールされている MATLAB/Simulink のバージョンを

INTECRIO に関連付けます。詳しくは INTECRIO ユーザーガイドの

「MATLAB®/Simulink® 接続機能」の項を参照してください。

この操作は、INTECRIO をインストールした後に MATLAB/Simulink
のみを新たにインストールした際などに必要となります。

• Manuals and Tutorials フォルダ

ETAS のドキュメントディレクトリを開きます。ここには INTECRIO のド

キュメントへのリンクが含まれています。

ETAS ライセンスマネージャを開くには、Windows スタートメニューのアプリ

一覧から E > ETAS > ETAS License Manager を選択します。

ETAS Virtual OS Execution Platform については、E > ETAS > ETAS Virtual OS 
Execution Platform <x>.<y> というフォルダに、以下のアイテムが作成されま

す。

• Signal Configuration Editor V<x>.<y>　
これは INTECRIO では使用されません。

<installation>ディレクトリ下の LicenseTermsフォルダに、

INTECRIO とともに配布されたオープンソース用ライセンス条件が保存されてい

ます。

PC のデスクトップには以下のアイコンが追加されます。

3.2.2 特殊なインストールの手順 : 仮想プロトタイピング（Virtual 
Prototyping）パッケージ

仮想プロトタイピング（バーチャルプロトタイピング）を行うには RTA-OSEK
ツール（“RTA-OSEK Tools”）と PC 用 RTA-OSEK（“RTA-OSEK for PC”）が必

要です。INTECRIO をインストールすると、仮想プロトタイピング用にこれらの

製品もインストールされます。（20 ページの「コンポーネントを選択する」を参

照してください）。

3.2.3 コマンドラインからのインストール

INTECRIO をコマンドラインからインストールすると、コマンドライン引数を使

用してインストールをカスタマイズすることができます。

インストールプログラム Setup.exeを実行すると、そのたびに以下の場所に

ログファイル <date_time> Setup.logが作成されます。

• C:\ProgramData\ETAS\SETUP\Logs　

以下に、Setup.exeで使用できるコマンドライン引数をご紹介します。
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/silent　

「サイレントモード」でインストールを行います。このモードにおいては

ユーザーの介入を必要とするダイアログボックスが開きません。

通常のインストールにおいてはダイアログボックスで入力される情報の代

わりに、所定のデフォルト値が使用されます。エラーメッセージも表示さ

れません。

/EULAAccepted　

ライセンスに関する合意文書に同意します。

ライセンスに関する合意文書は、インストールディスクの EULAサブ

フォルダ内に収められています。

/SafetyHintsAccepted　

安全に関する免責条項に同意します。

安全に関する免責条項の文書は、インストールディスクの

SafetyHintsサブフォルダ内に収められています。

/NoRestart　

インストール終了後に要求される PC の再起動を省略します。実際に再起

動が省略されると、ログメッセージが発行されます。

/AllowRestart　

インストール終了後に要求される PC の再起動を許可します。再起動が行

われる際には通知などは行われません。

/UninstallPreviousVersion　

インストール済みの旧バージョンの INTECRIO を自動的にアンインス

トールします。 

/UninstallPreviousVersionは /Uninstallと共には使用で

きません。

/Debug　

*.msiパッケージのログファイルが、C:\ProgramData\ETAS\
SETUP\Logsフォルダに作成されます。

注記

サイレントインストールにおいて EULA と免責条項（19 ページ参照）

に対して同意するには /EULAAcceptedと

/SafetyHintsAcceptedを使用します。

PC の再起動が要求された場合の対応を指定するには、引数

/NoRestart または /AllowRestartを使用します。

インストール済みの旧バージョンの INTECRIO を自動的にアンインス

トールするには、引数 /UninstallPreviousVersionを使用しま

す。

注記

この引数を使用しない場合、INTECRIO の旧バージョンが PC にインス

トールされていると、setup.exeは強制終了します。
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/DefaultSettings　

InstallationDefaultSettings.xmlの代わりに独自の XML
ファイルで以下のデフォルト設定を指定します。

ファイルが Setup.exeと相対位置にある場合は、相対パスで指定でき

ます。それ以外の場合は絶対パスで指定します。

構文： /DefaultSettings:"<path>¥<filename>.xml"

/Uninstall　

インストールされている INTECRIO をアンインストールします。

/silentと共に使用することにより、ユーザーの介入なしにアンインス

トールを実行することができます。

/Repair　

/silentと共に使用すると、修復処理を開始することができます。それ

以外の場合はメンテナンスモードが選択されます。

例 :
Setup.exe /silent /EULAAccepted /SafetyHintsAccepted　

サイレントインストールを開始します。

"C:¥Program Files (x86)¥ETAS¥GENericSetup¥IPE 
INTECRIO-IP¥5.0.<x>.<y>¥setup.exe" /uninstall /Debug　

サイレントモードではなく通常モードでアンインストールを開始し、詳細

なログを書き込みます。

変数 意味 参照

PRODINSTDIR インストールディレクトリ

21 ページPRODUSERDOCUMENTSDIR データディレクトリ

PRODCOMPILERDIR コンパイラディレクトリ

LOOPBACK_IP_ADDRESS ループバックアダプタの

IP アドレス

22 ページ

注記

インストールロケーションに setup.exeファイルがある場合は、

/Uninstallと /Repairは使用できません。これらの引数を使用す

る場合は、setup.exeを以下の場所に置いて実行する必要がありま

す。

C:¥<programs>¥ETAS¥GENericSetup¥IPE INTECRIO-

IP¥5.0.<x>.<y>　

<programs> = Program Files (x86)（64ビット OS）、また

は Program Files（32ビット OS）
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3.3 ETAS Experiment Environment（ETAS 実験環境）のイ

ンストール

3.3.1 Experiment Environment のシステム要件

3.3.2 初回のインストール

INTECRIO がインストールされていない場合、ETAS Experiment Environment
を使用して既存のプロジェクトの実験を行うことができますが、プロジェクトを

作成することはできません。

非対応のオペレーティングシステムに INTECRIO をインストールしようとする

と、エラーメッセージが表示され、インストール処理が強制終了します。

ETAS Experiment Environment は、システムドライブの Program Files 
(x86)\Common Filesにインストールされ、インストール先を変更するこ

とはできません。

操作手順 : ETAS Experiment Environment のインストーラを起動する

1. インストールディスクを PC の所定のドライブに挿入します。

2. 以下のいずれかを行います。

- インストーラのウィンドウから ”Main” リンクをクリックし、

さらに Experiment Environment をクリックします。

注記

必ず、使用する製品バージョンのリリースノートに記載された最新情報を確認

してください。

必要最低条件 推奨条件

ハード

ウェア

• PC: 1.5 GHz
• RAM: 2 GB
• DVD-ROM ドライブ

• イーサネットアダプタ : 10/
100BaseT

• グラフィックアダプタ : 32 
MB RAM、16 ビットカラー、

DirectX 7
• 画面解像度 : 1024x768

• PC: 2.0 GHz Multicore
• RAM: 8 GB
• DVD-ROM ドライブ

• 第 2 のイーサネットアダプタ : 
10/100BaseT

• グラフィックアダプタ : 256 
MB RAM、32 ビットカラー、

DirectX 7 以上、HW アクセラ

レーション

• 画面解像度 1600x1200
OS Windows® 8.1 (x64)、

Windows® 10 (x64)　
Windows® 10® (x64)

ディスク

空き容量

1.8 G 2 GB 以上
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- Windows Explorer で DVD の

ExperimentEnvironmentフォルダを開き、

setup.exeファイルを実行します。 
ETAS インストーラが起動します。

3. Next ボタンをクリックします。

インストーラは、PC が ETAS Experiment Environment のイン

ストール要件を満たしているかをチェックし、その結果を

“System Check” ウィンドウに表示します。

要件を満たしている場合は、自動的に次のページに進みます。
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操作手順 : ライセンスに関する合意

ライセンスに関する合意文書が表示されます。

1. ライセンスに関する合意文書の内容をよく読み、I read and 
accept the terms in the license agreement チェックボックス

をオンにして同意してください。

この文書に同意できない場合はインストールを続行できません。

2. 以下のいずれかを行います。

- Next をクリックします。

次のページに進みます。

- Proceed to Install をクリックして直接 “Ready to install”
ページを開きます。この場合、インストールするコンポーネ

ントの選択はスキップされ、デフォルト設定が適用されま

す。

31 ページの「ETAS Experiment Environment をインストー

ルする」に進みます。
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操作手順 : INCA バージョンの選択 :
"Associate to INCA" ページには、PC にインストールされている INCA のバー

ジョンのうち、ETAS Experiment Environment と同じターゲットサーバーにア

クセスするものが一覧表示され、Default (No INCA connection)が選

択された状態になっています。

1. ETAS Experiment Environment に関連付けたい INCA のバー

ジョンを選択します。

2. Next または Proceed to Install をクリックします。

操作手順 : ETAS Experiment Environment をインストールする

次の "Ready to install" ページには、インストールされるコンポーネントが一覧

表示されます。
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1. “Ready to Install ” ページの Install をクリックします。

各コンポーネントがインストールされます。インストールの進

行状況は進捗バーに示されます。 

操作手順 : インストールを完了する

選択されたコンポーネントがすべてインストールされると、インストール処理を

完了するためのキー入力が要求されます。

1. Finish をクリックしてインストールを完了します。

Windows スタートメニューのアプリ一覧に、以下のアイテムを含むフォルダ E 
> ETAS Experiment Environment <x>.<y> （<x>.<y> はバージョン番号）が作成

されます。

• Experiment Environment V<x>.<y> 　
ETAS Experiment Environment を起動します。

• Experiment Environment <x>.<y> Tools フォルダ

以下のショートカットを含むフォルダが開きます。

– Associate to INCA　

ETAS Experiment Environment と共に使用する INCA のバージョン

（および共有モジュールのバージョン）を指定します。

– Associate to RTA-TRACE

RTA-TRACE のインストール状況を調べます。問題がある場合はその

内容が表示されます。

• INCA <a> .<b> Target Server - Tools　
以下のショートカットを含むウィンドウを開きます。

– ETAS Network settings　
ETAS ネットワークの設定ツールを起動します。

– Search for connected hardware　

ターゲットサーバーが起動し、PC に接続されているハードウェアが検

索されます。

• Manuals and Totorials フォルダ

ETAS ドキュメントフォルダを開きます。ここに ETAS Experiment 
Environment のユーザードキュメントが保存されています。

– Instrument Programming　

ユーザー定義のインストゥルメントをプログラミングして ETAS 
Experiment Environment に組み込む際に必要となる情報が記載され

たオンラインヘルプが開きます。

– Online Help　

ETAS Experiment Environment のオンラインヘルプを開きます。

– Scripting API　
ETAS Experiment Environment のスクリプト用 API についてのオン

ラインヘルプを開きます。

注記

次の操作によってインストール処理が実際に開始されます。開始後は Cancel 
ボタンが無効になり、インストールを中止することはできません。
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PC のデスクトップには以下のアイコンが追加されます。

さらに、同じ ETAS プログラムグループ内に SMF エディタの専用フォルダ

SMFEditor <x>.<y> が作成され、以下のアイテムが格納されます。この SMF エ

ディタは LABCAR 関連のツールで、INTECRIO とともに使用するものではあり

ません。

• SuT Mapping File Editor　
SMF エディタを開きます。

• SMFE Online Help　

SMF エディタのオンラインヘルプを開きます。

3.3.3 コマンドラインからのインストール

ETAS Experiment Environment をコマンドラインからインストールには、以下

のようなコマンドライン引数を使用してインストールをカスタマイズすることが

できます。

Setup.exeが実行されるたびに以下のログファイルが作成されます。

%appdata%1 ¥ETAS¥SETUP¥<date_time> Setup.log

/silent

「サイレントモード」でインストールを行います。このモードにおいては

ユーザーの介入を必要とするダイアログボックスが開きません。

通常のインストールにおいてはダイアログボックスで入力される情報の代

わりに、所定のデフォルト値が使用されます。エラーメッセージも表示さ

れません。

/EULAAccepted　

ライセンスに関する合意文書に同意します。

ライセンスに関する合意文書は、インストールディスクの

ExperimentEnvironment¥EULAサブフォルダ内に収められていま

す。

1. %appdata% = 
C:¥Users¥<username>¥AppData¥Roaming

注記

サイレントインストールにおいて EULAと免責条項（30 ページ参照）

に対して同意するには /EULAAcceptedと

/SafetyHintsAcceptedを使用します。

PC の再起動が要求された場合の対応を指定するには、引数

/NoRestart または /AllowRestartを使用します。

インストール済みの旧バージョンの ETAS Experiment Environment を

自動的にアンインストールするには、引数

/UninstallPreviousVersionを使用します。
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/SafetyHintsAccepted　

安全に関する免責条項に同意します。

安全に関する免責条項の文書は、インストールディスクの

ExperimentEnvironment¥SafetyHintsサブフォルダ内に収め

られています。

/NoRestart　

インストール終了後に要求される PC の再起動を省略します。実際に再起

動が省略されると、ログメッセージが発行されます。

/AllowRestart　

インストール終了後に要求される PC の再起動を許可します。再起動が行

われる際には通知などは行われません。

/UninstallPreviousVersion　

インストール済みの旧バージョンの INTECRIO を自動的にアンインス

トールします。 

/UninstallPreviousVersionは /Uninstallと共には使用で

きません。

/Debug　

*.msiパッケージのログファイルを書き込みます。 
ファイルは %appdata%1 ¥ETAS¥SETUPフォルダに書き込まれます。

/DefaultSettings　

InstallationDefaultSettings.xmlの代わりに独自の XML
ファイルでデフォルト設定を指定します。

ファイルが setup.exeと相対位置にある場合は、相対パスで指定でき

ます。それ以外の場合は絶対パスで指定します。

構文： /DefaultSettings:"<path>¥<filename>.xml"

/Uninstall　

インストールされている ETAS Experiment Environment をアンインス

トールします。/silentと共に使用することにより、ユーザーの介入な

しにアンインストールを実行することができます。

C:¥<programs>2 ¥ETAS¥GENericSetup¥EE EE 

Standalone¥3.7.<x>.<y> フォルダに収められている

setup.exeファイルを使用します。

例 :
Setup.exe /silent /EULAAccepted /SafetyHintsAccepted　

サイレントインストールを開始します。

注記

この引数を使用しない場合、INTECRIO の旧バージョンが PC にインス

トールされていると、setup.exeは強制終了します。

1. %appdata% = 
C:¥Users¥<username>¥AppData¥Roaming

2. <programs> = Program Files (x86)（64 ビット OS）、または 
Program Files（32 ビット OS）
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"C:¥P<programs>1 ¥ETAS¥GENericSetup¥EE EE Standalone¥
3.7.<x>.<y>¥setup.exe" /uninstall /Debug　↵
サイレントモードではなく通常モードでアンインストールを開始し、詳細

なログを書き込みます。

setup.exe /DefaultSettings:"D:¥myOwnSettings.xml"　

サイレントモードではなく通常モードでインストールを開始し、カスタマ

イズされたデフォルト設定でインストールを実行します。

3.4 ライセンス管理に関する設定

INTECRIO をインストールすると、同時に ETAS ライセンスマネージャもインス

トールされます。*.iniファイルの [Licensing]セクションを編集するこ

とにより、INTECRIO（および他の ETAS ソフトウェアプログラム）がライセン

スにアクセスする方法を指定することができます。

インストールディスクには、このような *.iniファイルが 2 つ含まれていて、

1 つが INTECRIO 用、もう１つが ETAS Experiment Environment 用です。ファ

イル名はどちらも Licensing.iniです。 
INTECRIO 用の Licensing.iniの場所は

InstallationDefaultSettings.xmlファイルにおいて、INTECRIO
パッケージ Licenseの LIMA_INIFILE変数で指定されています。

ETAS Experiment Environment 用の Licensing.iniは、

ExperimentEnvironment¥Packages¥EE License_3.7.<x>.<y>

フォルダに格納されています。

一般的な手順

Licensing.iniファイルを編集してインストールを開始する手順は、インス

トール用ファイルが置かれている場所に応じて異なります。

（この手順を行うユーザーが）編集できないディレクトリにインストール用ファ

イルが置かれている場合：

以下のいずれかの手順で行います。

• すべてのインストール用ファイルを、編集可能なディレクトリにコピーし

ます。

その場所で Licensing.iniを編集し（36 ページ参照）、

Autostart.exeまたは setup.exe（3.2.1 項と 3.3.2 項を参照）を

ダブルクリックするか、またはコマンドラインから（3.2.3 項と 3.3.3 項

を参照）インストールを開始します。

• ユーザーが編集できるディレクトリに、Licensing.iniファイルのみ

をコピーします。

そこで Licensing.iniファイルを編集します （36 ページ参照）。 さ

らに独自の XML ファイルを作成し、デフォルト設定（34 ページ参照）を

定義し、編集した Licensing.iniファイルの場所を

LIMA_INIFILE変数で指定します。

1. <programs> = Program Files (x86)（64 ビット OS）、または 
Program Files（32 ビット OS）
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<Variable ¿
name="LIMA_INIFILE" ¿
defaultValue="<path>¥Licensing.ini" ¿
validation="fileExists" />

コマンドラインからインストールを開始し（3.2.3 項と 3.3.3 項を参照）、

その際に以下の引数を使用して、独自の、Licensing.iniファイルの

場所を指定した上記の XML ファイルを指定します。

/licconf="<absolute path>¥<filename>.ini" 

（この手順を行うユーザーが）編集できるディレクトリにインストール用ファイ

ルが置かれている場合：

Licensing.iniを編集し（36 ページ参照）、インストールを開始します。

*.iniファイルの編集

以下に Licensing.iniの編集方法を説明します。

操作手順 : ライセンスへのアクセス方法を指定する

1. テキストエディタで .iniファイルを開きます。

2. 要件にあわせて [Licensing] セクションを編集します。 
このセクションで使用できるパラメータとその設定については

以下を参照してください。

3. 変更内容を保存します。

[Licensing]セクションで使用できるパラメータ :
• LicenseFileName　

追加するライセンスファイルの完全なパスと名前

• LicensesToBorrow　

ライセンスサーバーからライセンスを借用できる場合、このパラメータを

使用して借用メカニズムについて設定することができます。借用メカニズ

ムを有効にするには、ここに製品または機能のライセンス名（例： 
INTECRIO）を指定します。2 つ以上のライセンスを指定するには、各ラ

イセンス名をスペースで区切って入力してください。

INTECRIO と ETAS Experiment Environment では以下のライセンスが使

用されます。

ライセンス名 機能

INTECRIO INTECRIO プロトタイピング環境a

INT_ASC ASCET 接続機能b

INT_ECC MATLAB/Simulink Embedded Coder 接

続機能 a

INT_RTA-RTE2.0 AUTOSAR-RTE - プロトタイピング用c

INT_SLC MATLAB/Simulink 接続機能 a

INT_TC_RTT RTA-Trace 接続機能 a, d

INT_UCC_ES900 ES900 接続機能e

INT_UCC_PC VP-PC 接続機能f

INT-VIP ETAS 仮想 OS 実行プラットフォーム e

LD_RTA-OS_VRTA_SC34 仮想プロトタイピング用 RTA-OSEK バリ

アント e
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• BorrowExpiryMode　

借用期限の指定方法を選択します。

– Date　

借用期間は、BorrowExpiryDateで指定された日付に満了します。

– Interval　

借用期間は、BorrowExpiryIntervalで指定された日数を経過

した時点で満了します。

• BorrowExpiryDate　

BorrowExpiryModeが Dateに設定されている場合、このパラメータ

で借用期間の終了日を指定します。フォーマットは yyyy-mm-ddです。

• BorrowExpiryInterval　

BorrowExpiryModeが Intervalに設定されている場合、このパラ

メータで借用日数を指定します。

• ExecuteBorrowAutomaticExtensionInterval　

借用期間を自動延長するタイミングを指定します。借用期間の残日数がこ

のパラメータで設定された日数になると、

BorrowAutomaticExtensionIntervalで指定された日数だけ自

動的に期間が延長されます。

• BorrowAutomaticExtensionInterval　

借用期間を自動延長する日数を指定します。

• ImmediateBorrow　

ライセンスの自動借用を行うかどうかを指定します。

EE ETAS Experiment Environment（ETAS
実験環境）

INT_RP_EE INTECRIO と ETAS Experiment 
Environment によるラピッドプロトタイ

ピング

INT_VP_EE INTECRIO と ETAS Experiment 
Environment による仮想プロトタイピン

グ

INT_UCC_LCO_FIL, 
LCS_LCO_CCI, 
LCS_LCO_LCE, 
LCS_LCO_LCX

ETAS Experiment Environment と

INTECRIO との組み合わせにおいては使

用されません。

a. INTECRIO 統合プラットフォームに同梱

b. ASCET に同梱

c. RTA-RTE（INTECRIO プラットフォームに同梱）

d. RTA-TRACE は 廃止となる製品です。このライセンスは、すでにインス
トールされている製品用のものです。

e. INTECRIO-VP（仮想プロトタイピング）の一部

f. INTECRIO-RP（ラピッドプロトタイピング）の一部

ライセンス名 機能
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– True　

インストール時に自動的にライセンスの借用が行われます。

– False　

プログラムが初めてライセンスサーバーに接続した際にライセンスの

借用が行われます。

• CustomLicenseFolder　

追加されるライセンスファイルのデフォルトの格納場所（例： Windows 7
の場合は C:¥ProgramData¥ETAS¥FlexNet）に管理者権限を持つ

ユーザーしか書き込みができない場合、このパラメータで別のパスを指定

することができます。

以下の例のように設定すると、INTECRIO についてライセンス借用が有効になり

ます。INTECRIO の初回起動時にライセンスの借用が行われ、デフォルト状態に

おいては 100 日後に借用期間が終了します。

[Licensing]

LicenseFileName = ’d:¥licenses¥MyLicense.lic’

LicensesToBorrow = ’INTECRIO’

BorrowExpiryMode = ’Interval’

BorrowExpiryInterval = ’100’

ImmediateBorrow = ’false’

3.5 ソフトウェアのライセンスを取得する

INTECRIOの使用には有効なライセンスが必要です。ライセンス取得に必要な

ライセンスファイルは、ツールの管理者、もしくは ETASのインターネットサイ

トにあるセルフサービスポータル (https://www.etas.com/support/licensing)
から取得できます。ライセンスファイルの要求には、注文時に ETASから配布さ

れたアクティベーション番号の入力が必要です。

Windows スタートメニューのアプリ一覧から E > ETAS > ETAS License Man-
ager を選択し、ダイアログに表示される指示に従ってください。ETAS のライ

センスモデルについての説明や、ライセンスの借用などの詳しい説明について

は、ライセンスマネージャで、<F1> キーを押して情報を参照してください。

3.6 アンインストールする

INTECRIO をアンインストールすると、インストールされているすべてのコン

ポーネントとアドオン（ターゲットサーバーと ETAS Experiment Environment
を除く）が自動的にアンインストールされます。

INTECRIO または ETAS Experiment Environment のアンインストールは、以下

のいずれかの方法で開始します。

1 Windows コントロールパネルの プログラムの追加と削除 または プログ

ラムと機能 を使用する

注記

ImmediateBorrow=’True’ は、インストールを行うユーザー

に対してのみ有効です。借用されたライセンスは、同じ PC を使用

する他のユーザーには使用できません。
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2. コマンドライン引数として /Uninstallを使用する（27 ページと 34
ページを参照）

操作手順 : INTECRIO または ETAS Experiment Environment をアンインス

トールする

1. 上記のいずれかの方法でアンインストールを開始します。

ETAS アンインストーラが起動します。

2. Next ボタンをクリックして次のページに進みます。

前のページに戻るには Previous、インストールを中止するには 
Cancel をクリックします。

PC がアンインストール要件を満たしているかがチェックされ、

その結果が “System Check” ページに表示されます。

PC がアンインストール要件を満たしているかがチェックされ、

その結果が “System Check” ページに表示されます。

要件が満たされていると、"Ready to uninstall" ページが開き、

アンインストールされるコンポーネントが一覧表示されます。

この内容は変更できません。

ETAS 仮想 OS 実行プラットフォームとライセンスマネージャ

のアンインストールは、他のプログラムによって使用されてい

ない場合にのみ可能です。

注記

次の操作によってアンインストール処理が実際に開始されます。開始後は 
Cancel ボタンが無効になり、アンインストールを中止することはできません。
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3. Uninstall をクリックしてアンインストールを実行します。

処理の進行状況は進捗バーに表示されます。

すべてのコンポーネントのアンインストールが終了すると、以

下のページが開きます。

4. Finish をクリックしてインストールを終了します。

操作手順 : ターゲットサーバーをアンインストールする

1. Windows コントロールパネルの プログラムと機能 を使用して、

ETAS Target Access – <x>.<y>のアンインストールを

開始します。

2. 安全に関する質問が表示されたら、メッセージを確認して Yes 
をクリックします。

Windows インストーラが開きます。

3. 表示されている注意事項をよく読み、Automatic または 
Custom を選択します。

ご注意ください！

ターゲットサーバーのみをアンインストールすると、ターゲットへのダウン

ロードが実行できなくなります。この場合、INTECRIOとETAS Experiment 
Environmentを起動することはできますが、エラーメッセージが発行されま

す。
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4. Next をクリックします。

Automatic を選択した場合は、ターゲットサーバーがアンイン

ストールされます。

Custom を選択した場合は、表示されるメッセージに従って操

作を行います。

5. アンインストールを中止するには、Windows インストーラの 
Cancel ボタンをクリックします。

アンインストールが中止され、削除されたファイルが復元され

ます。
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4 INTECRIO クイックガイド

4.1 はじめに

本章は、INTECRIO V5.0 の主要な機能をご理解いただくための「クイックガイ

ド」です。INTECRIO で ECU ソフトウェアのプロトタイプ開発を行うためのさ

まざまな作業とその操作方法の概要を紹介します。開発手順に沿って、各作業の

おおまかな手順をフローチャートで示し、その右側に操作方法を図示していま

す。図中の黒い矢印の付いた破線は、操作とその結果を示し、赤い矢印の付いた

実線は、操作を行うボタンやオプションなどの場所を示しています。

以下に、本章で用いられている主要な略語について簡単に説明します。

• BMT – Behavioral Modeling Tool（挙動モデリングツール）

• EE – ETAS Experiment Environment（ETAS 実験環境）

• ES – Environment System（環境システム）

• HBB – Hook-based bypass（フックベースバイパス）

• ISR – Interrupt Service Routine（割り込みサービスルーチン）

• HC – Hardware Configurator（ハードウェアコンフィギュレータ）

• HW – Hardware（ハードウェア）

• HWS – Hardware System（ハードウェアシステム） 
• PC – Project Configurator（プロジェクトコンフィギュレータ）

• PI – Project Integrator（プロジェクトインテグレータ）

• OSC – OS Configurator（OS コンフィギュレータ）

• RE – Runnable Entity（ランナブルエンティティ、「ランナブル」とも呼ば

れます）

• RP – Rapd Prototyping（ラピッドプロトタイピング）

• SBB – Service-based bypass（サービスベースバイパス）

• SP – System Project（システムプロジェクト）

• SWC – 「レガシー AUTOSAR モジュール」、つまり INTECRIO ワークス

ペースにインポート済みの AUTOSAR Software Component（AUTOSAR
ソフトウェアコンポーネント） 

• SWS – Software System（ソフトウェアシステム）

• VP – Virtual Prototyping（仮想プロトタイピング）

• WS – Workspace（ワークスペース）
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4.2 新しいワークスペースの作成

ワークスペース（WS）の主な役割は、INTECRIO での作業時に作成されたデー

タ（モジュール、ファンクション、ハードウェア／ソフトウェアシステム、シス

テムプロジェクト、実験）をデータベース形式で体系的に格納し、各データを明

解なインターフェースで管理することです。ワークスペースにおいては、

Windows エクスプローラと同様に、フォルダやアイテムの新規作成、移動、コ

ピー、インポート／エクスポートが行え、またワークスペース自体を新規作成す

ることもできます。

以下のデータはワークスペース内で管理されます。

• ファンクション

• ハードウェア／ソフトウェアシステム

• システムプロジェクト

以下のデータはワークスペース内では管理されません。

• *.c、*.h、*.a2lファイル

• *.a2l.codファイル

• 測定ファイル（*.dat）

INTECRIO では、複数のワークスペースを使用することができます。ワークス

ペースのデータ量が極端に大きくなると、システムパフォーマンスが低下してし

まう可能性があるため、作業ごとに個別のワークスペースを作成することをお勧

めします。これによって 1 つの作業で使用されるデータ量を小さく抑え、扱いや

すくすることができます。

一般的に、新しい作業を開始する際は、まず新しいワークスペースを作成し、そ

こに必要なデータを割り当てて具体的なプロジェクトを構成していきます。これ

により、必要なデータのみで構成された簡潔な作業環境を実現できます。

図 4-1 ワークスペースを作成する

ワークスペースの作成

fkqb`oflを起動

tpを作成 File >New Workspace（または ボタンか <CTRL> + 
<N>）、WS の名前とパスを入力し、OK
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4.3 モジュールの準備とインポート

INTECRIO で実験を行うには、実際に機能するソフトウェアモジュールが必要で

す。各種 BMT を用いて作成されたモジュールをインポートして INTECRIO 上で

使用できるようにするには、各モジュールを各種記述ファイル（*.c、*.a2l、
*.six）の形式にエクスポートしたものが必要です。

ワークスペース内において、モジュールは */Modulesフォルダに格納されま

す。

4.3.1 モジュールの準備

図 4-2 モジュールを作成する

モジュールの準備

ターゲットを選択

_jqでモジュールを

作成

コード生成オプション

を設定

コード生成

Build > Transfer、または ボタン

INTECRIO 実験を選択

Simulink® の場合：
make ファイル：
irt_default_tmfまたは
ier_default_tmf
ターゲット：
irt.tlcまたは ier.tlc

値を入力し、
OK　

ソルバ： Fixed-step

ASCET の場合：
プロジェクトエディタ : 
ターゲット ES910/Prototyping、
コンパイラ Gnu-C V3.4.4 
(PowerPC)/QCC V6.5 を選択

Simulink® の場合 :
Tools > C/C++ Code > Build Model、 <CTRL> + <B>、  
ボタンのいずれか
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4.3.2 モジュールのインポート

モジュールのインポート時には、インターフェース記述ファイル（*.six）の

みが読み込まれます（『INTECRIO ユーザーガイド』の「SCOOP と SCOOP-IX」

の項を参照してください）。

図 4-3 モジュールをインポートする

注記

INTECRIO V5.0.2 における AUTOSAR のサポートは限定的なものになります。

「レガシー AUTOSAR モジュール」を含む既存のワークスペースはサポートさ

れますが、AUTOSAR ソフトウェアコンポーネントを新たにインポートするこ

とはできません。

インポートしたモジュールが WS ブラ
ウザに表示される

モジュールのインポート

tpブラウザで
Modulesフォルダを

選択

p`llmJfuファイルを

インポート

m`上にモジュールを

表示

WS ブラウザ： 
Software/Modulesまたは
Environemnt/Modulesフォル
ダを選択し、
ショートカットメニューからImport 
Module または Import 
Environment Module を選択 （また

は  /  ）

SCOOP-IX ファイルを読み込むた
めのダイアログボックスが開くの
で、*.sixファイルを選択し、

Open

WS ブラウザ：
モジュールを選択し、
ショートカットメニューで 
Open in View

モジュールが PC（プロ
ジェクトコンフィギュレー
タ）に表示される
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4.4 ファンクションの作成

関連する複数のモジュールや「レガシー SWC」をまとめて 1 つの「ファンク

ション」に割り当てることにより、モデルがより明確になり、再利用しやすくな

ります。ファンクションはモジュールの構造化を行うためのアイテムで、それ自

体の機能はありません。ファンクションに含めることができるのは、モジュール

または SWC のみで、両者の混在も可能です。ワークスペース内において、ファ

ンクションは Software/Functionsフォルダに格納されます。

図 4-4 ファンクションを作成する

WS ブラウザ：
Software/Functionsまた
は Environment/
Functionsフォルダを選択し、
ショートカットメニューから
Create Function または Create 
Environment Function を選択

（または  /  ）

ダイアログボックスに
ファンクション名を入力し、
OK をクリック

WS ブラウザ：
ファンクションを選択し、
ショートカットニューから
Modules を選択

“Unused modules” フィールドから
モジュール /SWC を選択し、

、OK をクリック

ファンクションの作成

ファンクションに
含めるモジュール／

pt`を選択

ファンクションを作成

Functionsフォルダ

を選択
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次に、ファンクション内のモジュールまたは SWC 間の接続や、ファンクション

外部との接続のためのポートを、手動操作で定義します。1

図 4-5 SWC を含まないファンクションを定義する

1. Scalar in/out： モジュール

Sender/Receiver ／ Server/Client： AUTOSAR SWC

WS ブラウザ： ファンクションをダブルクリック

PC（プロセスコンフィギュレータ）： ショートカットメ
ニュー Create Port > Scalar In Port    
Create Port > Scalar Out Port   

接続ウィザード：
ポートタイプを選択 (1)1.

出力を持つコンポーネント (2)、
入力を持つコンポーネント (3)、
入力 / 出力 (4) を選択し、

ボタンをクリック

（同名のポートを自動接続するには  
をクリック）

WS ブラウザ：
ファンクションを選択し、
ショートカットメニューから
Open in Connection View を選択
して接続ウィザードを開く

接続モードを “Dynamic” に設定

PC： ソース（シンク）をクリックし、シンク（ソース）ま
でラインを引く

pt`を含まないファンクション

の設定

m`上に

ファンクションを表示

ポートを挿入

ソースとシンクを接続

接続ウィザードを使用

(2) (3)

(4)

(1)
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図 4-6 SWC を含むファンクションを定義する1

1. Scalar in/out： モジュール
Sender/Receiver ／ Server/Client： AUTOSAR SWC

pt`を含むファンクション

の設定

m`上に

ファンクションを表示

^rqlp^oポートを

挿入

^rqlp^oポート間を

接続

接続ウィザードを使用

「混合」ファンクション

内の接続とポートを定義

センダ（レシーバ）をクリックしてレシーバ（センダ）までラ
インを引く
クライアント（サーバー）をクリックしてサーバー（クライア
ント）までラインを引く

WS ブラウザ： ファンクションをダブルクリック

PC（プロセスコンフィギュレータ）： 
センダ（レシーバ）またはクライアント（サーバー）をクリッ
クして空白部分までラインを引き、Create Port を選択 
  AUTOSAR ポート

/ / /  が追加される

接続ウィザード：
ポートタイプを選択 (1)1.、
出力を持つコンポーネント (2)、
入力を持つコンポーネント (3)、
入力 / 出力 (4) を選択し、

ボタンをクリック

（同名のポートを自動接続するには  
をクリック）

WS ブラウザ：　
ファンクションを選択し、ショートカットメニューから
Open in Connection View を選択

「混合」ファンクション： SWC のセンダ / レシーバを
モジュールのシンク / ソースに接続、
モジュールのシンク / ソースをクリックして空白領域に
ラインを引き、Create Port を選択
非 AUTOSAR ポートが追加される

(2) (3)

(4)

(1)
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4.5 ソフトウェアシステム／環境システムの作成

モジュール、レガシー SWC、ファンクションは、参照形式で「ソフトウェアシ

ステム」（SWS）または「環境システム」（ES）に組み込まれます。ただし現行

バージョンでは、SWC は環境システムには組み込めません。1 つのモジュール

または SWC は、直接またはファンクションの一部として、1 つのソフトウェア

システムに 1 回だけ組み込むことができます。ファンクションやモジュール、

SWC のシグナルソースとシンクを互いに接続し、ハードウェア接続のためのイ

ンターフェースを作成します。

ワークスペース内においては、ソフトウェアシステムは Software/
Software Systemsフォルダに格納され、ETAS Experiment Environment
は Environment/Software Systemsフォルダに格納されます。

図 4-7 ソフトウェアシステム／環境システムを作成する

WS ブラウザ：
SWS または ES を選択し、
ショートカットメニューから Modules 
または Functions を選択 

（または  / ）

ソフトウェアシステム

／環境システムの作成

ptp／bpに含める
モジュール／pt`／
ファンクションを選択

ptp／bpを作成

“Unused modules” または
“Unused functions” フィールド
からモジュール /SWC/ ファンク

ションを選択し、 、OK

WS ブラウザ：
Software Systems または
Environment Systems
フォルダを選択し、
ショートカットメニューから 
Create Software System また
は Create Environment 
System を選択 （または  / 

 ボタン）

ダイアログボックスに
SWS ／ ES 名を入力し、
OK をクリック
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SWS 内のモジュール／ SWC ／ファンクション間の接続、およびハードウェア

接続のためのポートは、プロジェクトコンフィギュレータ（PC）において、手

動操作で定義します。

図 4-8 SWC を含まないソフトウェアシステム／環境システムを定義する1

1. Scalar in/out： モジュール
Sender/Receiver ／ Server/Client： AUTOSAR SWC

接続ウィザード：
ポートタイプを選択 (1)1.、
出力を持つコンポーネント (2)、
入力を持つコンポーネント (3)、
入力 / 出力 (4) を選択し、

 ボタンをクリック、

“Dynamic” 接続モード（ON/OFF）を設定
(5)

（同名ポートの自動接続には  を
クリック）

PC： ソース（シンク）をクリックし、シンク（ソース）まで
ラインを引く

pt`を含まない
ソフトウェアシステム
／環境システムの設定

m`上にptpLbpを表示

ポートを挿入

ソースとシンクを接続

接続ウィザードを使用

WS ブラウザ：
SWS/ES を
ダブルクリック

PC で操作する場合： 
ショートカットメニューの Create Port > Scalar In Port / 
Scalar Out Port   / 

(5)

(2) (3)

(4)

(1)

WS ブラウザ : SWS を選択し、
ショートカットメ
ニューから Open in 
Connection View　
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図 4-9 SWC を含むソフトウェアシステムを定義する1

1. Scalar in/out： モジュール、
Sender/Receiver ／ Server/Client： AUTOSAR SWC

pt`を含む
ソフトウェアシステムの設定

m`上に

ptpを表示

^rqlp^oポートを

挿入

^rqlp^oポート間を

接続

接続ウィザードを使用

「混合」ptp内の接続

とポートを定義

WS ブラウザ：SWS をダブルクリック

WS ブラウザ：　
SWS を選択し、ショートカットメニューから Open in 
Connection View を選択

センダ（レシーバ）をクリックしてレシーバ（センダ）まで
ラインを引き、クライアント（サーバー）をクリックして
サーバー（クライアント）までラインを引く

「混合」SWS： SWC のセンダ／レシーバを非 AUTOSAR シン
ク／ソースに接続し、非 AUTOSAR ポート間を接続

非 AUTOSAR シンク／ソースをクリックして空白領域にライ
ンを引き、Create Port を選択
非 AUTOSAR ポートが追加される

接続ウィザード：
ポートタイプを選択 (1)1.、
出力を持つコンポーネント (2)、
入力を持つコンポーネント (3)、
入力 / 出力 (4) を選択し、

ボタンをクリック

（同名ポートの自動接続には  を
クリック）

(2) (3)

(4)

(1)

PC（プロセスコンフィギュレータ）： 
センダ（レシーバ）またはクライアント（サーバー）をクリッ
クして空白部分までラインを引き、Create Port を選択 
  AUTOSAR ポート

/ / / が追加される
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4.6 ハードウェアシステムの作成と設定

実験で使用する「ハードウェアシステム」を作成してコンフィギュレーションの

設定を行うには、ハードウェアコンフィギュレータの機能を使用します。ハード

ウェアシステムにハードウェアを組み込む際は、“Insert Hardware System” ま

たは “Insert New Items” ダイアログボックスに各階層レベルで使用できるハー

ドウェアアイテムが表示されるので、そこから必要なアイテムを選択します。

また、各ハードウェアコンポーネントの各種設定（モジュールパラメータ、測定

ハードウェアのチャンネル設定など）も行えます。

ワークスペース内において、ハードウェアシステム（HWS）は Hardware
フォルダに格納されます。

図 4-10 ハードウェアシステムを作成して設定する

WS ブラウザ：Hardware 
Systemsフォルダのショートカッ
トメニューから Add Hardware 
System を選択（または  ボタン）

ハードウェアシステムの作成

（オプション）

ターゲットを手動で

挿入

デバイスを挿入

シグナルグループと

シグナルを挿入

ハードウェアシステム

とターゲットを追加

ハードウェアの

パラメータを設定

（オプション）
WS ブラウザ： 
システムを選択し、ショート
カットメニューから Insert 
Target を選択、
“Insert New Item” ダイアログ
ボックスでアイテムを選択して
Insert をクリック、
“Rename” ダイアログボックスでアイテム名を入力

HWS を選択して
Insert をクリック

WS ブラウザ： 
デバイスまたはフォルダを選択し、ショートカットメニュー
から Insert を選択、
“Rename” ダイアログボックスでアイテム名を入力

WS ブラウザ： アイテムをダブルクリック

WS ブラウザ：
実験ターゲットを選択してショートカットメニューから
Insert を選択、
“Insert New Item” ダイアログボックスでアイテム（I/O デバ
イス等）を選択して Insert をクリック、
“Rename” ダイアログボックスでアイテム名を入力

値を設定、
コメントを入力

（各列でソート可能）

“Rename” ダイアログボックスで
システム名を入力

自動的にターゲットが追加される
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4.6.1 ハードウェアシステムのインポート

HWS を手動操作で作成する代わりに、INTECRIO や INTECRIO-RLINK、

ASCET-RP で作成されたハードウェアディスクリプション（*.hwx）を、新し

い（または既存の）ハードウェアシステムにインポートすることができます。

ディスクリプションには 2 種類のフォーマット（HWX1 と HWX2）があり、拡

張子はどちらも *.hwxです。

インポートするファイルを選択した後、ウィザードによってインポート処理が実

行されます（図 4-11）。

図 4-11 HWX2 フォーマットのハードウェアコンフィギュレーション

（*.hwx）をインポートする

注記

INTECRIO V4.7.3 以降、HWX1 フォーマットはインポートできなくなりまし

た。

ハードウェアディスクリプション

etuO のインポート

*.hwxファイルを選択

インポートオプション
を設定

インポートを実行

WS ブラウザ：
インポート先ノード

（Hardware Systemsフォ
ルダ、既存のハードウェアシ
ステム、既存のターゲット

（ES910/ES830/X86）、既存
のコントローラ／デバイスを
選択し、ショートカットメ
ニューから Import を選択

ハードウェアディスクリプションがインポートされ、処理中
に出力された各種メッセージ（情報、警告、エラー）はログ
ウィンドウの “Message” タブに表示される

Windows ファイル選択ダイアログボックス : 
*.hwxファイルを選択し、Open をクリック

インポートタイプを選択し、Finish をクリック
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4.6.2 デイジーチェーンの設定

デイジーチェーンのコンフィギュレーション設定は、以下の手順で行います。

図 4-12 デイジーチェーンの作成と設定

デイジーチェーンを挿入して
コンフィギュレーションを

インポート

コンフィギュレーション
ファイルをインポート

デイジーチェーンを
設定

デイジーチェーンを
挿入

WS ブラウザ：
ES910、または ES830 下の
Ethernet コントローラを選択
してショートカットメニュー
から Insert を選択、

“Insert New Item” ダイアログ
ボックスで Daisychainを
選択して Insert をクリック、
“Rename” ダイアログボック
スでアイテム名を入力

WS ブラウザ： デイジーチェー
ンをダブルクリック

HC： ボタンをクリック

“Import file”
ダイアログボックス
1 ページ目：
コンフィギュレー
ションタイプを選択
して Next をクリック

2 ページ目：
コンフィギュレー
ションファイルを指
定して Next または 
Finish をクリック

3 ページ目：
（既存のコンフィギュ
レーションを
インポートする場合
のみ）：
チェーンを選択して 
Finish をクリック

WS ブラウザ： インポート終了後、
デイジーチェーンを選択してショートカット
メニューから Configure を選択し、
デイジーチェーンコンフィギュレーションツールを開く

コンフィギュレーションツール： デイジーチェーンを設定

WS ブラウザ： デイジーチェーンを選択してショートカッ
トメニューから Update を選択

または
WS ブラウザ：
デイジーチェーンを選択し、
ショートカットメニューから 
Import Daisychain 
Configuration を選択
54



ETAS － INTECRIO V5.0 入門ガイド INTECRIO クイックガイド
4.6.3 LIN コントローラの設定

LIN コントローラのコンフィギュレーションは以下のようにインポートします。

図 4-13 LIN コントローラの作成と設定

コンフィギュレーション
ファイル*.ldfを

インポート

LINの設定を調整

LINを挿入

LINを挿入して
コンフィギュレーションを

インポート

WS ブラウザ：
ES910 または ES830_ES8xx
を選択してショートカットメ
ニューから Insert を選択、
“Insert New Item” ダイアログ
ボックスで LINを選択して
Insert 、“Rename” ダイアロ
グボックスでアイテム名を入
力

インポートウィザード
1 ページ目：
LDF ファイルを選択、
必要に応じて
Replace... オプション
をセット、
Next をクリック

WS ブラウザ：
インポート終了後、LIN コントローラツリーから
アイテムを選択してショートカットメニューから 
Open を選択  HC が開く

HC： 
値を設定してコメントを入力

2 ページ目：
ノードを選択、
Replace... がオフの
場合は Next、
オンの場合は Finish を
クリック

3 ページ目
（Replace... がオフの
場合のみ）:
必要に応じて
Additive import を
セット、
フレーム識別方法を
選択して Finish を
クリック

WS ブラウザ：
LIN コントローラまたは
LIN I/O デバイスを選択し、
ショートカットメニューから 
Import LDF を選択
または
LIN コントローラを
ダブルクリック、
HC: ボタンをクリック
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LIN ノード（デバイス）のタイプにはマスタとスレーブがあり、いずれかを設定

できます。ノートタイプを変更すると、タイプに依存する設定内容は自動的に調

整されます。

図 4-14 LIN ノードタイプの変更

空のフォルダ Schedule Tablesおよび Sporadic 
Frame、ステータスシグナルグループが作成され、診断フ
レームの方向が反転される

スケジュールテーブルと散発フレームを追加して設定する

WS ブラウザ：
マスタデバイスを選択して
ショートカットメニューから
Open を選択、またはマスタ
デバイスをダブルクリック

HC：
“Node Type” を Slave Nodeに変更、
必要に応じてデバイス名を変更

マスタ → スレーブ

ifkのデバイスタイプの変更

スレーブ → マスタ

WS ブラウザ：
スレーブデバイスを選択してショートカットメニューから
Open を選択、またはスレーブデバイスをダブルクリック

HC：
“Node Type” を Master Nodeに変更、
必要に応じてデバイス名を変更

スケジュールテーブル、散発フレー
ム、ステータスシグナルグループが
削除され、診断フレームの方向が反
転される
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4.6.4 バイパスの設定

バイパスデバイスを追加した後（図 4-10）、以下の手順でバイパスを設定しま

す。

図 4-15 バイパスデバイスのセットアップ

注記

ETK（8 Mbit/s）のサービスベースバイパスはサポートされていません。

INTECRIO V5.0.1 以降、ES910 での FETK バイパスは推奨されません。

デバイスを選択し、
必要に応じてオプ
ションをオンにして、
Next または Finish

オプション:
SBBバージョンを選択

*.a2lファイルを
インポート

バイパスのセットアップ

バイパスシグナルを
選択

シグナルグループと
シグナルを設定

オプション:
デバイスを選択

（ETK/XETK/FETK
バイパス）

ファイル選択ダイアログ：
*.a2lファイルを選択して Open
をクリック

または
WS ブラウザ： 
ETK/XETK/FETK/XCP バイパスを
選択し、ショートカットメニュー
から Import A2L を選択

複数の SBB バージョ
ンが *.a2lファイル
に含まれる場合

WS ブラウザ： ETK/XETK/FETK/
XCP バイパスを選択してショート
カットメニューから Open を選択、
またはバイパスデバイスをダブル
クリック

(3) シグナルを選択し、
ショートカットメニュー
から Select を選択

(4) 選択されたシグナル
のリスト

HC： シグナルグループ／シグナルエディタを開き、オプショ
ンを設定

}

複数のデバイスが
*.a2lファイルに含
まれる場合

SBB バージョンを選択し、Finish

(1) シグナルを追加
するラスタを選択

(2) 使用する
シグナルを限定

HC: 必要に応じてデクリプション
キーを入力し、ボタンをクリック

HC："Signal Selection" タブ
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「サービスベースバイパス」用のサービスポイントのディスクリプションは

*.a2lファイル内に含まれているので、これをインポートし、実際に使用する

サービスポイントとシグナルを選択します。

図 4-16 サービスポイントのセットアップ（サービスベースバイパス）

注記

ETK（8 Mbit/s）のサービスベースバイパスはサポートされていません。

HC “Service Point Selection” タ
ブ :
サービスポイントをセット、
送信シグナルグループの
エラー時の挙動をセット

必要に応じて “Filter” ドロップダ
ウンリストでサービスポイントの
リストをフィルタリング

サービスポイントの

機能を選択

サービスポイントの
セットアップ

シグナルの選択と調整

WS ブラウザ： サービスベースバイパス対応の *.a2lファイ
ルを使用する ETK/XETK/FETK バイパスデバイスを選択して
ショートカットメニューから Open を選択、またはバイパス
デバイスをダブルクリック

: ファンクション実行前に read/write（receive/send）

: オリジナルファンクションの実行（追加ラスタ／メモリなし）

: ファンクション実行後に read/write（receive/send）

SBB V3 のみ

SBB V2 
のみ

HC “Signal Selection” タブ：

サービスポイントの下のシグナルグループを選択してシグナ
ルを追加（図 4-15 参照）

シグナルグループまたはシグナルをエディタで開き、オプ
ションを設定
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DISTAB17 を使用すると、サービスポイントのコンフィギュレーションをフック

ベースバイパス用に拡張することができます。フックベースバイパスのセット

アップは、シグナルを選択する前に行う必要があります。

図 4-17 フックベースサービスポイントのセットアップ（ブックベースバイ

パス + DISTAB17）

フックベースサービスポイントの
セットアップ

フックベース
サービスポイントの

機能を選択

シグナルの選択と調整

HC “Hooked Service Point Selection” タブ :
使用するフックベースサービスポイントをアクティブ化

必要に応じて “Filter” ドロップダウンリストで
フックベースサービスポイントのリストをフィルタリング

WS ブラウザ： DISTAB17 対応の *.a2lファイルを使用す
る ETK/XETK/FETK バイパスデバイスを選択して ショート
カットメニューから Open を選択、またはバイパスデバイス
をダブルクリック

HC “Signal Selection” タブ：

フックベースサービスポイントの下のシグナルグループを選
択してシグナルを追加（図 4-15 参照）

シグナルグループまたはシグナルをエディタで開き、オプ
ションを設定
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4.6.5 CAN コンフィギュレーションファイルのインポート

CAN デバイスを追加した場合（図 4-10）、シグナルとフレームを手動操作で作

成するか、CAN コンフィギュレーションファイル（CAN データベースファイル

(*.dbc) または AUTOSAR ファイル (*.arxml)）をインポートすることがで

きます。CAN のほか、ES910+ES922 と ES830 では CAN FD がサポートされて

います。

図 4-18 CAN コンフィギュレーションファイルのインポート

WS ブラウザ： CAN_IO デバイスを選択して Import CAN 
Configuration を選択、または
CAN_IO デバイスをダブルク
リックして HC を開き、ボタン
をクリック

2 ページ目： 
バスノードを選択、Next をクリック

`^kコンフィギュレーションファイル

のインポート

インポートウィザードを開

く

インポートの終了

`^kコンフィギュレーショ
ンファイル、パスノード、
インポートオプションを選

択

`^kフレームを選択

“Import CAN Configuration File” ウィザード 1 ページ目： 
ファイル名（*.dbcか *.arxml）を入力または選択

（ ）して

（3 ページ目）： 
フレーム識別モードを
選択してオプションを
設定、Next をクリッ
ク

3 ページ目： 
フレーム識別モードを選
択して、オプションを設
定し、 Next をクリック

4 ページ目： 

フィルタ使用

コンフィギュ
レーション内
に存在するフ
レームの表示

選択完了後、Finish をクリック

インポートする
フレームの選択
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4.6.6 CAN コンフィギュレーションのエクスポート

設定の完了した CAN デバイスのコンフィギュレーションは、CAN データベース

ファイル（*.dbc）としてエクスポートすることができます。CAN のほか、

ES910+ES922 と ES830 では CAN FD がサポートされています。

図 4-19 CAN データベースのエクスポート

4.7 システムプロジェクトのセットアップ

1 つのハードウェアシステムと 1 つのソフトウェアシステム、さらにオプション

で 1 つの環境システムを結合して、「システムプロジェクト」（SP）という 1 つ

の総体的なプロジェクトを定義します。

システムプロジェクトにおいて、ハードウェアの入出力信号をソフトウェアシグ

ナルに割り当て、さらにオペレーティングシステムコンフィギュレーションで定

義されているプロセスシーケンスにマッピングします。

注記

現時点では *arxml形式での CANコンフィギュレーションのエクスポートは

サポートしていません。

WS ブラウザ： CAN_IO デバイスを選択してショートカット
メニューから Export CANdb を選択

`^kデータベースを

エクスポート

`^k|flデバイスの

エクスポートを開始

`^kコンフィギュレー
ションを

GKÇÄÅファイルに
エクスポート

Windows ファイル選択ダイアログ : *.dbcファイルのパス
と名前を指定して、Save をクリック

CAN コンフィギュレーションが *.dbcファイルに保存され、
各種メッセージ（情報、警告、エラー）がログウィンドウの
“Message” タブに表示される

注記

CAN コンフィギュレーション内の以下のようなアイテムは
エクスポートされません。

• 空の受信フレームと多重化グループ（multiplex 
group）

• CANdb フォーマットで使用できない HC パラメータ
61



ETAS － INTECRIO V5.0 入門ガイド INTECRIO クイックガイド
4.7.1 システムプロジェクトの作成

ワークスペース内において、システムプロジェクトは Systemsフォルダに格

納されます。このフォルダには複数のシステムプロジェクトを格納でき、そのう

ち 1 つを「アクティブシステム」として実際に使用します。

本項では、ラピッドプロトタイピング用のシステムプロジェクトについて説明し

ます。バーチャルプロトタイピングについては 4.11 項「仮想プロトタイピング

（バーチャルプロトタイピング）」を参照してください。

システムプロジェクトをセットアップするには、まず Systemsフォルダにシ

ステムプロジェクト（SP）を作成し、そこにハードウェアシステム（HWS）と

ソフトウェアシステム（SWS）、および環境システム（ES）を割り当てます。

図 4-20 システムプロジェクトを作成する

WS ブラウザ： 
SP を選択し、ショートカットメ
ニューから Add Software System
を選択

システムプロジェクトの作成

システムプロジェクト

を作成

ハードウェアシステム

を追加

ソフトウェアシステム

を追加

（オプション）

環境システムを追加

WS ブラウザ：
SP を選択し、ショートカットメ
ニューから Add Hardware System
を選択

HW を選択して
OK をクリック

SWS を選択して、
OK をクリック

WS ブラウザ： Insert > Create System、

 ボタン、または
Systemsフォルダのショートカットメ
ニューから Create System を選択

WS ブラウザ： SP を選択し、
ショートカットメニューから Add 
Environment System を選択、ES
を選択して OK

ダイアログボックスで SP の名前を入力
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4.7.2 ハードウェアとソフトウェアの接続

次に、ハードウェアシステム内のどのデバイスをシステムプロジェクト内で使用

するかを選択します。ソフトウェアシステムからの接続は、ここで選択されたデ

バイスに対してのみ行えます。ハードウェアとソフトウェアのポートを接続し、

実行可能なプロトタイプを生成します。

図 4-21 ハードウェアとソフトウェアを接続する12

1. Scalar in/out： モジュール、 Sender/Receiver： AUTOSAR SWC
Server/Client： ハードウェア接続では使用不可

2. SWC 接続では “Dynamic” 接続モードは使用不可

WS ブラウザ：

SP を開き、 ボタンをクリック、
または SP のショートカットメニュー
から Devices を選択

“Unused devices” フィール
ドからハードウェアデバイ
スを選択して、  、
OK をクリック

(3)(2)

(4)
(5)

(1)

WS ブラウザ : 
SP を選択してショートカットメ
ニューから Open in View を選択

（または SP をダブルクリック）

または、
WS： SP を選択してショートカットメニューから
Open Connection Window を選択

PC: 
ソース（シンク）をクリックし、
シンク（ソース）までラインを引く

WS ブラウザ：
SP を選択して、ショートカットメ
ニューから Import HWC Connection 
を選択、
“Import HWC Connection”
ダイアログボックスで HWX ファイル
を選択し、Open をクリック

HW 接続が名前ベースでインポート
されます。同名の接続がすでに存在
する場合、上書きは行われません。

接続ウィザード：
ポートタイプを選択 (1)1.、
出力を持つコンポーネント (2)、
入力を持つコンポーネント (3)、
入力 / 出力 (4) を選択し、 ボタンをクリック、

“Dynamic” 接続モード（ON/OFF）を設定 (5)2.

（同名ポートの自動接続には  をクリック）

ハードウェアとソフトウェアの

接続

デバイス（ボード）

を選択

m`内のシステムプロ

ジェクトを表示

ソースとシンクを接続

接続をインポート
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4.8 オペレーティングシステムの設定

オペレーティングシステムのコンフィギュレーション設定は、リアルタイムプロ

トタイプシステムを作成するうえで非常に重要な作業のひとつです。

オペレーティングシステム（OS）は、プロセッサの占有を競合するタスクやプロ

セス、およびランナブルエンティティ（RE： Runnable Entity、「ランナブル」とも

呼ばれます）の処理シーケンスを決定し、必要に応じてタスクの実行を切り替えま

す。これらのことを行うために必要な条件設定を、OS コンフィギュレーション

ウィンドウで行います。

4.8.1 オペレーティングシステムの自動設定

INTECRIO には OS の自動設定機能があります。

図 4-22 オペレーティングシステムを自動設定する

lpコンフィギュレーションの
自動設定

fpoを設定

未使用のプロセス／

ob、シグナルグループ

などをマッピング

HWデバイスの未使用
シグナルグループを

マッピング

lp全体を設定

WS Browser：
System > OS Auto Mapping、

または  ボタン（アクティブ SP
のすべてのプロセス /RE/ シグナル
グループ /ISR）

OSC： OS Configurationを選択し、
ショートカットメニューから Auto Mapping を選択

 タスクと ISR が作成され、必要なプロセス、RE、
シグナルグループ、ISR が割り当てられる

注記

System > OS Auto Mapping /  Auto Mapping を実行す
ると既存の OS 設定が削除されます。

OSC：
OS Configurationを選択し、
ショートカットメニューから Map 
Unused を選択

 未使用のプロセス /RE、
シグナルグループ、ISR がマッピングされ、必要に応じて
新しいタスクや ISR が作成される

OSC： “Hardware” タブで HW 割り込
みを選択し、ショートカットメニュー
から Auto Map Interrupt を選択

 ISR が作成
されて設定さ
れ、SW タス
クが作成され
て non-

polling 受信シグナルが割り当てられ
る

OSC：
“Hardware” タブで HW デバイスを選
択し、ショートカットメニューから 
Map Unused を選択

 未使用のシグナルグループが適切な
タスクに割り当てられる
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4.8.2 オペレーティングシステムの手動設定

INTECRIO では、OS のコンフィギュレーション設定を手動操作で行うこともで

きます。すべてを手動操作で設定したり、自動設定の結果を調整したりすること

もできます（図 4-23）。

最初に必要なタイマタスクとソフトウェアタスク、および ISR を作成します。た

だし Initタスクと Exitタスクは自動的に作成されます。

図 4-23 オペレーティングシステムを手動設定する

OSC：
アプリケーションモードを選択、
ISRsフォルダ（RTA-OSEK）または
Software Tasksフォ
ルダのショートカットメ
ニューから Add Timer 
Task、 Add ISR または 
Add Task を選択

AUTOSAR： Tasksフォ
ルダのショートカットメ
ニューから Add Task を
選択

オペレーティングシステムの設定

タスクとfpoを
作成する

lpコンフィギュレータ

を開く

一般的な設定を行う

WS ブラウザ：　

 ボタン、
または OS Configurationを
ダブルクリック

名前を入力

OSC：
表示モードを選択 (1)、
OS Configurationを
選択して下部の入力フィール
ドに値を設定

(1)
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続いて、作成したタスクのプロパティを設定します。Initタスクと Exitタス

クのプロパティは INTECRIO により自動的に定義されます。その後、プロセス

（または RE）とシグナルグループをタスクに割り当てます。

図 4-24 タスクを手動設定する

OSC： タスクを選択
タスクの設定

タスク属性を調整

タスクを選択

空のタスクを削除

プロセス／obを
マニュアル操作で

割り当てる

シグナルグループと

イベントを割り当てる

OSC：
OS Configuration（空の
タスクと ISR を削除）、アプリ
ケーションモード（空のタイマ
タスクを削除）、Software 
Tasksフォルダ（空の SW タスクを削除）を
選択し、ショートカットメニューから Delete 
Empty Tasks を選択

OSC：
“Hardware”
タブ上のアイ
テムを、
タスクまたは 
Actions / 
Runnable
sフォルダ（ ＋ ）、または Eventフォルダ（ ）に
ドラッグ

OSC 入力フィールド :
各プロパティの値を
選択、または直接入力

OSC：
“Software”/
“Environme
nt” タブ上の
プロセス /RTE を適切
なタスクフォルダにド
ラッグ
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割り込みサービスルーチン（ISR）は、タスクの場合と同じような方法で設定し

ます。各 ISR には HW 割り込みと、プロセスおよびシグナルグループが割り当

てられます。HW 割り込みによっては、トリガイベントの下にサブイベントを定

義し、そこにプロセスやシグナルグループを割り当てることもできます。

図 4-25 ISR を手動設定する

OSC： タスクを選択

OSC 下部の入力フィールド：
ISRの設定

HW割り込みを

割り当てる

名前と属性を設定

空のISRを削除

プロセスと
シグナルグループを

ISRに割り当てる

サブイベント（イベン
トの依存関係）

を設定

次の操作を行うと、
ISRだけでなく、空のタスクが

すべて削除されます。

OSC：
“Hardware”
タブ：
イベント（ ）
を選択、 
<CTRL> を押し
下げたまま、
そのイベント
を Event Dependenciesフォルダにドラッグ

“Software”/“Hardware”
タブ： 
プロセス / シグナルグ
ループを Event 
<event name>フォルダにドラッグ

名前と優先度を入力

OSC：
OS Configurationを選択し、
ショートカットメニューから Delete 
Empty Tasks を選択

OSC： 
“Software” タブ上のプロセスまたは “Hardware” タブ上のシ
グナルグループを Actions フォルダにドラッグ

OSC： 
“Hardware” タブ上の

HW 割り込み（ ）
を Interruptフォ
ルダにドラッグ
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4.9 実行ファイルの生成

ビルド処理は、いくつかのオプションを設定するだけでほぼ自動的に実行されま

す。

図 4-26 実行ファイル（プロトタイプ）を生成する

実行ファイルの生成

ビルドオプションを

設定

コード生成を実行

WS ブラウザ：
Tools > Options 、
WS ショートカットメニュー
の Properties、
SP ショートカットメニュー
の Properties

Integration > Build / ボタン：　実行ファイルを生成

Integration > Rebuild / ボタン：　実行ファイルを再生成

Integration > Generate / ボタン：　コードだけを生成

Integration > Clean / ボタン：　生成されたファイルを削除

Integration > Abort / ボタン：　生成をキャンセル

右側フィールド：
ビルドオプションを設定、OK

左側フィールド：
Project 
Integration
とサブアイテムを
選択
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4.10 実験

測定／適合、およびそれらの準備作業を行うための機能のほとんどは、ETAS 
Experiment Environment に含まれています。ETAS Experiment Environment

（ETAS 実験環境）では、測定変数や適合変数を選択してオシロスコープ、棒グ

ラフディスプレイ、適合エディタなどのさまざまなウィンドウに配置します。

4.10.1 実験の準備

1 つのシステムプロジェクトについて、空の「実験」が 1 つ作成されます。

ETAS Experiment Environment のウィンドウを開いて（図 4-27）、PC に接続さ

れているハードウェア（ES900 または ES800）を選択し、実験に必要な各サブ

ウィンドウとツールバーが表示されることを確認してください（図 4-28）。

図 4-27 ETAS Experiment Environment（ETAS 実験環境）を開く

注記

ES800 ハードウェアシステムを用いた実験を行うには、V7.2.17 以降の INCA
と INCA-EIP、または V3.7.7 以降の ETAS 実験環境が必要です。

実験環境を開く

実験オプションを

設定する

実験環境を開く

WS ブラウザ： 
SP を選択し、Experiment > Open 
Experiment

（または  をクリックするか、

ショートカットメニューから Open 
Experiment を選択）

WS ブラウザ : Tools > Options
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図 4-28 ETAS Experiment Environment をセットアップする

実験環境をセットアップする

（必要に応じて）
接続されているハード

ウェアを選択

ドッキングウィンドウ

とツールバーを表示

実験オプションを設定

EE：
View メニューでウィンドウを
選択し、Toolbar ショート
カットメニューでツールバー
を選択

EE：
同じシミュレーションシス
テムを含む複数のハード
ウェアが PC に接続されて
いる場合 は、最下部の
バーの青いランプをダブル
クリック

使用する ＨＷ を選択し、
OＫ

EE： Tools > Options
“Options” ダイアログボックス：
各ページのプロパティを設定し、OK
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4.10.2 測定／適合ウィンドウの作成とセットアップ

ETAS Experiment Environment では、オシロスコープやその他のさまざまな測

定／操作インストゥルメント（GUI エレメント）を任意の数だけ作成し、そこに

測定変数や適合変数を割り当てることができます。同じタイプのインストゥルメ

ント（オシロスコープやテーブルエディタを除く）は 1 つの測定／適合ウィンド

ウにまとめて表示することもできます。

図 4-29 測定／適合ウィンドウを作成する

EE： 
Instrumentation タブを
クリック

測定ウィンドウと
適合ウィンドウの作成

“fåëíêìãÉåí~íáçå”
フィールドを表示

ウィンドウに
測定／適合エレメント

を割り当てる

サイズを調整

EE の “Instruments” ウィンドウ： 
シンボルを “Instrumentation” フィールドにドラッグ

EE の “Layer” フィールド：
測定 / 適合ウィンドウを選択し、
その頂点をドラッグ
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各インストゥルメントは、個別に表示設定を行えます。

図 4-30 測定／適合インストゥルメントをセットアップする

測定／適合

インストゥルメントの設定

その他の

インストゥルメントを

設定

オシロスコープを設定

EE オシロスコープ：
シグナル表示領域、
座標軸、またはチャ
ンネルリストを選択
し、“Properties”
ウィンドウにプロパ
ティを表示する

“Properties”
ウィンドウ：
シグナル表示領域
(a)、軸 (b,d)、チャ
ンネル (c) のプロパ
ティを設定

“Properties” ウィンドウ：
インストゥルメントの
プロパティを設定

EE： 
インストゥルメントを選択して 
“Properties” ウィンドウに
プロパティを表示する

(a)

(b)

(d)

(c)
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4.10.3 測定変数と適合変数の割当て

プロジェクトに定義されている測定変数と適合変数が “Workspace Elements”
ウィンドウにリストアップされるので、ここから必要な変数を適切な測定／適合

インストゥルメントに割り当てます。

図 4-31 測定／適合変数を測定／適合インストゥルメントに割り当てる

“Workspace Elements” ウィンドウ：
変数を選択し、測定 / 適合インストゥルメントにドラッグ

測定変数と適合変数の
割り当て

変数を既存の

インストゥルメントに

割り当てる

変数を新しい

インストゥルメント

に割り当てる

変数を選択

“Workspace Elements” ウィンドウ：
インストゥルメントの
ショートカットメニューから
Measure/Calibrate を選択

“Create Instruments” ウィンドウ： 
“Instrument Type” 列から測定／適
合インストゥルメントを選択、 
“Group” 列から測定／適合ウィンド
ウを選択し、OK
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4.10.4 レイヤの使用

デフォルト状態においては、“Instrumentation” フィールドには 1 つのレイヤ

（“Layer” タブ）が含まれていて、そこに測定／適合ウィンドウを作成できるよう

になっています。レイヤの追加や削除、レイヤ名の変更、既存レイヤ間での測定

／適合ウィンドウの交換が可能です。

図 4-32 レイヤを使用する

EE：
レイヤタブのショートカットメニュー
から Create Layer を選択

EE：
レイヤのタブのショートカットメニュー
から Rename Layer を選択
“Rename” ウィンドウに名前を入力、OK

EE：
レイヤのタブのショートカットメ
ニューから Delete Layer を選択

EE：
測定 / 適合ウィンドウを選択し、タイトルバーのショート
カットメニューから Move To Layer > <layer name> を選択

レイヤの使用

レイヤの名前を変更

レイヤを作成

レイヤを削除

測定／適合ウィンドウ

を移動
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4.10.5 実験の管理

実験のセットアップ（測定／適合ウィンドウとレイヤの作成、変数の割当て）が

終わったら、その設定を保存します。その後は、別の実験を作成したり、既存の

実験をロードしたりすることができます。

図 4-33 実験を管理する

EE： 
現在開いている実験を閉じ、File > New Experiment（ ）実験の管理

実験をロード

実験を作成

実験を保存

実験を閉じる

現在開いている実験を閉じ、File > Open Experiment
（または  か、<CTRL> + <O>）
実験を選択、Open 

File > Close Experiment、
現在の実験を保存（Yes）また
は破棄（No）

File > Save Experiment（または か、<CTRL> + <S>）、
または File > Save Experiment As
必要に応じて “Save Experiment As” ウィンドウにパスと名
前を入力、Save 

“New Experiment” ダイアログボックス：
名前とパスを入力（または Browse ボタン
で選択）、OK
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4.10.6 データ収集の設定

INTECRIO では、データロガーで測定データを記録する際のさまざまな条件（保

存場所や保存ファイル名、記録時間など）を設定できます。

データ収集の開始と終了を自動化するために、任意に定義されたイベントをトリ

ガ条件として指定したり、プリトリガ時間やポストトリガ時間を指定したりする

こともできます。 

図 4-34 データ収集について設定する

測定データの記録設定

記録する

測定変数を選択

新しいデータロガーを

追加

“a~í~äçÖÖÉê”タブ

を開く

トリガ条件を設定

記録ファイルを設定

記録用タスクを選択

EE： 
Data Logger タブをクリック

“Workspace Elements” 内の
測定変数をデータロガーにドラッグ

（または測定変数のショートカット
メニューから Add to Data Logger を
選択）

"Task" 列： 
タスクを選択

Add をクリック

記録ファイル設定

トリガエディタを開く

記録時間
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4.10.7 実験の実行

実験を開始すると、生成されたプロトタイプが実験ターゲットに転送されます。

このターゲット上で、まずリアルタイムオペレーティングシステムが稼働し、続

いてシミュレーションが開始されます。

図 4-35 実験を開始する1

1. <SP> はシステムプロジェクト名

EE：　Experiment > Download > <SP> 1./ 
実験の開始

ターゲットへ
ダウンロード

（必要に応じてetを
選択）

シミュレーション開始

（lpを起動）

測定開始

Experiment > Start Simulation > <SP>1. / 
Experiment > Start Measurement > <SP>1. / 

同じシミュレーションシステ
ムを含む複数のハードウェア
が PC に接続されている場合 
 最下部のバーの青いランプ
をダブルクリック

使用する ＨＷ を選択、OＫ
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測定データを記録する場合、測定を開始する前にデータロガーを起動する必要が

あります。データロガーが起動されると、通常は測定開始と同時に記録が開始さ

れますが、トリガが設定されている場合はトリガ条件が満たされた時点で記録が

開始されます。

図 4-36 測定データを記録する1

1. <SP> はシステムプロジェクト名

測定データの記録

データロガーを起動

測定開始

必要に応じて

マニュアル操作で

記録を開始

EE： 
Experiment > Start Measurement > <SP>1.

（または  ）
EE： 
Datalogger タブをクリック

開始トリガ発生により記録開始
（  
または ）

設定時間の経過、または終了トリガ発生により記録終了
（  
または ）

データロガー： 
“Available Dataloggers” フィールドの “Active”
列をチェックし
て、データロ
ガーを起動
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4.10.8 測定と適合

測定値は、オシロスコープやその他の各種測定インストゥルメントに表示しま

す。オシロスコープには、測定値を分析するための機能が用意されています。

図 4-37 値を測定する

変数の測定

測定カーソルをオンに

して表示設定を行う

オシロスコープ上での

測定データ表示の

開始／停止

測定データを分析

（オシロスコープ）

各種インストゥルメント

を使用して測定を行う

カーソルを選択し、
ショートカットメニュー
から Show Cursor 
difference > <other Cursor> 

を選択 

 カーソル上部にカーソル間の時間差が表示
され、チャンネルリストには

時間差と値の差が表示される

オシロスコープ：
表示の開始 / 再開： 、表示の休止： 

カーソル
ON/OFF： 

カーソル上、お
よびチャンネル
リスト内に値が
表示される

マウスの左ボタンを使って
任意の測定ポイントまで
カーソルをドラッグ

測定開始（EE の ボタン）により

直ちに測定値が表示される
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あるインストゥルメントに適合変数（特性値、特性カーブまたは特性マップ）を

割り当てると、このインストゥルメントは「エディタ」として機能します。さま

ざまなタイプのエディタで、適合変数の値を直接変更できます。

図 4-38 エディタで適合を行う

4.10.9 ポストプロセッシング

測定結果をファイルに書き込んでおくと、そのファイルを測定データ分析ツール

で読み込んでシグナル評価を行うことができます。

ETAS の MDA（Measure Data Analyzer： 測定データアナライザ）はこのよう

な分析作業に最適なオフラインツールです。MDA には 2 種類の分析ウィンドウ

があります。1 つはオシロスコープウィンドウで、これは通常のオシロスコープ

または XY プロッタとして使用できます。もう 1 つは、正確な値を素早く読み取

るのに適したテーブルウィンドウです。複数の測定ファイルに保存された測定シ

パラメータの適合

スライダエディタを

使用

テーブルエディタを

使用

数値エディタを使用

適合したパラメータを

保存

パラメータをロード

スクロールボタンを使用、
またはテキストフィールドをクリックして値を入力

マウスを使用してポインタを移動

セルをダブルクリックして値を入力、Apply

* 依存パラメータは適合不可

EE： 
”Workspace 
Elements”
ウィンドウ：
パラメータを
選択し、
ショートカッ
トメニューか
ら
Calibration/ 
Parameters > 
Save を選択

パラメータ
の最終選択

出力ファイルを選択、

Add * オプションをオ
ン、

Save をクリック

EE： 
“Experiment 
Explorer” タ
ブ： 
Parameter 
Filesフォルダを選択し、ショートカットメニューから Add 
File を選択
ファイル選択ダイアログボック
ス： ファイル名とフォーマット
を選択して Open  ファイルが
追加される

“Experiment Explorer” ウィンド
ウ： Parameter Filesフォ
ルダ内のファイルを選択して
ショートカットメニューから
Active を選択  ファイルから値
が読み込まれる
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グナルを同じウィンドウに表示することも可能です。表示設定は任意に変更で

き、設定を「分析コンフィギュレーション」として保存することもできます。分

析を行う際には、測定ファイル内の任意のポイントにスムーズにアクセスするた

めのズーム機能や検索機能が用意されていて、値を読み取るための測定カーソ

ル、シグナル間の差異の自動計算などの機能も利用できます。

MDA は INTECRIO、ASCET、INCA の各製品パッケージに含まれています。
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4.11 仮想プロトタイピング（バーチャルプロトタイピング）

仮想プロトタイピング用のシステムプロジェクトの作成方法は、ラピッドプロト

タイピング用のシステムプロジェクトを作成する場合とほとんど同じです。

図 4-39 仮想プロトタイピング用プロジェクトを作成する

コンパイラとパスを指定

WS ブラウザ：
Tools > Options、Project 
Integrator/Toolsを選択

smプロジェクトの作成

ソフトウェア／環境

／ハードウェア

システムを作成

システムプロジェクト

を作成

オペレーティング

システムを設定

コンパイラを設定

（必要に応じて）

デバッグの準備

（必要に応じて）

HWS：
HWS を作成してターゲットを作
成（4.6 項参照）

コンパイラを選択

検索パスを
指定

WS ブラウザ：
SP を選択して
ショートカット
メニューから
Properties を選択、 
Project 
Integrator/ 
Compiler 

WS ブラウザ : 
SP を選択して、
ショートカットメニューから Properties を選択
Project Integration/Build: Activate compiler debug code creation をオン

Project Integration/Compiler: MS Visual Studio® compiler を選択 

SWS：
モジュールを作成（Simulink：External Mode オプションを
オフ）してインポート（4.3 項参照）、
ファンクションを作成して（4.4 項参
照）、 SWS を作成（4.5 項参照）

OS：
OS を設定（4.8 項参照）、

（VP の場合、Eventフォルダや ISR は使用しない）

SP：
SP を作成（4.7.1 項参照）、 ES を割り当て、ES と SWS を接
続（VP の場合、HWS の設定や HW/SW の接続は不要）

コンパイラ：

OK

OK
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仮想プロトタイピング実験がラピッドプロトタイピング実験と大きく異なる点

は、シミュレーション時間に関するモードを選択できるという点です。

図 4-40 仮想プロトタイピング実験

デバッガ：

ビルド完了後、直ちに実験を開き（4.10.1 項）、実験をダウ

ンロード（  ） 
 VP フロントエンドが
システムトレイに表示される 

VP フロントエンドを右クリックし、
ショートカットメニューから Debug 
Virtual Target を選択

 デバッガ（Visual Studio）が開く 
Development/Professional 版： 自動的に *.exe ファイル
にアタッチ

シミュレーション時間：
EE： 測定を休止（ ）、シ

ミュレーションを休止（ ）
“VP Execution Mode” ウィン
ドウ： 
モードを選択、必要に応じて
スケールを設定

EE： 
シミュレーション開始（ ）、続いて測定開始（ ）

実験：

ETAS Experiment Environment を開き（4.10.1 項参照）、
測定 / 適合インストゥルメントを作成（4.10.2 項参照）、
測定 / 適合変数を割り当て（4.10.3 項参照）、
レイヤを設定（4.10.4 項参照）、
実験の管理を行い（4.10.5 項参照）
データ収集について設定し（4.10.6 項参照）、
実験＋データ収集を実行（4.10.7 項参照）、
測定 / 適合を実行（4.10.8 項参照）

プロトタイプ生成：
Integration > Build（または ）で実行ファイルを生成

Integration > Rebuild（または ）で実行ファイルを生成
（4.9 項参照）

sm実験の実行

実行ファイルを生成

実験を実行

シミュレーション

時間モードを選択

デバッガに接続
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4.12 ワークスペースの管理と交換

4.12.1 ワークスペースの管理

前述のように、INTECRIO では複数のワークスペースを扱うことができます。新

しい空のワークスペースを作成する（43 ページの「新しいワークスペースの作

成」を参照してください）だけでなく、たとえば他のユーザーが作成したワーク

スペースを開いて利用することもできます。保存されたワークスペースには、

ワークスペース自体だけでなく INTECRIO ウィンドウのレイアウトも保存されま

す。

図 4-41 ワークスペースを管理する

ワークスペースの管理

tpを保存

tpを開く

tpを閉じる

WS を開く：

File > Open Workspace（または 、<CTRL>＋ <O>）

WS を選択して Open をクリック

WS を保存：
File > Save Workspace（または 、<CTRL>＋ <S>）

WS に名前を付けて保存：
File > Save Workspace As、
WS の名前とパスを入力し、OK をクリック

WS を閉じる： File > Close Workspace   確認ダイアログ
Yes： 変更内容を保存
No： 変更内容を破棄
Cancel： WS を閉じない
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4.12.2 インポート／エクスポートによるワークスペースの交換

WS ブラウザでは、ワークスペースのエクスポートやインポートを行えます。

ワークスペースのエクスポート／インポート時には、任意のモジュールを含める

ことができます。この機能は、既存のワークスペースをユーザー間や PC 間で交

換する際に非常に役立ちます。

図 4-42 ワークスペースをインポート／エクスポートする

ワークスペースの
インポート／エクスポート

tpをインポート

tpをエクスポート

インポート：
File > Import Workspace
*.iozファイルを選択、Open

WS のパスを入力、

インポートする
モジュールを選択、

モジュールファイ
ルのパスを入力、

アルゴリズムファ
イルのインポート
オプションをオン

Import 

エクスポート：
File > Export Workspace

選択された場所に
エクスポートファイルが書き込まれる

エクスポートパス

コメントを入力

エクスポートする
モジュールを選択

Export をクリック

アルゴリズムファイル
のエクスポートオプ
ションをオン
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4.12.3 外部で変更されたワークスペースを開く

ワークスペースファイルを Windows エクスプローラで移動、または INTECRIO
の外部でワークスペースファイルを編集したような場合には、そのワークスペー

スを INTECRIO で開こうとすると警告メッセージが表示されます。DTD が期限

切れの場合や見つからない場合も同じメッセージが表示されます。

図 4-43 外部で変更されたワークスペースを開く

上記の操作で作成されたバックアップは、以下のようにして復元できます。

図 4-44 バックアップファイルを復元する

変更済みワークスペースを開く

tpを開く

処理を選択

File > Open Workspace、（または 、 <CTRL>＋ <O>）

メッセージウィ
ンドウが開く

Backup and Proceed： 
WS ディレクトリ下で、Dataディレクトリのコピーを
Data.bak<n> ディレクトリに格納し、WS を開く
Proceed WITHOUT Backup： 
バックアップを作成せずに WS を開く
Cancel： 処理を中止する

バックアップファイルの復旧

ファイルをコピー

WSを開く

Windows エクスプローラ：
...¥<workspace> ディレクトリを開き、Dataフォル
ダを削除するか、フォルダ名を変更、

...¥<workspace>¥Data.bak<n>を開き、

...¥<workspace>下に Dataディレクトリをコピー 

INTECRIO：
File > Open Workspace（または 、<Ctrl> + <O>）
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4.13 グラフィックエディタ上のブロックのレイアウト編集

INTECRIO のプロジェクトコンフィギュレータ（PC）では、グラフィックエ

ディタに表示されるブロックのレイアウト調整を行えます。

図 4-45 グラフィックエディタ上のブロックのレイアウトを編集する

ブロックレイアウトの変更

グローバル設定を変更

ブロックレイアウトを

変更

ポートを移動／ソート

Tools > Options 

Custom、色を選択、
OK

Graphical 
Modeling/ 
Container 
Settings

デフォルトの設定を復元： Reset all または * default color

PC： ブロックをクリック、
ハンドルをドラッグして
サイズを調整 区切り線をマウスで移動

PC： ポートのショートカットメニューの Sort > Ascending / 
Descending でポートをソート、Move Up/Down で 1 つの
ポートを移動

選択
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図 4-46 グラフィックエディタ上のブロックのポートを追加／削除する

ポートの追加／削除

マニュアル操作で行う
場合

“mçêí=oÉéêÉëÉåí~íáçå”
ダイアログボックスを

使用する場合

PC： ポートのショー
トカットメニューの
Remove Port　

WS ブラウザ：
足りないポートをブロックに
ドラッグ

PC： ブロックのショートカット
メニューの 
Open Port Representation　

ウィンドウの表示設定

ポートの追加 / 削除

Apply： 設定を確定
OK： 設定を確定し、
“Port Representation”
ダイアログボックスを閉じる
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4.14 ドキュメントの自動生成

INTECRIO では、システムプロジェクト（SP）のドキュメントを自動生成する

ことができます。

図 4-47 システムプロジェクトの自動ドキュメント生成

ドキュメントの生成

出力フォーマットを

選択

出力先ディレクトリを

選択

内容を指定

ドキュメントを生成

Tools > Options 

左側：
Documentation/
General
右側：
生成ツールと出力
フォーマットを選択、 
OK

WS を選択、
ショートカットメニューの Properties

出力ディレクトリを選択、OK

SP を選択、
ショートカットメニューの Properties

Documentation
を選択し、さらに
System、
Software、
Environment、
Hardware、OS
を選択

内容を選択、OK

Tools > Documentation > Generate
（または か、
SP のショートカットメニューから
Generate Documentation を選択）

Documentation
/ Directories 
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5 INTECRIO チュートリアル

はじめに . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 90
レッスン 1： INTECRIO 用モジュールの準備 . . . . . . . . . . . . . . . . . . . . . . . . 96
レッスン 2： 準備 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 99
レッスン 3： モジュール、ファンクション、ソフトウェアシステム、環境シ

ステム . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 102
レッスン 4： ハードウェアシステム . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 111
レッスン 5： システムプロジェクト . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 112
レッスン 6： プロトタイプの生成 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 118
レッスン 7： 実験 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 126
レッスン 8: ES930 － 設定と操作の例 . . . . . . . . . . . . . . . . . . . . . . . . . . . . 143

5.1 はじめに

本章では、スロットル制御開発の例を用いて、INTECRIO の基本的な操作方法を

学習できます。このチュートリアルで学習するユーザーは、INTECRIO 自体につ

いての詳しい知識は必要ありませんが、Windows オペレーティングシステム、

および BMT（挙動モデリングツール）である MATLAB®/Simulink® に精通して

いる必要があります。

また、チュートリアルを始める前に『INTECRIO ユーザーガイド』の

「INTECRIO を理解する」という章をよく読んでご理解いただくことをお勧めし

ます。

5.1.1 準備

実際の作業を始める前に、システムの準備が必要です。

このチュートリアルに含まれる各操作を実行するには、PC 上に INTECRIO がイ

ンストールされている必要があります。INTECRIO の起動は、デスクトップのア

イコン、または Windows スタート メニューから行います。

「レッスン 1： INTECRIO 用モジュールの準備」レッスン 1 では、MATLAB/
Simulink（バージョン R2016a ～ R2021b と、INTECRIO V5.0 のリリース時点

でリリースされている 32 ビット／ 64 ビットサービスパック）がインストール

されている必要があります。旧バージョン（R2006b ～ R2015b）で作成された

Simulink モデルは、INTECRIO へのインポートは可能です。

「レッスン 2： 準備」で必要なファイルは本製品とともに供給されているので、

レッスン 1 はスキップすることができます。

以下のファイルがサンプルファイルディレクトリ（例： <sample 
files>¥ThrottleDemo¥SimulinkModel、詳しくは 21 ページを参照し

てください）に格納されていることを確認してください。

• throttle_control.mdl

注記

この「はじめに」の項、およびレッスン 1 ～ 7 では実際のハードウェアを使用

する必要がないため、これらのレッスンはオフラインモードで実行できます。

実際にハードウェアが必要なのは「レッスン 8: ES930 － 設定と操作の例」だ

けです。

このチュートリアルでは ETAS Experiment Environment（ETAS 実験環境）

を使用しています。ES800 ハードウェアシステムをターゲットとして使用する

場合は、V3.7.7 以降の ETAS Experiment Environment が必要です。
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• throttle_stimuli.mdl

• throttle_plant.mdl

また、以下のファイルが throttle_*_irt_rtwというサブディレクトリに

格納されていることも確認してください（* = control、stimuli、plant
のいずれか）。

• throttle_*.a2l 

• throttle_*.six 

• throttle_*_main.c 

• throttle_*_irtmacros.h 

「レッスン 8: ES930 － 設定と操作の例」では以下のファイルが必要です。これ

らのファイルが <sample files>¥ES930Demoディレクトリとそのサブディレ

クトリに格納されていることを確認してください。 

5.1.2 記述形式について

• 「character stringと入力します。」は、character stringと

いう文字列をキーボードから入力することを意味します。ただし、以下の

例外があります。

「<INTECRIO drive>¥INTECRIO5.0¥exp1.txtと入力します。」

と書かれている場合、<INTECRIO drive>という文字列の代わりに

INTECRIO がインストールされているドライブを表す文字列を入力してく

ださい。

たとえば、INTECRIO がドライブ C: にインストールされている場合、上

記の指示は「c:¥INTECRIO5.0¥exp1.txtと入力します。」という

意味になります。

• INTECRIO を起動すると表示される INTECRIO ウィンドウは、チュートリ

アルでは「グラフィカルフレームワーク」と呼ばれます。

5.1.3 概念

本項では、このチュートリアルに用いられている重要な用語と、その定義を紹介

します。

統合

「統合」の処理には以下のステップが含まれます。

a 制御アルゴリズムを作成するためのモデルとモデルパーツの組み立て

b そのアルゴリズムを制御対象のハードウェアに接続

c 実行ファイルの生成

INTECRIO　

INTECRIO は、各種 BMT（挙動モデリングツール）で記述された制御ア

ルゴリズムの各部分を結合（統合）し、さらにハードウェアシステムのコ

ンフィギュレーション設定を行ってそのハードウェアシステムを制御アル

ゴリズムに接続するためのツールです。

• OutValConverter.six • Proj_temp.six 

• OutValConverter.a2l • Proj_temp.a2l 

• OutValConverterM.c • Proj_tempM.c 

• OutValConverterM.h • Proj_tempM.h 

• OutputValueConverterM.c • TemperatureM.c 

• OutputValueConverterM.h • TemperatureM.h 
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モジュール（Module）

INTECRIO で使用される「モジュール（Module）」とは、ECU の制御機

能が汎用的な形式で記述されたものを指します。モジュールは、ASCET
（V5.1 以降）のプロジェクトや Simulink のモデルなどに相当します。

ASCET や Simulink でコード生成されたモデルを INTECRIO で使用する

ためには、C コードとともに生成されたインターフェース記述ファイル

（SCOOP-IX、*.six）やデータ記述ファイル（*.a2l）が必要です。モ

ジュールをインポートする際は、インターフェース記述ファイルだけが

INTECRIO に読み込まれます。データ記述ファイルと C コードが必要とな

るのは実行ファイルが生成される時だけです。

各モジュールは、1 つのシステムプロジェクト内において一度だけ使用で

きます。マルチインスタンスはサポートされていません。

ファンクション（Function）

INTECRIO の「ファンクション（Function）」は、ソフトウェアシステム

を構築するための構造オブジェクトで、ファンクション自身には機能はあ

りません。複数のモジュールを組み合わせて互いに接続し、「ファンク

ション」として定義することにより、各モジュールが明確に配置され、扱

いやすくなります。

ソフトウェアシステム（Software System）

「ソフトウェアシステム（Software System）は、ハードウェアに依存し

ないアプリケーションソフトウェアに相当し、制御アルゴリズムを構成す

るモジュールやファンクション、コネクションなどが含まれます。

環境システム（Environment System）

「環境システム（Environment systems）」は、仮想プロトタイピング用

のプラントモデルのモデリングに用いられるものです。ソフトウェアシス

テムと同様にモジュールとファンクションで構成されます。

ハードウェアシステム（Hardware System）

「ハードウェアシステム（Hardware System）には、ECU（実験ターゲッ

ト）やデバイス間インターフェースについての記述が含まれ、これによっ

てハードウェア全体の構成や設定が定義されます。

システムプロジェクト（System Project）
「システムプロジェクト（System Project）」は、ハードウェアシステムと

ソフトウェアシステム、さらにシグナルマッピングやオペレーティングシ

ステム設定を一体化したものです。実行コードの生成は、システムプロ

ジェクトを対象として行われます。

プロトタイプ（Prototype）

「プロトタイプ（Prototype）」は、実験ターゲットシステム用の実行ファ

イルを指します。プロトタイプにはソフトウェアファンクションの実行

コードが書き込まれていますが、これは製品用 ECU を必要としない汎用

的な形式になっています。

ワークスペース（Workspace）

「ワークスペース（Workspace）」は、ソフトウェアとハードウェア、お

よびそれらが割り当てられたシステムプロジェクトが 1 つのファイルセッ

トにまとめられたもので、「ワークスペースブラウザ」というツリー

ビューにその内容が表示されます。ワークスペースは、セッション間でイ

ンポート／エクスポート、ロード／保存が可能です。ワークスペース環境

から、INTECRIO の各種コンポーネントが起動されます。
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グラフィカルフレームワーク

INTECRIO を起動した時に表示されるウィンドウです。INTECRIO のさま

ざまなコンポーネントがこのグラフィカルフレームワークに統合されてい

ます。

左上部はワークスペースブラウザで、ワークスペースのツリービューが表

示されます。右上部には各種コンポーネント用のウィンドウが表示され、

下部には各コンポーネントの出力メッセージが表示されるメッセージウィ

ンドウがあります。

ソフトウェアコンフィギュレーションとプロジェクトコンフィギュレータ

システム全体を機能させるためには、INTECRIO にインポートしたモ

ジュールを互いに接続する必要があります。またソフトウェアとハード

ウェアを接続するための入力と出力（シグナルシンクとシグナルソース）

を作成し、ソフトウェアとハードウェアを接続します。

これらの作業は、INTECRIO のプロジェクトコンフィギュレータ機能を用

いて行います。

ハードウェア接続と INTECRIO-RP ／ VP ハードウェアコンフィギュレータ

制御プラント（「テクニカルプロセス」とも呼ばれます）は、センサとア

クチュエータのセットを表し、制御システムは、各種ハードウェアを経由

してこれらのものに接続します。ここで使用されるハードウェアは、モデ

リングされたテクニカルプロセスに適合するよう設定する必要がありま

す。

ハードウェア接続の作業は INTECRIO のハードウェアコンフィギュレー

タ（「HC」とも呼ばれます）で行います。

INTECRIO-RP のハードウェアコンフィギュレータを使用すると、該当す

るハードウェアシステムの構成の定義とパラメータ設定を行うことがで

き、ここで設定されたモデルが「コントローラ環境」にロードされ、ハー

ドウェアシステムに組み込まれたインターフェースを制御します。

このようにして、外部ソースからのシグナルをコントローラモデル内の適

切な箇所で確実に取得するためのロジックが生成されます。

INTECRIO-VP のハードウェアコンフィギュレータを使用すると、仮想プ

ロトタイピング用ハードウェアシステムの構成の定義とパラメータ設定を

行うことができ、ここで設定されたモデルが「コントローラ環境」にロー

ドされ、VP-PC ハードウェアシステムに組み込まれたインターフェース

を制御します。

このようにして仮想プロトタイピングのためのロジックが生成されます。

オペレーティングシステムのコンフィギュレーション設定

リアルタイムプロトタイプを作成する場合、オペレーティングシステムの

コンフィギュレーション設定は非常に重要な作業です。オペレーティング

システムはプロセッサをめぐって競合するタスクとプロセスの処理シーケ

ンスを決定し、必要に応じてタスクの実行を切り替えます。その際に必要

な設定は、すべてオペレーティングシステムのコンフィギュレーション設

定時に行われます。

OS コンフィギュレータ（OSC）と OSC エディタ

オペレーティングシステムのコンフィギュレーション設定は、INTECRIO
の OSC（OS コンフィギュレータ）エディタで行います。OSC エディタ

は OS コンフィギュレータのユーザーインターフェースで、システムの概

要を素早く把握でき、アプリケーションからの視点でコンフィギュレー

ションを編集することができます。
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ビルド処理とプロジェクトインテグレータ

プロジェクトインテグレータ（PI）は、システム全体、つまりモジュール

とファンクション、ハードウェア接続、OS コンフィギュレーションなど

を 1 つの実行ファイル（「プロトタイプ」と呼ばれます）にまとめます。

この際、実験用の ASAM-MCD-2MC ファイルが生成され、その中に各モ

ジュールの ASAM-MCD-2MC ファイルの内容とプロジェクト全体につい

ての追加情報が格納されます。

実験

ETAS Experiment Environment を使用して、プロトタイプの機能の検証

実験を行います。実験を行う際は、さまざまなタイプの測定／適合インス

トゥルメントを使用できます。

実験はハードディスクに保存されますが、ワークスペースブラウザから開

くことができます。適切な実験をロードすることにより、特定の作業用の

実験環境を素早くセットアップすることができます。

仮想プロトタイピング（Virtual Prototyping - バーチャルプロトタイピング）

車両の電子制御ファンクションの仮想プロトタイプを作成し、PC 上で実

行してテストを行います。仮想プロトタイプは以下のコンポーネントで構

成されます。

– 自動車用組み込みソフトウェア（アプリケーションソフトウェアと

OSEK オペレーティングシステム）

– プラントモデル（環境システム）

仮想プロトタイピングの手法を用いることにより、開発工程の初期段階に

おいて、システムモデルを用いた Model-in-the-Loop（MiL）環境を構築

し、ファンクションを検証することができます。これによって、早い段階

でのファンクションとシステムの並行開発が実現でき、開発工程全体の効

率が向上します。

デイジーチェーンコンフィギュレーション

一般的なインターフェースとは異なり、デイジーチェーンは INTECRIO
内で設定することができません。専用のデイジーチェーンコンフィギュ

レーションツールを用いて設定し、ツールで作成したコンフィギュレー

ションファイルを INTECRIO にインポートします。

ES930

ES930 マルチ I/O モジュールは、コンパクトでありながら耐久性に富ん

だパワフルなツールです。各種入出力チャンネルを搭載しています。

このモジュールで ES910 の機能を拡張することにより、ファンクション

モデル（Simulink®、ASCET、AUTOSAR、C コード）から直接センサを

読み取ったりアクチュエータを制御したりすることが可能になります。

5.1.4 チュートリアルの概要と目標

チュートリアルでは、INTECRIO で行われるさまざまな作業について、スロット

ル制御やその他の例を用いて実習します。

ガソリンエンジンの混合気中の空気量は、スロットルバルブの位置（角度）に

よって変化します。つまりスロットルバルブは、エンジン制御ファンクションの

一部として機能します。

エンジン制御ファンクションは、たとえばエアフロー（つまりはスロットルバル

ブの動作）によってエンジン出力を調整し、所定のエンジン回転数におけるエン

ジントルクを制御します。スロットルバルブが完全には開いていない場合、エン
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ジンに吸入される空気量が絞られ、生成されるトルクが減少します。この「ス

ロットル効果」はスロットルバルブの開度で決まる断面積に依存します。最大エ

ンジントルクはスロットルバルブを全開にした時に得られます。

チュートリアルの各レッスンは、このような制御系のプロトタイプ開発を行う際

の一般的な手順に沿って構成されています。

「レッスン 1： INTECRIO 用モジュールの準備」:  スロットル制御の Simulink モ

デルについて必要な設定を Simulink 上で行い、INTECRIO 用に適したコードを

生成します。

「レッスン 2： 準備」: ワークスペースを作成しセットアップします。

「レッスン 3： モジュール、ファンクション、ソフトウェアシステム、環境シス

テム」:  スロットル制御に属するモジュールを INTECRIO にインポートし、続い

て、2 つのモジュールを結合して 1 つのファンクションを定義します。さらに

ファンクション内でシグナル接続を確立し、外界と接続するためのインター

フェースを作成します。次にソフトウェアシステムを作成してセットアップし、

最後に環境システムを作成して 3 つのモジュールを追加します。

「レッスン 4： ハードウェアシステム」:  仮想プロトタイピング用ハードウェアシ

ステムを作成します。

「レッスン 5： システムプロジェクト」:  システムプロジェクトを作成します。ま

ずハードウェアシステム、ソフトウェアシステム、環境システムをシステムプロ

ジェクト内に組み込み、続いてソフトウェアシステムと環境システムを接続しま

す。

「レッスン 6： プロトタイプの生成」:  オペレーティングシステムのコンフィギュ

レーション設定を行い、さらにコード生成オプションを設定して、スロットル制

御用実行プロトタイプを生成します。

「レッスン 7： 実験」:  作成したプロトタイプを用いて実験を行います。

「レッスン 8: ES930 － 設定と操作の例」:  小規模な ES930 プロジェクトをセッ

トアップして実験を行います。

チュートリアルで習得できること

チュートリアルを終えると、以下の操作が行えるようになります。

• モジュールを INTECRIO にインポートし、それらを結合してソフトウェ

アシステムを作成する。

• ハードウェアシステムを作成してパラメータ設定を行い、ソフトウェアシ

ステムと結合してシステムプロジェクトを作成する

• オペレーティングシステムのコンフィギュレーションを設定し、実行プロ

トタイプを生成してその実験を行う

これらの基本的なステップを学習すれば、その後はオンラインヘルプを参照しな

がらさらに詳細な機能を利用できるようになります。またワークスペースと実験

のサンプルが用意されているので、それらを利用して実際の作業を手早く開始す

ることもできます。
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5.2 レッスン 1： INTECRIO 用モジュールの準備

スロットル制御のファンクションソフトウェアは、BMT（挙動モデリングツー

ル）である Simulink 上で作成された複数のモジュールで構成されます。

INTECRIO で処理可能なコードを BMT で生成するには、コード生成用のオプ

ション設定が必要です。

目標：

スロットル制御の Simulink モデル（throttle_control.mdl）用オプショ

ンを Simulink 上で設定し、INTECRIO で扱えるコードを生成します。生成した

コードは以降のレッスンで使用されます。

モジュール自体を記述する作業は、このチュートリアルに含まれていません。

さらに学習を行いたい場合は、別の Simulink モデル

（throttle_stimuli.mdl、throttle_plant.mdl）を使用してこのス

テップを反復練習してください。

5.2.1 本レッスンで利用する重要な概念

モジュール（Module）

INTECRIO で使用される「モジュール（Module）」とは、ECU の制御機

能が汎用的な形式で記述されたものを指します。モジュールは、ASCET
（V5.1 以降）のプロジェクトや Simulink のモデルなどに相当します。

ASCET や Simulink でコード生成されたモデルを INTECRIO で使用する

ためには、C コードとともに生成されたインターフェース記述ファイル

（SCOOP-IX、*.six）やデータ記述ファイル（*.a2l）が必要です。

5.2.2 Simulink® モデル

本項で使用する throttle_control.mdlという Simulink モデルは、

INTECRIO のサンプルファイルディレクトリ（<sample 
files>¥ThrottleDemo¥SimulinkModel）に格納されています。このモ

デルにはすでに機能が定義されているので、ここではこのモデルを開いて

INTECRIO で使用するために必要なシミュレーションパラメータを設定し、コー

ドを生成します。

操作手順 : Simulink モデルのコードを生成する

1. モデルのバックアップコピーと

throttle_control_irt_rtwフォルダを作成します。

2. Simulink で throttle_control.mdlモデルを開きます。

注記

INTECRIO で扱える ASCET モジュールを作成する方法は、ASCET のマニュア

ルで説明しています。

注記

本項では、MATLAB/Simulink R2016b のユーザーインターフェースを用いて

説明しています。他のバージョンをご使用の場合はユーザーインターフェース

が多少異なります。
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3. Simulink で “Configuration Parameters” ダイアログボックス

を開きます。

4. “Simulation Parameters” ダイアログボックスの “Solver” ノー

ドを開きます。

5. “Fixed-step” タイプのソリューションアルゴリズムを選択しま

す。
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6. "Code Generation" ノードで irt.tlcターゲットを選択しま

す。

irt_default_tmfテンプレートが自動的に選択されます。

ターゲットとテンプレートの組み合わせは ier.tlcと

ier_default_tmfでも可能ですが、irt*と ier*を組み

合わせることはできません。

Generate code only オプションは、INTECRIO ターゲットにつ

いては暗黙的に設定されるので、手動操作でオンにする必要は

ありません。

7. External modeインターフェースがオフ（無効）になって

いることを確認します。

External mode がオンになっていると、ASAM-MCD-2MC ファイ

ルにパラメータが書き込まれなくなってしまいます

8. コードを生成します。

注記

各オプションが上図のように設定されていないと、INTECRIO
用コードは生成されません。
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Simulink モデルが格納されているディレクトリ内に、生成されるファイルを格

納するためのサブディレクトリ hrottle_control_irt_rtwが作成されま

す。生成されるファイルのうち、INTECRIO での作業に必要なのは以下のファイ

ルです。

• throttle_control.a2l 

INTECRIO での実験用に生成される ASAM-MCD-2MC ファイルです。

• throttle_control.six　

インターフェース記述ファイル、つまり SCOOP-IX ファイルです。

• throttle_control_main.c　

このファイルには、INTECRIO で統合を行う ECU ファンクションの主な

部分が含まれています。ファンクションは複数の C 関数（void/void
関数） からなり、これらの関数は、INTECRIO において「プロセス」とし

てオペレーティングシステムに関連付けられます。

• throttle_control_irtmacros.h　

このヘッダファイルには複数のモジュールに用いられる複数の #define

文が含まれています。このファイルは、gcc -include 
throttle_control_irtmacros.hというコマンドにより、他の

ファイルよりも先に処理されます。

throttle_control_irt_rtwサブディレクトリには、Simulink と

Simulink® Coder™ によるコード生成時に生成されるその他のファイルも格納さ

れますが、これらのファイルは INTECRIO での作業には無関係です。これらの

ファイルの内容については各ユーザーマニュアルを参照してください。

5.3 レッスン 2： 準備

レッスン 1 で、実験に必要なファイルを生成したので、次に INTECRIO での作

業準備を行います。まず INTECRIO を起動し、使用するワークスペースを開きま

す。作業を明確化するため、ここではチュートリアル専用のワークスペースを使

用することをお奨めします。ここでセットアップしたワークスペースを元に、以

降の作業を進めていきます。

目標：

チュートリアルに必要なワークスペースを作成し、セットアップします。

5.3.1 本レッスンで利用する重要な概念

グラフィカルフレームワーク

INTECRIO を起動した時に表示されるウィンドウです。INTECRIO のさま

ざまなコンポーネントがこのグラフィカルフレームワークに統合されてい

ます。

ワークスペース（Workspace）

「ワークスペース（Workspace）」には INTECRIO での作業時に作成され

たすべてのデータが含まれます。INTECRIO の各種コンポーネントには

ワークスペースブラウザからアクセスします。

5.3.2 INTECRIO とワークスペース

プログラムを起動（デスクトップの INTECRIO V5.0 アイコン、または

Windows スタート メニューの ETAS INTECRIO 5.0 を選択）すると、INTECRIO
のグラフィカルフレームワークが開きます。この際、“Log Window” 内の
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“Messages” タブ上には、実際に起動された INTECRIO のコンポーネントがリス

トアップされ、それ以外のフィールドには何も表示されません。そして、新しい

ワークスペースを作成するかまたは既存のワークスペースを開くと、そのワーク

スペースがワークスペースブラウザ（“Workspace” ウィンドウ、 デフォルト状態

ではメインウィンドウの左側にドッキングされています）にツリー構造で表示さ

れます。INTECRIO のさまざまな機能を実行する各コンポーネントは、このワー

クスペースブラウザまたはメニューバーから呼び出します。右上部のフィールド

にはさまざまなデータを編集するための各種エディタが表示されます。

まず、メニューコマンド Tools > Options を使用してオプションウィンドウを開

いてください。ここではシステム全体についてのオプション設定（プロジェクト

インテグレータやテキストエディタに関する設定など）を行うことができます。

各オプションについては、オンラインヘルプに詳しく説明されています。

次にワークスペースを作成します。ワークスペースには、INTECRIO での作業時

に作成されたデータが階層的に格納されます。ワークスペースはツリービューで

表示され、ここからモジュールの統合、ファンクションの定義、ハードウェアコ

ンフィギュレーションとシステムプロジェクトの作成などを行います。これらの

アイテムの内容を定義するために使用される各種エディタも、すべてツリー

ビューから呼び出します。

操作手順 : ワークスペースを作成する

1. New Workspace ボタンをクリックします。

“New Workspace” ダイアログボックスが開きます。

2. “Workspace Name” フィールドに、Throttleという名前を

入力します。
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3. “Location” フィールドでワークスペースを保存するパス（例：

D:¥ETASData¥INTECRIO5.0¥Tutorial）を指定しま

す。

4. OK をクリックします。

上記の操作により INTECRIO 上に Tutorialという名前のワークスペースが開

き、同時にこのワークスペースが、ETASData¥INTECRIO5.0¥Tutorial¥
Throttleディレクトリ（上記のパスを使用した場合）に Throttle.iowと

いう名前で保存されます。ワークスペースブラウザにはワークスペースのツリー

構造が表示されますが、この時点ではまだデフォルトアイテムしか表示されませ

ん。

ワークスペースブラウザのデフォルトアイテムは以下のとおりです。

(A)トップアイテム － ワークスペースの名前です。

(B)Hardware — このフォルダに、ワークスペース内のすべてのハードウェ

アシステムが格納されます。各システムに含まれるハードウェアアイテム

は、ハードウェアコンフィギュレータ（HC）により組み込まれ、

Hardware Systems というサブフォルダに格納されます。

(C)Software — 各サブフォルダに以下のものが格納されます。

– Modulesサブフォルダ： プロジェクトに属するソフトウェアモ

ジュールと AUTOSAR ソフトウェアコンポーネント

– Functionsサブフォルダ： 関連するモジュールを集めて構成される

ファンクション

– Software Systemsサブフォルダ： ソフトウェア全体を表すソフ

トウェアシステム

(D)Environment — このフォルダに、プロジェクトに属する環境モジュー

ル（Modulesサブフォルダ）、関連するモジュールを集めて構成される

ファンクション（Functionsサブフォルダ）、そして環境全体を表す環

境システム（Software Systemsサブフォルダ）が格納されます。

(E)Systems — このフォルダに、システムプロジェクト、つまり実験に使用

されるハードウェアとソフトウェアへの参照、ソフトウェアとハードウェ

アの接続情報、オペレーティングシステムのコンフィギュレーションが格

納されます。

ワークスペース内にシステムプロジェクトを作成するには、Systems 
フォルダ内に所定のアイテムが作成されている必要があります。

ワークスペースのプロパティを設定するには、ワークスペースブラウザに表示さ

れているワークスペース名を右クリックし、ショートカットメニューから

Properties を選択して “Options” ダイアログボックスを開きます。設定オプ

ションについての情報は、オンラインヘルプに記載されています。

(A)
(B)

(C)

(D)

(E)
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最後にこのワークスペースを保存します。以降の各レッスンにおいても、最後に

必ずワークスペースを保存してください。

5.4 レッスン 3： モジュール、ファンクション、ソフトウェア

システム、環境システム

目標：

スロットル 制御に必要なモジュールを INTECRIO にインポートし、2 つのモ

ジュールを組み合わせてファンクションを作成します。ファンクション内でシグ

ナル接続を確立し、さらに外部接続用インターフェースを作成します。続いてソ

フトウェアシステムを作成してファンクションを割り当て、最後に環境システム

を作成して 3 つのモジュールを追加します。

5.4.1 本レッスンで利用する重要な概念

モジュールと環境モジュール

INTECRIO で使用される「モジュール（Module）」とは、ECU の制御機

能が汎用的な形式で記述されたものを指します。モジュールは、ASCET
（V5.1 以降）のプロジェクトや Simulink のモデルなどに相当します。

「環境モジュール」には仮想プロトタイピング用プラントモデルの汎用的

な機能を記述したものが含まれます。

ファンクション（Function）

INTECRIO の「ファンクション（Function）」は、ソフトウェアシステム

を構築するための構造オブジェクトで、ファンクション自身には機能はあ

りません。複数のモジュールを組み合わせて互いに接続し、「ファンク

ション」として定義することにより、各モジュールが明確に配置され、扱

いやすくなります。

ソフトウェアシステム（Software System）

「ソフトウェアシステム（Software System）は、ハードウェアに依存し

ないアプリケーションソフトウェアに相当し、制御アルゴリズムを構成す

るモジュールやファンクション、コネクションなどが含まれます。

環境システム（Environment System）

「環境システム（Environment systems）」は、仮想プロトタイピング用

のプラントモデルのモデリングに用いられるものです。ソフトウェアシス

テムと同様にモジュールとファンクションで構成されます。

ソフトウェアコンフィギュレーションとプロジェクトコンフィギュレータ

システム全体を機能させるためには、INTECRIO にインポートしたモ

ジュールを互いに接続する必要があります。またソフトウェアとハード

ウェアを接続するための入力と出力（シグナルシンクとシグナルソース）

を作成し、ソフトウェアとハードウェアを接続します。

これらの作業は、INTECRIO のプロジェクトコンフィギュレータ機能を用

いて行います。

5.4.2 モジュールのインポート

システムの挙動を決定する「モジュール」は、INTECRIO で処理できるモデルの

最小単位で、インスタンス生成できません。つまりモジュールは、直接、または

ファンクションの一部として、1 つのシステムプロジェクト内に 1 回のみ割り当

てられます。
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スロットル制御に属するモジュールは、INTECRIO を PC にインストールした際

にサンプルファイルディレクトリ（<sample files>¥ThrottleDemo¥
SimulinkModel）にコピーされます。レッスン 1 をスキップした場合、その

サブディレクトリ throttle_control_irt_rtwに格納されたファイルを

使用してレッスン 2 を行うことができます。

INTECRIO の観点で見たモジュールの基本構造はどれも同じで、以下のインター

フェースが備わっています。

• シグナルシンク（入力）

• シグナルソース（出力）

• 起動インターフェース（プロセス）

モジュールをインポートする際には、インターフェース記述ファイル（*.six）

だけが読み込まれます。実際の機能が記述されている *.cファイルや *.hファイ

ルは、実行ファイルを生成する際にのみ使用されます（5.7 項）。ASAM-MCD-
2MC ファイルも、実行ファイル生成時まで必要ありません。

操作手順 : モジュールをインポートする

INTECRIO では、各モジュールは Software フォルダ下に保存されます。

1. ワークスペースブラウザに表示されている Modulesフォルダ

を右クリックし、ショートカットメニューから Import Module
を選択します。

ファイル選択ダイアログボックスが開きます。

2. <sample files>¥ ThrottleDemo¥SimulinkModel¥ 

throttle_control_irt_rtwというパスから

throttle_control.sixというファイルを選択します。

3. Open をクリックします。

モジュールがワークスペース内にインポートされ、ワークス

ペースブラウザに表示されます。

4. 同様に、throttle_stimuliという Simulink モデルもイン

ポートします。

ツリービューを見ると、このモジュールの下にシグナルソース（ ）とシグナ

ルシンク（ ）が表示されています。

操作手順 : 環境モジュールをインポートする

INTECRIO では、各環境モジュールは Environment フォルダ下に保存されま

す。

1. ワークスペースブラウザに表示されている Environment /
Modulesフォルダを右クリックし、ショートカットメニュー

から Import Module を選択します。

ファイル選択ダイアログボックスが開きます。
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2. throttle_plantというファイルを選択します。

3. Open をクリックします。

モジュールがワークスペース内にインポートされ、ワークス

ペースブラウザに表示されます。

操作手順 : モジュールを表示する

モジュールと環境モジュールは、グラフィックエディタで表示することができま

す。

1. throttle_controlモジュールを右クリックし、ショート

カットメニューから Open in View を選択します。

グラフィックエディタが開き、このモジュールが表示されます。 

シグナルシンクはブロックの左端に配置され、シグナルソースは右端に配置され

ます。どちらも白抜きの三角形で示され、三角形の隣にエレメント名が表示され

ます。シグナルシンクまたはシグナルソースの名前が長くて表示しきれない場合

は後ろの部分が省略されますが、カーソルでその名前をポイントすると名前全体

がツールチップに表示されます。起動インターフェースは表示されません。

5.4.3 ファンクションの作成

ファンクションは、それ自体には機能を持たない純粋な構造化オブジェクトで

す。関連するモジュールを「ファンクション」としてまとめることにより、モデ

ルの視認性や再利用性が向上します。

ファンクションは以下のコンポーネントで構成されます。

• 1 つ以上のモジュール

• ファンクション内の各モジュールの入力と出力を結ぶコネクション

• ファンクションインターフェース（入力、出力、起動インターフェース）

ファンクションの入力と出力にデータやインプリメンテーション（実装情報）を

持たせることはできません。ファンクションの入力と出力は手動操作で追加し、

入力はファンクション内のモジュールの 1 つまたは複数のシンクに接続でき、出

力は 1 つのモジュールの 1 つのソースだけに接続できます。

Softwareフォルダと Environmentフォルダは完全に区別されています。 
Software フォルダ内のモジュールを Environment フォルダ内のファンク

ションに挿入することはできず、その逆もできません。
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ここではまず、Software フォルダにファンクションを作成します。

操作手順 : 空のファンクションを作成する

1. ワークスペースブラウザで Functionsフォルダを右クリック

し、ショートカットメニューから Create Function を選択しま

す。

2. “Create Function” 入力ダイアログボックスに

Function_Throttleという名前を入力し、OK をクリック

します。

Function_Throttleファンクションがワークスペースブ

ラウザの Functionsフォルダに作成されます。

次に、このファンクションにモジュールを組み込みます。

操作手順 : モジュールを追加する

1. ワークスペースブラウザで Function_throttleファンク

ションを右クリックし、ショートカットメニューから Modules
を選択します。

“Modules“ ダイアログボックスが開きます。Software フォ

ルダ内のモジュールがすべて “Unused modules” フィールドに

表示されます。

2. “Unused modules” フィールドから throttle_controlと

throttle_stimuliというモジュールを選択します。

3. >> ボタンをクリックします。

選択した 2 つのモジュールが “Used modules” フィールドに移

動します。
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4. OK をクリックします。

選択した 2 つのモジュールがファンクションに追加され、ワー

クスペースブラウザ内のファンクション用サブフォルダ内に表

示されます。 

これで、2 つのモジュールがファンクションの一部となったので、次に、シグナ

ルフローを実現する「コネクション」を明示的に確立する必要があります。

INTECRIO では、たとえば同名のシグナルソースとシグナルシンクが自動的に接

続されるというような暗黙的な接続は一切行われません。

ラピッドプロトタイピングにおいては「静的コネクション」と「動的コネクショ

ン」が使用され、後者はプログラム実行時に修正できます。このチュートリアル

では動的コネクションを使用しますが、実験において実際にその接続を変更する

操作は行いません。「動的コネクション」や「コネクション」の扱い全般につい

ての詳しい情報は、ユーザーガイドとオンラインヘルプを参照してください。

コネクションの作成はグラフィックエディタのファンクションビューで行いま

す。新しく作成されるコネクションは、デフォルトでは動的コネクションとして

作成されます。

操作手順 : モジュールを接続する

1. グラフィックエディタで Function_throttleファンク

ションを開きます。

2. 各モジュールの位置を調節し、接続しやすいように以下のよう

に配置します。
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3. 必要に応じて以下のように表示を変更します。

4. カーソルを throttle_stimuliモジュールの

Perc_Desired_Positionというシグナルソースに合わせ

ます。

カーソルが十字カーソルに変わります。

5. マウスの左ボタンを押し下げ、そのままシグナルソース

Perc_Desired_Positionから throttle_controlモ

ジュールの同名のシグナルシンクまで線を引きます。

6. マウスボタンから指を離すと接続が確立されます。

シグナルソースとシグナルシンクの間の「コネクション」が実

線で描かれ、両端の三角形は塗りつぶされます。コネクション

自体は、ワークスペースブラウザには表示されません。

ファンクション内のその他のコネクションは以降のステップで定義しますが、こ

こでは先に、ファンクション外部とのインターフェースを定義する方法を説明し

ます。接続されていないシグナルソースとシグナルシンク（上図の白抜きの三角

形）が自動的にファンクションインターフェースとなるのではないため、手動操

作でインターフェースを作成する必要があります。

これを行うには、ファンクションインターフェース（ファンクションのシグナル

ソースおよびシグナルシンク）を追加し、それらをモジュールのシグナルソース

やシグナルシンクに接続します。ファンクションインターフェースにはデータや

インプリメンテーションは定義されません。ファンクションの各シグナルシンク

（図 5-1 の Sink 1ポートを参照してください）はモジュールの 1 つまたは複数

のシグナルシンクに接続でき、ファンクションの各シグナルソース（図 5-1 の
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Source 1ポートを参照してください）はファンクション内の 1 つのモジュー

ルの 1 つのシグナルソースにのみ接続できます。ファンクションの 1 つのシグ

ナルソースに 2 つ以上のコネクションを定義することはできません（図 5-1 の赤

丸の部分）。

図 5-1 モジュールとポートの接続

操作手順 : ファンクションインターフェースを追加する

1. グラフィックエディタ内の空白部分を右クリックし、ショート

カットメニューから Create Port > Scalar In Port を選択しま

す。

入力ポートが生成されます。 

2. 入力ポートを、適切な位置にドラッグします。

3. throttle_controlモジュールの

V_Position_Signal_Rawというシグナルシンクに入力

ポートを接続して、ファンクションのシグナルシンクを作成し

ます。

入力ポートの三角形が塗りつぶされます。入力ポートには接続

先のシンクの名前が付きます。

4. Create Port > Scalar Out Port で出力ポート（ ）を作

成し、それを throttle_controlモジュールの

F_PWM_Frequencyというシグナルソースに接続します。

これでファンクションのシグナルソースが作成されました。

5. ファンクションのその他のインターフェースを下図のように生

成します。

これでファンクションが定義されたので、次のステップでこれを「ソフトウェア

システム」に組み込みます。

なお、グラフィックエディタの編集機能についての詳細や、ここまでの作業を別

の操作で行う方法は、オンラインヘルプを参照してください。

5.4.4 ソフトウェアシステムと環境システムの作成

仮想プロトタイピング環境には、ECU 制御ファンクションのハードウェア非依

存部分が含まれる「ソフトウェアシステム」と、プラントモデルが含まれる「環

境システム」が必要です。
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ここではまず、空のソフトウェアシステムを作成します。

操作手順 : ソフトウェアシステムを作成する

1. ワークスペースブラウザに表示されている Software 
Systemsフォルダを右クリックし、ショートカットメニュー

から Create Software System を選択します。

“Create Software System” ダイアログボックスが開きます。

2. Throttle_SWS という名前を入力して OK をクリックしま

す。

空のソフトウェアシステムが作成されます。

次に、スロットル制御のファンクションをこのソフトウェアシステムに追加しま

す。この作業はワークスペースブラウザでドラッグアンドドロップ操作により行

います。

操作手順 : モジュールとファンクションを追加する

1. ワークスペースブラウザの Software¥Functionsフォルダ

にある Function_throttleファンクションを

Throttle_SWSというソフトウェアシステムまでドラッグし

ます。

このファンクションがソフトウェアシステムに割り当てられま

す。ファンクションは、ソフトウェアシステムにより「参照」

されます。

次に、ソフトウェアシステム内にハードウェアとのインターフェースを作成しま

す。これには、ファンクションを編集する際に用いたグラフィックエディタを使

用します。
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操作手順 : ソフトウェアシステムにインターフェースを追加する

1. Throttle_SWS ソフトウェアシステムをダブルクリックしま

す。

グラフィックエディタが開き、ソフトウェアシステムが表示さ

れます。

ここで、すべてのシグナルソース／シンクにハードウェア接続

用の外部インターフェースを追加し、それらをファンクション

に接続します。

2. ファンクションのショートカットメニューから Map Ports to 
Software System を選択します。

すると、下図のような結果になります。

最後に、環境システムを作成してセットアップします。

操作手順 : 環境システムを作成してセットアップする

1. ワークスペースブラウザの Environment Systemsフォル

ダを右クリックして、ショートカットメニューから Create 
Environment System を選択します。

2. 環境システムの名前（例 : Environment）を指定します。

3. 環境システムに throttle_plantモジュールを追加します。

4. モジュールの各ポートを環境システムに接続します。
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5.5 レッスン 4： ハードウェアシステム

目標：

仮想プロトタイピング用の「ハードウェアシステム」を作成します。仮想プロト

タイピングにおいては PC を実験用ハードウェアとして使用するので、ハード

ウェアシステムの作成はとてもシンプルです。ラピッドプロトタイピング用の

ハードウェアデバイスの場合はオプション設定の項目数が多くなりますが、それ

については 5.9.3 項「ES910 ハードウェアシステムの作成とセットアップ」に説

明されています。

5.5.1 本レッスンで利用する重要な概念

ハードウェアシステム（Hardware System）

「ハードウェアシステム（Hardware System）には、ECU（実験ターゲッ

ト）やデバイス間インターフェースについての記述が含まれ、これによっ

てハードウェア全体の構成や設定が定義されます。

ハードウェア接続と INTECRIO-VP ハードウェアコンフィギュレータ

ハードウェア接続の作業は INTECRIO のハードウェアコンフィギュレー

タ（「HC」とも呼ばれます）で行います。

INTECRIO-VP のハードウェアコンフィギュレータを使用すると、仮想プ

ロトタイピング用ハードウェアシステムの構成の定義とパラメータ設定を

行うことができ、ここで設定されたモデルが「コントローラ環境」にロー

ドされ、VP-PC ハードウェアシステムに組み込まれたインターフェース

を制御します。

このようにして仮想プロトタイピングのためのロジックが生成されます。

5.5.2 ハードウェアシステムの作成とセットアップ

INTECRIO-VP では PC ターゲットを用いた仮想プロトタイピングを行います。

ハードウェアシステムの作成方法は、ラピッドプロトタイピングの場合と同じで

す。

操作手順 : 仮想プロトタイピング用ハードウェアシステムを作成する

1. ワークスペースブラウザ上の Hardwareフォルダ下の

Hardware Systemsフォルダを右クリックし、ショート

カットメニューから Add Hardware System を選択します。

“Insert Hardware System” ダイアログボックスが開き、使用で

きるハードウェアシステムの一覧（ES800 System、ES900 
System、VP-PC System）が表示されます。
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2. VP-PCを選択して Insert をクリックし、VP-PC システムを追

加します。

“Rename” ダイアログボックスが開いてデフォルト名 VP-PC
が表示されます。

3. 必要に応じて異なる名前を入力し、OK をクリックします。

ワークスペースブラウザに VP-PCシステムが追加され、表示

されます。

ここで使用できるターゲットは 1 つだけなので、直接

“Rename” ダイアログボックスが開きます。

4. 必要に応じて異なる名前を入力し、OK をクリックします。

5.6 レッスン 5： システムプロジェクト

レッスン 1 ～ 3 で、スロットル制御のソフトウェアモジュールをインポートし

て設定し、レッスン 4 でラピッドプロトタイピング実験に必要なハードウェアシ

ステムを作成したので、今度は全体のシステムを作成します。

目標：

システムプロジェクトを作成します。まずシステムプロジェクトにハードウェア

システムとソフトウェアシステムを統合し、続いて、ソフトウェアシステム内や

ソフトウェアとハードウェア間のシグナル接続を確立します。

5.6.1 本レッスンで利用する重要な概念

システムプロジェクト（System Project）
「システムプロジェクト（System Project）」は、ハードウェアシステムと

ソフトウェアシステム、さらにシグナルマッピングやオペレーティングシ

ステム設定を一体化したものです。実行コードの生成は、システムプロ

ジェクトを対象として行われます。

ハードウェアシステム（Hardware System）

「ハードウェアシステム（Hardware System）」には、使用されるECU
（実験ターゲット）やデバイス間のインターフェースに関する情報、と
いったハードウェア全体の構成や設定が含まれます。

ソフトウェアシステム（Software System）

「ソフトウェアシステム（Software System）は、ハードウェアに依存し

ないアプリケーションソフトウェアに相当し、制御アルゴリズムを構成す

るモジュールやファンクション、コネクションなどが含まれます。

環境システム（Environment System）

「環境システム（Environment systems）」は、仮想プロトタイピング用

のプラントモデルのモデリングに用いられるものです。ソフトウェアシス

テムと同様にモジュールとファンクションで構成されます。
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統合

「統合」の処理には以下のステップが含まれます。

a 制御アルゴリズムを作成するためのモデルとモデルパーツの組み立て

b そのアルゴリズムを制御対象のハードウェアに接続（このレッスンで

は行いません）

c 実行ファイルの生成（次項のレッスンの一部）

プロジェクトコンフィギュレータ

システム全体を機能させるためには、INTECRIO にインポートしたモ

ジュールを互いに接続する必要があります。またソフトウェアとハード

ウェアを接続するための入力と出力（シグナルシンクとシグナルソース）

を作成し、ソフトウェアとハードウェアを接続します。

これらの作業は、INTECRIO のプロジェクトコンフィギュレータ機能を用

いて行います。

5.6.2 システムプロジェクトの作成

始めにシステムプロジェクトを作成し、構成を定義します。

操作手順 : システムプロジェクトを作成する

1. ワークスペースブラウザに表示されている Systemsフォルダ

を右クリックし、ショートカットメニューから Create System
を選択します。

“Create System“ ダイアログボックスが開きます。

2. ダイアログボックスに Throttle_SPという名前を入力し、

OK をクリックします。

システムプロジェクトがワークスペースに作成されます。
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次に、5.5 項で作成したハードウェアシステムをシステムプロジェクトに統合し

ます。

操作手順 : ハードウェアシステムを統合する

1. ワークスペースブラウザに表示されている Throttle_SP シ
ステムプロジェクトを右クリックし、ショートカットメニュー

から Add Hardware System を選択します。

“Add hardware system“ ダイアログボックスが開きます。 
Hardware/Hardware Systemsフォルダ内に定義されて

いるハードウェアシステムがリストアップされます。

2. VP-PCを選択して OK をクリックします。

ハードウェアシステムがシステムプロジェクトに統合されます。

ターゲットの下には、オペレーティングシステムコンフィギュ

レーションを表す OS Configurationというアイテムが自

動生成されます。
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さらに、5.4.4 項で作成したソフトウェアシステムをシステムプロジェクトに統

合します。

操作手順 : ソフトウェアシステムを統合する

1. ワークスペースブラウザに表示されている Throttle_SPシ

ステムプロジェクトを右クリックし、ショートカットメニュー

から Add Software System を選択します。

“Software System” ダイアログボックスが開きます。

Software/Software Systemsフォルダ内に定義されて

いるソフトウェアシステムがリストアップされます。

2. Throttle_SWSを選択して OK をクリックします。

ソフトウェアシステムがシステムプロジェクトに統合されます。

さらに、5.4.4 項で作成した環境システムをシステムプロジェクトに統合します。

操作手順 : 環境システムを統合する

1. ワークスペースブラウザに表示されている Throttle_SPシ

ステムプロジェクトを右クリックし、ショートカットメニュー

から Add Environment System を選択します。

2. “Environment System” ダイアログボックスで Environment
を選択し、OK をクリックします。

環境システムがシステムプロジェクトに統合されます。
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5.6.3 ソフトウェアシステムと環境システムの接続

ここではソフトウェアシステムと環境システムを接続して、完全なシグナルフ

ローを定義します。

ソフトウェアシステムと環境システムは、118 ページのように接続します。接続

には接続ウィザードを使用します。

操作手順 : ソフトウェアシステムと環境システムを接続する

1. Throttle_SP システムプロジェクトをダブルクリックしま

す。

グラフィックエディタが開き、システムプロジェクトが表示さ

れます。

ソフトウェアシステムは黄色のブロックとして表示され、環境

システムは緑のブロックとして表示されます。

2. 必要に応じて、ポートのショートカットメニューを使用して

ポートをソートします。

3. ワークスペースブラウザで、システムプロジェクトのショート

カットメニューから Open in Connection View を選択します。

“Throttle_SP - Connections” ウィンドウ（接続ウィザード）が

開きます。“Components with out ports” ドロップダウンリス

トにはシグナルソースを持つすべてのコンポーネントが表示さ

れ、“Components with in ports” ドロップダウンリストにはシ
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グナルシンクを持つすべてのコンポーネントが表示されます。

その下のフィールドには、選択されたコンポーネントのシグナ

ルソース／シンクがリストアップされます。

4. ウィンドウ左側（出力側）のドロップダウンリストでソフト

ウェアシステムを選択し、その下のリストボックスから

Function_Throttle.throttle_control.F_PWM_F

requencyというアイテムを選択します。

5. ウィンドウ右側（入力側）のドロップダウンリストで環境シス

テムを選択し、その下のリストボックスから

throttle_plant.F_PWM_Frequency_Plantというア

イテムを選択します。

接続する入力と出力が選択されると、ダイアログボックス中央

にあるボタンが有効になります。

6. このボタンをクリックしてコネクションを作成します。

作成された「コネクション」が “Existing Connections“ という

表に表示されます。“Dynamics” 列で、その接続のタイプ（動

的または静的）を選択できます。
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7. さらに以下のコネクションを作成します。

接続されたソフトウェアシステムと環境システムは、以下のよ

うになります。

これで、システムプロジェクト作成に関係する作業はほぼ終わりです。次に行う

のは、オペレーティングシステムの設定とプロトタイプの生成です。

5.7 レッスン 6： プロトタイプの生成

目標 :
OS ウィザードを使用してオペレーティングシステムのコンフィギュレーション

を設定します。そしてコード生成用オプションを設定し、最後にスロットル制御

の実行プロトタイプを生成します。

5.7.1 本レッスンで利用する重要な概念

統合

「統合」の処理には以下のステップが含まれます。

a 制御アルゴリズムを作成するためのモデルとモデルパーツの組み立て

b そのアルゴリズムを制御対象のハードウェアに接続

c 実行ファイルの生成

前項までのレッスンは、上記のステップ a に相当するものです。

オペレーティングシステムのコンフィギュレーション設定

オペレーティングシステムはプロセッサをめぐって競合するタスクとプロ

セスの処理シーケンスを決定し、必要に応じてタスクの実行を切り替えま

す。その際に必要な設定は、すべてオペレーティングシステムのコンフィ

ギュレーション設定時に行われます。

OS コンフィギュレータ （OSC）

オペレーティングシステムのコンフィギュレーション設定は、INTECRIO
の「OSC（OS コンフィギュレータ）」というエディタで行います。OSC
エディタは OS コンフィギュレータのユーザーインターフェースで、シス

テムの概要を素早く把握でき、アプリケーションからの視点でコンフィ

ギュレーションを編集することができます。

Throttle_SWS Environment
*.Perc_PWM_Dutycycle_1 *.Perc_PWM_Dutycycle_1_Plant
*.Perc_PWM_Dutycycle_2 *.Perc_PWM_Dutycycle_2_Plant
*.V_Position_Signal_Raw *.V_Position_Signal_Raw_Plant
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ビルド処理とプロジェクトインテグレータ

「プロジェクトインテグレータ（PI）」は、システム全体、つまりモジュー

ルとファンクション、ハードウェア接続、OS コンフィギュレーションな

どを 1 つの実行ファイル（「プロトタイプ」と呼ばれます）にまとめます。

この際、実験用の ASAM-MCD-2MC ファイルも生成します。

プロトタイプ（Prototype）

「プロトタイプ（Prototype）」は、実験ターゲットシステム用の実行ファ

イルを指します。プロトタイプにはソフトウェアファンクションの実行

コードが書き込まれていますが、これは製品用 ECU を必要としない汎用

的な形式になっています。

5.7.2 オペレーティングシステムのコンフィギュレーション設定

実行プロトタイプを生成するには、オペレーティングシステムのコンフィギュ

レーション設定を行い、各プロセスの処理シーケンスを定義する必要がありま

す。

OS コンフィギュレーションは、OS Configurationというアイテムによっ

て定義されます。このアイテムは、ハードウェアシステムを統合した時にシステ

ムプロジェクト内のターゲットの下に自動的に作成されています（114 ページの

「ハードウェアシステムを統合する」を参照してください）。
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操作手順 : OS コンフィギュレータを起動する

1. ワークスペースブラウザに表示されている OS 
Configuration をダブルクリックします。

OSC が開きます。

OSC エディタは 3 つの部分に分かれています。左上部は OS コンフィギュレー

ションビューです。右上部には 3 つのタブがあり、それぞれのタブに、ソフト

ウェアシステム、環境システム、ハードウェアシステムの階層構造が表示されま

す。ウィンドウ下部のフィールドには、OS コンフィギュレーションビューで選

択されているアイテムの属性が表示されます。

OS コンフィギュレーションビューの最上位レベルにはオペレーティングシステ

ム（ ）が表示され、その下にアプリケーションモード（ ）が表示されま

す。また、オペレーティングシステムの直下には、自動的に作成された「Init タ

スク」と「Exit タスク」も表示されます。これらのタスクには以下のような特徴

があり、すべてのアプリケーションモードで使用されます。

• Init — アプリケーションモード開始時に一度だけ実行されます。このタス

クの実行時は割り込みが無効になります。

• Exit — シミュレーション終了時に一度だけ実行されます。このタスクの実

行時は割り込みが無効になります。

これらのタスクに加え、ユーザーはタイマタスクとソフトウェアタスクを作成す

ることができます。タイマタスクはアプリケーションモードの下に作成され、ソ

フトウェアタスクは Software Tasksフォルダ内に作成されます。

操作手順 : アプリケーションモードをセットアップする

アプリケーションモードについては名前の変更だけが可能です。

他の設定は行えません。ここでは、チュートリアル用に設定さ

れている名前をそのまま使用します。

スロットル制御には Task_10msというタイマタスクが必要です。

操作手順 : タイマタスクを作成してセットアップする

1. アプリケーションモードを右クリックし、ショートカットメ

ニューから Add Timer Task を選択します。

名前を指定できるダイアログボックスが開きます。
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2. Task_10msというタスク名を入力して OK をクリックしま

す。

このタスクは OS コンフィギュレーションビュー内のアプリ

ケーションモードの下に作成されます。さらに、このタスク用

の Actionsフォルダが自動的に作成されます。

ラピッドプロトタイピングターゲットの場合は、タイマタスク

用に Events という 2 番目のフォルダも作成されます。

3. この新しいタスクを選択します。

入力フィールドに、タスク属性のデフォルト値が表示されます。

4. 各属性に以下の値を設定します。

各属性についての詳細は、INTECRIO のオンラインヘルプまた

はユーザーガイドの「OSC エディタ」の項を参照してくださ

い。

属性 説明 値

Priority 起動されたタスクの処理シーケ

ンスを決定する、タスク優先順

位

116

Period タスクの起動間隔（単位は秒） 0.01

Delay タスクが実際に起動されるまで

の遅延時間（単位は秒）

0.0

Execution 
Budget

タスクに許容される最長の実行

時間（単位は秒）。0 にすると、

実行時間の監視が行われません。 

0

Max. number 
of activation

タスクを同時に起動できる回数 1

Monitoring タスク用のモニタリング変数を

生成するかどうかを指定するフ

ラグ

True

Exclude from 
Tracing

Trueの場合、システムがこの

タスクを RTA-Trace によるト

レース対象から除外します。 

True
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次に、プロセスをタスクに割り当てます。これには OSC 右上部のフィールドの

“Software” タブと ”Environment” タブを使用します。

操作手順 : プロセスをタスクに割り当てる

1. OS コンフィギュレーションビューを展開して、すべてのタスク

が表示されるようにします。

2. “Software” タブのビューを展開して、すべてのモジュールのプ

ロセスが表示されるようにします。

3. タブの上のドロップダウンリストで、全プロセスを表示する

（All processes displayed）か、または未使用のプロ

セスだけを表示する（Only unused processes 
displayed）かを選択します。

4. irt_OneStep_throttle_controlプロセス

を、“Software” タブから OS コンフィギュレーションビューに

ドラッグし、Task_10msタスクの Actionsフォルダに格納

します。

プロセスがこのタスクに割り当てられます。

5. 残りのプロセスを下図のように各タスクに割り当てます。

各プロセスは、プロセスがタスクに割り当てられた順序と同じ

順序で実行されます。

6. 割り当て順が上図のようになっていない場合は、プロセスを別

の位置にドラッグして、同じシーケンスになるようにしてくだ

さい。
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7. “Environment” タブに切り替えて、環境システムの各プロセス

を適切なタスクに割り当てます。

これで、オペレーティングシステムのコンフィギュレーション設定が終わりまし

た。

5.7.3 ビルド処理

ビルド処理は、いくつかのオプションを設定して処理を開始するだけで、ほぼ自

動的に実行されます。ビルドオプションには 3 種類のレベルがあります。

• アプリケーションレベル： Tools > Options で “Application Wide 
Options” ダイアログボックスを開いて設定します。

• ワークスペースレベル： ワークスペースのショートカットメニュー

Properties で “Workspace Properties” ダイアログボックスを開いて設定

します。

• プロジェクトレベル： システムプロジェクトのショートカットメニュー

Properties で ”System Properties” ダイアログボックスを開いて設定し

ます。

このチュートリアルでは、コンパイラのパスとプロジェクトレベルのビルドオプ

ションを確認します。

コンパイラのパスは、INTECRIO オプションとしてデフォルトパスが自動的に設

定されていますが、必要に応じてそのパスを変更することができます。

操作手順 : コンパイラのパスを確認／設定する

1. Tools > Options を選択します。

“Application Wide Options” ダイアログボックスが開きます。

2. Project Integration フォルダの Toolsグループを開

きます。

3. “Select tool” ドロップダウンリストからコンパイラを選択しま

す。

4. このコンパイラのパスが “Tool Path” フィールドに正しく設定

されていることを確認します。

INTECRIO の製品パッケージには GNU Compiler Suite 
(PowerPC)が含まれているので、このコンパイラのパスが

“Tool Path” フィールドに設定されています。

他のコンパイラを使用する場合は、別途インストールしてくだ

さい。

5. OK でダイアログボックスを閉じます。
123



ETAS － INTECRIO V5.0 入門ガイド INTECRIO チュートリアル
システムプロジェクトのオプション設定を変更することにより、デフォルト設定

されている GNU Compiler の代わりに、PC にインストールされているその他の

コンパイラ（例： Microsoft Visual Studio 2008 コンパイラ）を使用することが

できます。GNU Compiler を使用する場合は、設定を変更する必要はありませ

ん。

操作手順 : コンパイラを選択する

1. ワークスペースブラウザに表示されている Throttle_SPシ

ステムプロジェクトを右クリックして、ショートカットメ

ニューから Properties を選択します。

“System Properties” ダイアログボックスが開きます。

2. Project Integrationフォルダの Compilerグループ

を開きます。

3. “Selected compiler suite” ドロップダウンリストからコンパイ

ラを選択します。

4. 必要に応じて “Compiler Search paths” フィールドに検索先の

パスを入力します。

5. OK でダイアログボックスを閉じます。
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操作手順 : ビルドオプションを設定する

1. ワークスペースブラウザに表示されている Throttle_SPシ

ステムプロジェクトを右クリックし、ショートカットメニュー

から Properties を選択します。

“System Properties” ダイアログボックスが開きます。

2. 左側のフィールドに表示されている Project 
Integrationフォルダの Filesグループを開きます。

このグループのオプションが右側のフィールドに表示されます。

3. “Result File Basename” フィールドに、プロトタイプの 実行

ファイルと ASAM-MCD-2MC ファイルに使用されるベースネーム

として、Throttleと入力します。

他のグループのオプションは、デフォルト設定のままにしておい

てください。

4. OK で設定を有効にします。

操作手順 : 実行ファイルを生成する

1. 以下のいずれかを行います。

- ワークスペースブラウザから Throttle_SPシステムプロ

ジェクトを右クリックし、ショートカットメニューから 
Build を選択します。

前回実行されたビルド処理の結果が現在も有効な場合、ビル

ド処理は実行されません。

- ショートカットメニューから Rebuild を選択します。

前回生成されたファイルは削除され、ビルド処理が実行され

てすべての出力ファイルが再生成されます。

現在の処理についての情報が “Log Window” フィールドの

“Messages” タブに表示されます。また、ウィンドウ最下部の

ステータスバーに進捗バーが表示され、処理の進行状況を示し

ます。

これで、実行可能なプロトタイプが生成されました。次項では、このプロトタイ

プを用いて実験を行います。
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5.8 レッスン 7： 実験

目標 :
実験を行い、スロットル制御モデルをテストします。ETAS Experiment 
Environment を使用して、さまざまな測定／適合インストゥルメントを用いた

実験を行います。

5.8.1 本レッスンで利用する重要な概念

実験

ETAS Experiment Environment を使用して、プロトタイプの機能の検証

実験を行います。実験を行う際は、さまざまなタイプの測定／適合インス

トゥルメントを使用できます。

実験はハードディスクに保存されますが、ワークスペースブラウザから開

くことができます。適切な実験をロードすることにより、特定の作業用の

実験環境を素早くセットアップすることができます。

仮想プロトタイピング（Virtual Prototyping - バーチャルプロトタイピング）

車両の電子制御ファンクションの仮想プロトタイプを作成し、PC 上で実

行してテストを行います。仮想プロトタイプは以下のコンポーネントで構

成されます。

– 自動車用組み込みソフトウェア（アプリケーションソフトウェアと

OSEK オペレーティングシステム）

– プラントモデル（環境システム）

仮想プロトタイピングの手法を用いることにより、開発工程の初期段階に

おいて、システムモデルを用いた Model-in-the-Loop（MiL）環境を構築

し、ファンクションを検証することができます。これによって、早い段階

でのファンクションとシステムの並行開発が実現でき、開発工程全体の効

率が向上します。

5.8.2 準備

まず実験の準備を行います。ETAS Experiment Environment を開き、いくつか

のオプションを指定します。

INTECRIO の場合、実験は独立したアイテムとしては扱われないため、ワークス

ペースブラウザには表示されません。

操作手順 : ETAS Experiment Environment を開く

1. アプリケーションレベルオプションの Check for connected 
hardware がオンになっていることを確認します。

このオプションがオンになっていないと、ETAS Experiment 
Environment は開けません。
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2. ワークスペースブラウザに表示されている Throttle_SPシ

ステムプロジェクトを右クリックします。

3. ショートカットメニューから Open Experiment を選択します。

ETAS Experiment Environment が専用のウィンドウで開き、実

験がロードされます。

この時点では、実験のセットアップはまだ行われていません。そのため、エレメ

ントリスト（デフォルトでは ETAS Experiment Environment ウィンドウの左側

にドッキングされている “Workspace Elements” ウィンドウの “All ASAM” タ

ブ）にはシステムプロジェクトの測定変数と適合変数しか表示されていません。

各変数は、エレメントリスト内のシステムプロジェクトの以下のサブフォルダ

に、タイプごとに分類されて表示されます。

• throttle_controlおよび throttle_stimuli － 各モジュール

の測定変数と適合変数

• throttle_plant － 環境モジュールの測定変数と適合変数

• OSMonitoring － モニタリング変数

このレッスンでは、スロットル制御のプロトタイプ実験に必要な環境をセット

アップします。

5.8.3 実験のセットアップ

スロットル制御用に測定／適合インストゥルメントを作成し、それらに割り当て

る変数を選択することにより、「実験のセットアップ」を行います。ここでは、

以下の変数の測定や適合を行います。

変数 説明

Perc_Desired_Position スロットルバルブ位置の要求値

Perc_Actual_Position スロットルバルブ位置の実測値

K_S_Value, Td_S_Value, 
Ti_S_Value, Tv_S_Value 

PID コントローラの制御パラメータ

Abs_Error_Counter エラーカウント

error_tolerance_yData エラー検知に用いられる許容値
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5.8.3.1 測定／適合インストゥルメントの作成

実験ウィンドウ右側にドッキングされている “Instrumentation” ウィンドウに

は、実験で使用できるすべてのインストゥルメントが表示されています。この

レッスンではそのうちの一部のみを使用します。

数値インストゥルメントとスライダは、割り当てられた変数のタイプ（測定変数

または適合変数）に応じて、測定インストゥルメントまたは適合インストゥルメ

ントとして使用されます。テーブルエディタは適合専用、円ゲージとオシロス

コープは測定専用のインストゥルメントです。

ここで行うスロットル制御の実験では、オシロスコープ、スライダ、円ゲージ、

テーブルエディタを 1 つずつ使用し、さらに数値インストゥルメントを 7 つ使

用します。オシロスコープ、円ゲージ、テーブルエディタ、スライダはそれぞれ

専用のウィンドウに表示し、数値インストゥルメントは 2 つのウィンドウに配置

します。

Stimulus_Select_Value スロットル位置の要求値を取得するためのス

ティミュラスを選択する値

dT タスク起動間の時間差

grossRunTime タスクの総実行時間

注記

2 つ以上の変数を表示できるインストゥルメントは、オシロスコープだけです。

他のインストゥルメントには変数を 1 つしか表示できません。そのため、同じ

タイプのインストゥルメントを複数作成しなければならない場合があります。

変数 説明

スライダ

オシロスコープ

数値インストゥルメント

円ゲージ

テーブルエディタ
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操作手順 : オシロスコープを作成する

1. “Instrumentation” ウィンドウの Oscilloscope アイコン

を、“Instrumentation” フィールドにドラッグします。

新しいオシロスコープが開きます。

2. オシロスコープのサイズを調整します。

円ゲージ、テーブルエディタ、スライダも同様に作成します。

数値インストゥルメントは、測定インストゥルメントと適合インストゥルメント

という 2 つのグループに分けて作成します。ここでは、“Instrumentation” ウィ

ンドウではなく “Workspace Elements” ウィンドウから行う方法を紹介します。

操作手順 : 数値インストゥルメントを追加する

1. “Workspace Elements” ウィンドウで、grossRunTimeと

dTという OS モニタリング変数を選択します。
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2. これらの変数のショートカットメニューから Measure/
Calibrate を選択します。

“Create Instruments” ダイアログボックスが開きます。

数値インストゥルメントを備えた新しい測定ウィンドウを作成

するには、両方の変数についてインストゥルメントタイプ

（”Instrument Type”）に Edit Box、グループ（”Group”）に

<New Group> を選択します。

3. OK で選択内容を確定します。

2 つの数値インストゥルメントを含んだ測定ウィンドウが開き

ます。各インストゥルメントには 2 つの変数がそれぞれ割り当

てられています。

4. 次に、5 つのパラメータ（K_S_Value、Td_S_Value、
Ti_S_Value、Tv_S_Value、
Stimulus_Select_Value）用の適合ウィンドウを作成し

ます。

こんどは、ショートカットメニューの Measure/Calibrate を使

わずに、変数を直接 “Instrumentation” フィールドの空いてい

る場所にドラッグしてください。
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すべてのインストゥルメントを追加したら、下図の例のように

“Instrumentation” フィールド内に配置してください。

5.8.3.2 測定／適合変数の割当て

インストゥルメントを作成したので、次に、測定や適合を行う変数を各インス

トゥルメントに割り当てます。エレメントリストでは、測定変数は赤い正方形の

シンボル（ ）で示され、適合変数は青い円形のシンボル（ ）で示されま

す。

操作手順 : 測定変数と適合変数を割り当てる

1. 測定変数 Perc_Desired_positionを “Workspace 
Elements” タブからオシロスコープにドラッグします。

測定変数がオシロスコープに割り当てられます。

2. 下の表に従い、変数を残りのインストゥルメントに割り当てま

す。

5.8.3.3 測定／適合インストゥルメントのセットアップ

インストゥルメントのセットアップは、シミュレーションの開始前でも実行中で

も任意に行えます。設定オプションについての詳細はオンラインヘルプを参照し

てください。

dTと grossRunTimeの場合は、数値インストゥルメントの表示を調整して小

数点以下の桁数を 6 桁以上にすることをお勧めします。

変数 インストゥルメント

Perc_Actual_Position オシロスコープ

Abs_Error_Counter 円ゲージ／スライダ

error_tolerance_yData テーブルエディタ
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操作手順 : 数値インストゥルメントをセットアップする

1. 測定変数が割り当てられたインストゥルメントをクリックして

選択します。

ここでは、インストゥルメントを含むウィンドウを選択するの

ではなく、ウィンドウ内のインストゥルメントを個別に選択し

てください。

“Properties” ウィンドウに、インストゥルメントのプロパティ

が表示されます。

2. “Number of Decimals” フィールドに、小数点以下の桁数を入

力します。

変更内容は直ちに有効になります。

続いて別のインストゥルメントをセットアップするには、セットアップするイン

ストゥルメントをクリックし、そのインストゥルメントのプロパティを

“Properties” ウィンドウに表示します。
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円ゲージについては、測定変数 Abs_Error_Counterが適切に表示されるよ

うに、いくつかのプロパティを変更します。

操作手順 : 円ゲージをセットアップする

1. “Properties” ウィンドウに円ゲージのプロパティを開きます。

2. 値が正常範囲を外れた時に通知されるようにするには “Normal 
Range Enabled” フィールドの値を Trueにします。

3. “Upper/Lower Bound” フィールドに、正常範囲の上下限値を入

力します。

4. “Autoadjust Scale Range” フィールドで、自動スケール調整を

行う（True）か行わない（False）かを選択します。

Trueを選択すると、表示範囲の上限値が、実際の測定値に応

じて大きくなります。ただし、測定値が表示範囲よりも恒常的

に小さい場合、上限値は自動的には小さくならないので、必要

に応じて手動操作で調整する必要があります。

5. “Maximum/Minimum Value” フィールドに表示範囲の上下限値

を入力します。
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スライダは、測定変数 Abs_Error_Counterが適切な形で表示されるように

いくつかのプリセット値を変更します。

操作手順 : スライダをセットアップする

1. “Properties” ダイアログボックスにスライダのプロパティを開

きます。

“Autoadjust Scale Range” フィールドと “Maximum/Minimum 
Value” フィールドの意味は、円ゲージのものと同じです。

テーブルエディタについては、デフォルト設定のままにします。

オシロスコープについては、チュートリアルでは、座標軸についての最も重要な

設定のみ扱います。グリッドや凡例、チャンネルについては、デフォルト設定を

使用します。

操作手順 : オシロスコープをセットアップする

1. オシロスコープ内で X 軸をクリックします。

“Properties” ウィンドウに X 軸のプロパティが表示されます。

2. “Span” フィールドに 5sを入力し、時間幅の表示範囲を 5 秒に

指定します。

3. オシロスコープ内で Y 軸をクリックし、“Properties” ウィンド

ウに Y 軸のプロパティを表示します。

4. “Number of Decimals” フィールドに 2を入力し、小数部分の

最大表示桁数を 2 桁に設定します。
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Y 軸の表示領域は、ここではまだ変更しません。実際に測定を行いながら、測定

値の範囲に応じて調整します。

5.8.3.4 測定／適合インストゥルメントの保存

設定がすべて完了したら、設定内容全体、つまり「実験」を保存し、後で同じ

GUI 環境を再現できるようにします。

操作手順 : 実験を保存する

1. File > Save Experiment を選択します。

測定／適合ウィンドウについての設定が Default.eexファ

イルに保存されます。

このファイルはワークスペースの実験ディレクトリに格納され

ます。

例： 
ETASData¥INTECRIO5.0¥Tutorial¥Throttle¥EE¥
Experiments¥System¥Default¥Default.eex

2. 実験の名前や保存先を指定するには、File > Save Experiment 
As を選択します。

5.8.4 データ記録に関する設定

データの記録には ETAS Experiment Environment のデータロガー

（“Datalogger” フィールド）を使用します。

データの記録を行うには、まず最初にデータロガーを作成します。

操作手順 : データロガーを作成する

1. “Available Dataloggers” フィールドの Add ボタンをクリック

します。

新しいデータロガーが作成されます。

2. データロガーの名前を変更するには、“Name” 列をクリックし

ます。
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次に、データ記録に関する以下のプロパティを定義します。

• 記録する測定変数

• 記録データを保存するログファイル

• 記録開始／終了のタイミング

操作手順 : 記録する測定変数を選択する

1. “Workspace Elements” ウィンドウから 1 つまたは複数の測定

変数を選択します。

2. 選択した測定変数を右クリックし、ショートカットメニューか

ら Add to Datalogger を選択します。

測定変数がデータロガーの “Signals to record” フィールドに追

加されます。

システムプロジェクトに含まれるタスクがデータ測定タスクと

して設定されます。

操作手順 : ログファイルを指定する

ログファイルについての設定は、データロガーの “Recording File Settings”
フィールドで行います。

1. “Recording base filename” フィールドで、テキストフィール

ドの右側にあるボタンをクリックします。

ファイル選択ダイアログボックスが開きます。

2. ログファイルのパス

（D:¥ETASData¥INTECRIO5.0¥Tutorialなど）とファ

イル名を入力して Save をクリックします。

Auto Increment オプションをオンにすると、ファイル名にシー

ケンス番号が付加され、保存のたびに番号がインクリメントさ

れます。

データ記録の開始／終了のタイミングを決定する条件（「開始フィルタ」／「終

了フィルタ」と呼ばれます）は、“Trigger Settings” フィールドで詳細に設定す

ることができます。シミュレーション開始後、手動操作またはトリガによって記

録を開始し、設定時間だけ記録を行ったり、トリガによって記録を終了したりす

ることもできます。
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チュートリアルでは、手動操作で記録を開始し、設定時間だけ記録を行います。

トリガを使用するデータ記録の方法は、ETAS Experiment Environment のオン

ラインヘルプを参照してください。

操作手順 : 記録時間を指定する

1. データロガーの “Trigger Settings” フィールドで、“Start 
Trigger” 行の右端のボタンをクリックします。

“TriggerEditorDialog” ダイアログボックスが開きます。

2. “Filter Type” フィールドで、StartManualFilterを選択し

ます。

3. “Pre Trigger Time” および “Post Trigger Time” フィールドに、

値 0および 10を入力します。

この設定により、開始操作を行った後、10 秒間だけデータが記

録されます。

データ記録は、データロガーが起動している間のみ行われます。上記のように設

定すると、記録開始後、選択された測定変数のデータが 10 秒間記録され、指定

されたファイル（141 ページの「記録」を参照してください）に保存されます。

このデータは分析ツール（INTECRIO 付属の MDA など）で分析することができ

ます。

5.8.5 測定／適合タスクの実行

本項では、これまでにセットアップした実験を使用して実験を実行します。 

5.8.5.1 シミュレーションの開始

操作手順 : シミュレーションと測定を開始する

1. Experiment Environment の Download ボタンをクリックしま

す。
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2. Start Simulation ボタンをクリックしてシミュレーションを開

始します。

3. Start Measurement ボタンをクリックして測定を開始します。

データロガーによるデータ収集も開始されます。データ収集は、

設定した時間が経過すると終了します。

また測定値は、測定変数が割り当てられている測定インストゥ

ルメントに表示されます。 
ETAS Experiment Environment には下図のように測定値が表示されます。

5.8.5.2 測定

数値表示、円ゲージ、棒グラフ表示

これらの測定インストゥルメントには、シミュレーションと測定が開始されると

すぐに最新の測定値が表示されます。各インストゥルメントの表示設定は、シ

ミュレーション実行中に変更できます（「測定／適合インストゥルメントのセッ

トアップ」を参照してください）。これらのインストゥルメント内では測定デー

タの分析は行えません。

オシロスコープ

オシロスコープもシミュレーションと測定が開始されると最新の測定値を表示し

ます。オシロコープの場合、表示設定や値の分析を行うには、表示を休止（一時

停止）する必要があります。

オシロスコープにおいて、実際の測定値が Y 軸の表示範囲から外れると、測定値

のカーブの全体像を見ることができなくなります。そのような場合、以下のよう

な方法で表示領域を変更できます。 

操作手順 : 表示領域を変更する

1. 測定を一時停止します。
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2. Zoom In ／ Zoom out ボタンをクリックして X 軸のスケールを

変更します。

3. Y 軸の表示範囲を上下にシフトするには、Y 軸上でマウスの左

ボタンを押下し、そのままポインタを上下に移動します。

4. Y 軸のスケールを変更するには、<Ctrl> キーを押したまま Y 軸

上でマウスの左ボタンを押下し、そのまま上下にポインタを移

動します。

5. 現在表示されている値に合わせて Y 軸の表示範囲を自動調整す

るには、Y 軸上でマウスを右クリックしてショートカットメ

ニューを開き、Zoom to Fit を選択します。

6. その他のズーム機能を使用するには、オシロスコープのツール

バーの Zoom ボタンをクリックします。

7. “Properties” ウィンドウで X 軸または Y 軸のプロパティを表示

し、設定を任意に編集することもできます。

8. Resume All（Tracking）ボタンをクリックして表示を続行し

ます。

すべての測定変数を 1 つの座標系に表示すると、表示が煩雑になって視認性が悪

くなってしまう場合があります。そのような場合は、変数ごとに個別の座標軸を

使用することができます。 

操作手順 : 表示形式を設定する

1. オシロスコープのシグナル表示領域を右クリックしてショート

カットメニューを開き、Single Axis per channel を選択しま

す。

2 つの測定変数用にそれぞれ個別の Y 軸が割り当てられ、各軸

の表示範囲を個別に設定できるようになります。

2. オシロスコープのシグナル表示領域を右クリックしてショート

カットメニューを開き、Single Strip per channel を選択しま

す。

オシロスコープが上下に 2 つの領域に分割され、それぞれの領

域に各測定変数が表示されます。Y 軸も個別に割り当てられま

す。

下図にその例を示します。
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操作手順 : 測定データを分析する

1. オシロスコープの Pause All ボタンをクリックして測定データ

表示を一時停止します。

2. Add Cursor ボタンをクリックします。

表示領域にラインカーソルが表示されます。

3. カーソルをもう 1 本追加します。

4. マウスでカーソルをドラッグし、値を読み取りたい位置まで移

動します。

各カーソルの名前が表示され、チャンネルごとに、カーソル位

置の Y 値が下部のチャンネルリスト内に表示されます。

5. 2 番目のカーソルを右クリックし、ショートカットメニューか

ら Show Cursor difference > A: <X value> を選択します。

2 本のカーソルの時間の差異がカーソル付近に表示され、Y 値

の差異がチャンネルリスト内に表示されます。

5.8.5.3 適合

適合変数（特性値、特性カーブ、特性マップ）をインストゥルメントに割り当て

ると、そのインストゥルメントはエディタとして機能します。さまざまなタイプ

のエディタで、適合変数の値を直接変更することができます。

操作手順 : 各種エディタで値を適合する

1 数値エディタで特性値を適合する場合

1. エディットボックスのテキスト領域をクリックします。

2. スクロールボタンを使用するか、または値を入力します。

新しい値が直ちに有効になります。
140



ETAS － INTECRIO V5.0 入門ガイド INTECRIO チュートリアル
3. PID コントローラの制御パラメータを適合し、変数

Perc_Actual_Positionの変化をオシロスコープで観察

してください。

2. テーブルエディタで特性カーブ（例： error_tolerance_YData）を

適合する場合

1. テーブルのセルをダブルクリックします。

2. 新しい値を入力します。

3. Apply をクリックします。

新しい値が有効になります。

4. 許容値を適合しながら、変数 Abs_Error_Counterの変化

を円ゲージとスライダで観察してください。

5.8.5.4 記録

5.8.4 項においてデータロガーの設定を行ったので、測定を実行し、さらにデー

タ記録を開始します。

操作手順 : 測定データを記録する

1. データロガーを表示します。

“Available Dataloggers” フィールドの “State” 列に、データロ

ガーの現在のステータスが表示されます。

2. “Active” 列をクリックしてデータロガーを起動します。

チェックマークが表示されてデータロガーが起動し、さらに、

右側の列の記録開始ボタンが有効になります。

3. 記録開始ボタンをクリックします。

このボタンの押下により記録開始のマニュアルトリガが発生し

て記録が開始され、10 秒後に自動的に停止します。

記録された測定データは、指定されたファイル（例： 
D:¥ETASData¥INTECRIO5.0¥Throttle¥MyLogfile0001.datな

ど）に保存されます。このデータは、分析ツールなどを用いたオフライン分析に

使用することができます。

5.8.5.5 仮想プロトタイピング実験の特殊な機能と条件

ここまでの内容は仮想プロトタイピングとラピッドプロトタイピングの両方に共

通の内容でしたが、ここでは仮想プロトタイピング固有の特殊な機能や条件につ

いて説明します。
141



ETAS － INTECRIO V5.0 入門ガイド INTECRIO チュートリアル
VP 実験の場合は、実験環境内に “VP Execution Mode” ウィンドウ（ETAS 
Experiment Environment ウィンドウの右側にドッキングされています）が表示

され、そこでシミュレーション時間の制御モードを選択することができます。

デフォルトでは Scaled Time が選択され、ファクタが 1 に設定なっています。

Windows のリアルタイム性能には限界があるため、システム負荷が高い処理に

おいては遅延や障害が発生する可能性があり、それによって変則的なデータが測

定される場合があります（下図の矢印の箇所）。

このため、仮想プロトタイピング実験を行う時には、リソースを消費する他のプ

ログラムを終了しておくことをお勧めします。

Adaptive Time モデルを可能な限り高速で、つまり最短の処理時間で実行

します。

Scaled Time

（デフォルト）

モデルをリアルタイム（Scaling Factor = 1）、早送り

（Scaling Factor < 1）、スローモーション（Scaling 
Factor > 1）のいずれかで実行します。
142



ETAS － INTECRIO V5.0 入門ガイド INTECRIO チュートリアル
障害が発生すると、どのタスクが実行されなかったかを通知するメッセージが

“Hardware Output” タブに出力されます。

操作手順 : VP 実行モードを変更する

1. 測定とオペレーティングシステムの両方を停止します。

2. “VP Execution Mode” ウィンドウで以下のいずれかを行いま

す。

- Adaptive Time モードを選択する

- Scalling Factor の値を変更する（142 ページ参照） 
3. オペレーティングシステムを再起動して測定を再開し、データ

表示の違いを確認してください。

5.9 レッスン 8: ES930 － 設定と操作の例

目標 : 
ES910 に接続された ES930 を使用する方法を学習します。ES930 モジュールを

含むデイジーチェーンのコンフィギュレーションを手動操作で設定し、そのコン

フィギュレーションを ETAS Experiment Environment でテストします。

5.9.1 本レッスンの最重要コンセプトの概要

ハードウェア接続と INTECRIO-RP ／ VP ハードウェアコンフィギュレータ

制御プラント（「テクニカルプロセス」とも呼ばれます）は、センサとア

クチュエータのセットを表し、制御システムは、各種ハードウェアを経由

してこれらのものに接続します。ここで使用されるハードウェアは、モデ

リングされたテクニカルプロセスに適合するよう設定する必要がありま

す。

ハードウェア接続の作業は INTECRIO のハードウェアコンフィギュレー

タ（「HC」とも呼ばれます）で行います。

注記

オペレーティングシステムを実行させたままシミュレーショ

ンタイムモードを変更することはできません。

注記

このレッスンの実験を行うには、ES910.3 ハードウェア、HSP V12.1 以降、

デイジーチェーンコンフィギュレーションツール、および所定のケーブルが必

要です。

マルチ I/O モジュール ES930 は ES830 ターゲットにも接続できますが、その

構成に関する情報は本レッスンには含まれません。
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INTECRIO-RP のハードウェアコンフィギュレータを使用すると、該当す

るハードウェアシステムの構成の定義とパラメータ設定を行うことがで

き、ここで設定されたモデルが「コントローラ環境」にロードされ、ハー

ドウェアシステムに組み込まれたインターフェースを制御します。

このようにして、外部ソースからのシグナルをコントローラモデル内の適

切な箇所で確実に取得するためのロジックが生成されます。

デイジーチェーンコンフィギュレーション

一般的なインターフェースとは異なり、デイジーチェーンは INTECRIO
内で設定することができません。専用のデイジーチェーンコンフィギュ

レーションツールを用いて設定し、ツールで作成したコンフィギュレー

ションファイルを INTECRIO にインポートします。

ES930　

ES930 マルチ I/O モジュールは、コンパクトでありながら耐久性に富ん

だパワフルなツールです。各種入出力チャンネルを搭載しています。

このモジュールで ES910 の機能を拡張することにより、ファンクション

モデル（Simulink®、ASCET、AUTOSAR、C コード）から直接センサを

読み取ったりアクチュエータを制御したりすることが可能になります。

5.9.2 ES930 デイジーチェーンモジュールの設定

コンフィギュレーションの設定は ETAS のデイジーチェーンコンフィギュレー

ションツールで行います。その後、ツールで作成した *.xmlコンフィギュレー

ションファイルを INTECRIO にインポートします。

操作手順 : 新しいデイジーチェーンコンフィギュレーションを作成する

1. ES930 を ES910 に接続します。

2. ES910 を PC に接続します。

3. デスクトップアイコンなどからデイジーチェーンコンフィギュ

レーションツールを起動します。

“ ハードウェアコンフィギュレーション ” ウィンドウが開きま

す。

4. “ ハードウェアコンフィギュレーション ” ウィンドウに ES930
モジュールを追加します。

5. チェーンの IP アドレスを入力します。

6. データ転送の遅延が最小化されるように Hardware > Activate 
Rapid Prototyping を選択します。

デフォルトでは、すべてのデジタル入力／出力、アナログ入力／出力、温度チャ

ンネルがイネーブルになっています。このチュートリアルでは 2 つのデジタル出

力チャンネルと 1 つの温度チャンネルしか使用しないので、それ以外のチャンネ

ルはディセーブル（= 無効）にしてください。

注記

このウィンドウについての詳しい情報は、オンラインヘルプ

を参照してください。
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操作手順 : 温度チャンネルを設定する

1. 温度センサを ES930 モジュールの Thermo チャンネルの 1 つ

に接続します。

2. “ ハードウェアコンフィギュレーション ” ウィンドウの “ ネット

ワーク構成 ” ペインから、“温度 ”ノードを選択します。

3. “ 温度入力 ” タブで、センサを接続したチャンネルをイネーブル

（チェックマークをオン）にします。

4. レート、測定範囲 min、測定範囲 max に適切な値を入力しま

す。

5. 必要に応じて、使用していない温度チャンネルもイネーブルに

して、診断を行えるようにします。

以下に設定例を示します。

操作手順 : 診断チャンネルを設定する

1. “ ハードウェアコンフィギュレーション ” ウィンドウの “ ネット

ワーク構成 ” ペインから、“診断 ”ノードを選択します。

2. ES930_D_TH1_CH<n>_OpenWireチャンネルをイネーブ

ルにします。

実験中、これらのチャンネルは対応する温度チャンネルが使用

されていないときには trueを返し、使用されているときには

falseを返します。

3. “ ハードウェアコンフィギュレーション ” ウィンドウでオンライ

ン測定を開始します。

下のスクリーンショットはオンライン測定実行中の “ 診断 ” タ

ブを示しています。

操作手順 : デジタル出力チャンネルを設定する

1. “ ハードウェアコンフィギュレーション ” ウィンドウの “ ネット

ワーク構成 ” ペインから、“ デジタル出力 ” ノードを選択します。
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2. 第 1 チャンネルと第 2 チャンネルをイネーブルにします。

3. 両方のチャンネルについて、PWM 出力モード を選択します。

4. 各チャンネルのアクティブステートを選択します。

5. 各チャンネルにユーザー LED を 1 つずつ割り当てます。

6. アクティブ時間 と パルス周期 の初期値を定義します。

以下に設定例を示します。

操作手順 : デイジーチェーンのコンフィギュレーションを完成させる

1. 設定が終わったら、デイジーチェーンを初期化します。

2. コンフィギュレーションファイルを保存します。

指定されたディレクトリに *.xmlファイルと *.gcfファイ

ルが書き込まれます。INTECRIO で ES930 を使用する際は、こ

の *.xmlファイルが必要です。

デイジーチェーンコンフィギュレーションツールで行う作業はここまでです。

5.9.3 ES910 ハードウェアシステムの作成とセットアップ

5.9.3.1 ES900 システム

操作手順 : ES900 システムを作成する

1. ワークスペースブラウザ上の Hardwareフォルダ下の

Hardware Systemsフォルダを右クリックし、ショート

カットメニューから Add Hardware System を選択します。

“Insert Hardware System” ダイアログボックスが開き、使用で

きるハードウェアシステムの一覧（ES800 System、ES900 
System、VP-PC System）が表示されます。
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2. ES900 Systemを選択して Insert をクリックし、ES900 シ

ステムを追加します。

“Rename” ダイアログボックスが開いてデフォルト名 ES900
が表示されます。

3. 必要に応じて異なる名前を入力し、OK をクリックします。

ワークスペースブラウザに ES900 システムが追加され、表示さ

れます。

空のシステムが作成されたので、ここにスロットル制御に必要なデバイスを追加

する必要があります。ここでは ES910 ターゲットとデイジーチェーンを順に追

加します。

5.9.3.2 ES910 シミュレーションターゲット

ES910 シミュレーションターゲットは、ハードウェアコンフィギュレータで作

成するハードウェア構成全体のマスタデバイスとして機能します。INTECRIO　

V5.0 以降では、1 つのターゲットしかサポートしていないハードウェアシステ

ムについては、自動的にターゲットが追加されるので、その下にその他のデバイ

スを追加していきます。

ターゲットを削除してしまった場合は、手動で追加することができます。詳細は

INTECRIO オンラインヘルプを参照してください。

操作手順 : 実験ターゲットを設定する

1. ワークスペースブラウザに表示されている ES910をダブルク

リックします。

ES910 用のハードウェアコンフィギュレータが開き、デバイス

パラメータが表示されます。

2. ここではプリセットされているデフォルト値をそのまま使用し

ます。

5.9.3.3 デイジーチェーンデバイス

操作手順 : デイジーチェーンデバイスを作成する

1. ワークスペースブラウザ内の ES910を右クリックし、ショー

トカットメニューから Insert を選択します。

2. “Insert new Item” ダイアログボックスで Daisychainを選択

します。

パラメータ名 意味

Name デバイスの名前

IO Failure Behavior I/O 初期化時にエラーが発生した

際の対処方法
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3. Insert をクリックします。

4. デフォルトの名前を変更する場合は “Rename” ダイアログボッ

クスに新しい名前を入力し、OK をクリックします。

ターゲットに Daisychainデバイスが追加されますが、その

内容はまだ空の状態です。

5. Daisychainデバイスを右クリックし、ショートカットメ

ニューから Import Daisychain Configuration を選択します。

インポートウィザードが開きます。

6. ウィザードの指示に従い、5.9.2 項で作成した *.xmlデイジー

チェーンコンフィギュレーションファイルをインポートします。

次に、このデバイスを「アクティブ化」します。

操作手順 : デイジーチェーンデバイスをアクティブにする

1. Daisychainデバイスのショートカットメニューを開きます。

Enabled メニューコマンドの横にチェックマークが付いている

場合、このデバイスはアクティブになっています。

2. そうでない場合は Enable を選択してデバイスをアクティブにし

ます。
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操作手順 : デイジーチェーンデバイスを設定する

1. ワークスペースブラウザ内の Daisychainを右クリックし、

ショートカットメニューから Open を選択します。

デイジーチェーンデバイス用のハードウェアコンフィギュレー

タが開き、"Node" タブにデバイスパラメータが表示されます。

"Node" タブには一般的なデバイスパラメータが表示されます。

各パラメータについてはオンラインヘルプに詳しく説明されて

います。

値を編集するには、その値のセルをクリックします。パラメー

タの種類により、直接入力する場合と、ドロップダウンリスト

から値を選択する場合とがあります

灰色の背景で表示されたフィールドは編集できません。

2. デバイスのステータスシグナルをアクティブにします。

3. 必要に応じて、パラメータの "Comments" 欄にコメントを入力

します。

操作手順 : シグナルグループを設定する

1. ワークスペースブラウザ内のシグナルグループ

Inputs_ES930_MIO1_TH_100msをダブルクリックしま

す。

シグナルグループの ハードウェアコンフィギュレータが開き、

シグナルグループのスパラメータが表示されます。各パラメー

タについてはオンラインヘルプに詳しく説明されています。

灰色の背景で表示されたフィールドは編集できません。

2. 必要に応じて、パラメータの "Comments" 欄にコメントを入力

します。

3. シグナルグループをアクティブにします。

4. 他のシグナルグループを設定します。

上記の方法以外に、デイジーチェーンのハードウェアコンフィギュレータ（149
ページ参照）を開いて “Signal Groups” タブを選択すると、そこでもシグナルグ

ループの設定（コメント以外）が行えます。
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操作手順 : シグナルを設定する

1. 以下のいずれかを行います。

- デイジーチェーンのハードウェアコンフィギュレータで

"Signals" タブを選択します。

全シグナルグループに含まれるすべてのシグナルのパラメー

タが表示されます。

- シグナルグループのハードウェアコンフィギュレータで

"Signals" タブを選択します。

そのシグナルグループに含まれるシグナルのパラメータが表

示されます。

- ワークスペースブラウザ上のシグナルをダブルクリックしま

す。

そのシグナルのパラメータを含むハードウェアコンフィギュ

レータが開きます。 
シグナルパラメータについてはオンラインヘルプに詳しく説明

されています。

灰色の背景で表示されたフィールドは編集できません。

2. 必要に応じて、シグナルパラメータの "Comments" 欄にコメン

トを入力します。

これでハードウェアシステムの定義が完了したので、これをシステムプロジェク

トに追加することができます。

その他のハードウェアデバイスの使用方法については、オンラインヘルプを参照

してください。

5.9.4 ES930 による実験

5.9.4.1 システムプロジェクトの作成

実験を行うには完全なシステムプロジェクトが必要です。このために、以下の 2
つのソフトウェアモジュールが用意されています。

• OutValConverterは、周波数とデューティーサイクルを使用して、

ES930 のデジタル出力チャンネルの HIGH タイム（アクティブタイム）

とパルス周期の値を算出します。

• Proj_tempは Thermo チャンネルで測定された温度を °C から °F に変

換します。

操作手順 : システムプロジェクトを作成する

1. 103 ページの説明に従い、ソフトウェアモジュール

OutValConverterおよび Proj_tempをインポートしま

す。

*.sixファイル、およびその他の必要なファイルは <sample 
files>¥ES930Demo ディレクトリのサブディレクトリ

OutValConverterおよび Proj_tempにあります。

2. ソフトウェアシステム（109 ページ参照）を作成し、それに名

前を付けます（例： SWS_ES930）。
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3. インポートしたモジュールをソフトウェアシステムに追加し

（109 ページ参照）、必要なインターフェースを下図のように追

加します（108 ページと 110 ページ参照）。

4. 113 ページの説明に従ってシステムプロジェクトを作成し、そ

れをアクティブシステムにして名前（例： SP_ES930）を付け

ます。

5. ハードウェアシステムとソフトウェアシステムをシステムプロ

ジェクトに統合します（114 ページと 115 ページ参照）。

操作手順 : ハードウェアシステムをセットアップする

1. ワークスペースブラウザで SP_ES930システムプロジェクト

を右クリックし、ショートカットメニューから Devices を選択

します。

“Devices” ダイアログボックスが開きます。

このダイアログボックスの使用方法は、105 ページの 
"Modules" ダイアログボックスと同じです。ここにはハード

ウェシステムに含まれるデバイスが表示されます。

2. “Unused modules” フィールド内の

Daisychain.Daisychainというエントリを "Used 
devices" フィールドに移動します。

Daisychain.Presenceというエントリにはデバイスのス

テートを表すシグナルが含まれますが、このチュートリアルで

は使用しません。

3. OK をクリックします。

デイジーチェーンがシステムプロジェクトで使用できるように

なりました。 
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操作手順 : ハードウェアとソフトウェアを接続する

1. グラフィックエディタで SP_ES930システムプロジェクトを

開きます。

システムプロジェクトがブロック図で表示されます。

ハードウェアデバイスは青いブロックのセットとして表示され

ます。ソフトウェアシステムのシグナルシンクに接続できる

ハードウェアチャンネルは、1 つのブロックの右側にまとめら

れ、ソフトウェアシステムのシグナルソースに接続できるハー

ドウェアチャンネルは、もうひとつのブロックの左側にまとめ

られています。

2. 下図のように接続します（116 ページ参照）。

表示を見やすくするため、使用されていない SWS ポートは非

表示になっています。

操作手順 : オペレーティングシステムを設定する

1. OSC を開きます。
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2. OS Auto Mapping ボタンをクリックして、OS コンフィギュ

レーションの自動設定を行います。

必要なタスクと ISR が作成され、“Software” タブと

“Hardware” タブのプロセスが自動的に割り当てられます。

システムプロジェクトを作成してコンパイラを選択したら、実行ファイルを生成

します。

操作手順 : プロトタイプを生成する

1. ビルドオプションを設定します（125 ページ参照）。

2. プロトタイプを生成します（125 ページ参照）。

実行ファイル SP_ES930.rtaが生成され、ワークスペースの

出力用ディレクトリ（例： ETASData¥INTECRIO5.0¥
Tutorial¥ES930_demo¥Results）に格納されます。

5.9.4.2 ES910 の設定

デイジーチェーン用の IO インターフェースを使用するには、ES910 のポート設

定をグラフィックユーザーインターフェースで確認する必要があります。この確

認を行うには、ES910 を PC に接続してウェブブラウザアプリケーションを使用

します。

ES910 ユーザーインターフェースは、下記とは異なる方法で開くこともできま

す。詳しくは ES910 ユーザーガイドを参照してください。
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操作手順 : IP アドレスを確認してコンフィギュレーションインターフェースを

開く

1. Windows のシステムトレイに表示されている IP-Manager ア
イコンを右クリックして、ショートカットメニューから 
Ethernet System Configuration を選択します。

“Ethernet System Configuration” ダイアログボックスが開きま

す。

“System or Master view” フィールドに IP アドレスが表示され

ます。

2. この IP アドレスを Web ブラウザに入力し、ES910 ユーザーイ

ンターフェースを開きます。
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操作手順 : ES910 を設定する

3. ES910 ユーザーインターフェースのスタートページにある、

Device configuration リンクをクリックします。

4. “Device configuration” ページの “Device configuration” とい

うキャプションの下にある Port configuration リンクをクリック

します。

5. Micro I/O interfaceの ES400 daisy chain オプション

がオンになっていることを確認します。

6. コンフィギュレーションを保存します。

5.9.4.3 実験の実行

以上の設定で、実験の準備は完了です。6 個の数値インストゥルメントと 4 個の

LED インストゥルメントを使用して、以下の変数の測定と適合を行います。

操作手順 : 実験をセットアップする

1. ETAS Experiment Environment を開きます（126 ページ参

照）。

変数 ソース 備考

dutycycle1 SW
モジュール

パラメータ

OutValConverter

モジュールの入力frequency1

dutycycle2

frequency2

highTime1 SW
モジュール変数

OutValConverter

モジュールの出力period1

highTime2

period2

ES930_TH1_CH3 HW
温度チャンネル

測定された温度

Temp_C SW
モジュール変数

Proj_tempモジュー

ルの入力／出力Temp_F

ES930_D_TH1_CH1_OpenWire HW
診断チャンネル

温度チャンネルが接続

されている（false）
かいない（true）かを

調べます。

ES930_D_TH1_CH2_OpenWire

ES930_D_TH1_CH3_OpenWire

ES930_D_TH1_CH4_OpenWire
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2. 以下の変数用に 3 つのグループの数値インストゥルメントを作

成します（129 ページ参照）。

3. 変数 ES930_D_TH<n>_CH<n>_OpenWire用に、4 個の

LED インストゥルメントからなるグループを 1 つ作成します。

4. 実験を保存します（135 ページ参照）。

グループ 変数

1 dutycycle1

frequency1

dutycycle2

frequency2

2 highTime1

period1

highTime2

period2

3 ES930_TH1_CH3

Temp_C

Temp_F
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操作手順 : 実験を実行する

1. シミュレーションと測定を開始します（137 ページ参照）。

数値ディスプレイと LED インストゥルメントに測定値が表示さ

れます。

ES930 のフロントパネルにあるユーザー LED（U1 と U2）が点

滅します。

2. 第 1 グループのパラメータを編集し、ES930 上にあるユーザー

LED の点滅パターンの変化を観察します。
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6 ETAS ネットワークマネージャ

ネットワークアダプタの設定は、ETAS ネットワークマネージャを使用して行い

ます。ETAS ネットワークマネージャは、ETAS IP マネージャが使用するコン

フィギュレーション（ネットワーク構成）を作成するためのツールで、IP マ

ネージャは、ネットワーク接続された ETAS ハードウェアのダイナミック IP ア

ドレッシングを行います。

ETAS ネットワークマネージャは、Windows スタートメニューのアプリ一覧か

ら表示できます。例：E > ETAS > ETAS Network settings
ETAS ネットワークマネージャについての詳しい情報は、ネットワークマネー

ジャのオンラインヘルプを参照してください。オンラインヘルプを開くには、

ネットワークマネージャで <F1> キーを押します。
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7 一般的なトラブルシューティング

この章では、個々のソフトウェアやハードウェアに依存しない一般的な問題が発

生した場合の対処法について説明します。

7.1 ETAS ネットワーク用のネットワークアダプタを選択でき

ない

原因： APIPA が無効になっている

IP アドレッシングの代替メカニズムである APIPA は、Windows XP ／ Vista 環

境では、通常は有効に設定されていますが、時にはネットワークセキュリティポ

リシーによって無効となっている場合もあります。そのような場合、DHCP 設定

のネットワークアダプタ（ネットワークカード）を ETAS ハードウェアのアクセ

スに使用することはできず、そのアダプタを選択すると ETAS ネットワークマ

ネージャは警告メッセージを表示します。

無効になっている APIPA メカニズムを有効にするには、Windows のレジストリ

を編集する必要がありますが、これを行うには管理者の権限が必要です。ネット

ワーク管理者の方にご相談のうえ行ってください。

操作手順 : APIPA メカニズムを有効にする

1. 以下のように操作します。

i. <Windows ロゴ > + <R> を押します。

ii. regedit と入力し、OK をクリックします。

レジストリエディタが開きます。

2. 以下のフォルダを開きます。

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSe
t\Services\Tcpip\Parameters\

3. 編集 > 検索 を選択して以下のキーを検索します。

IPAutoconfigurationEnabled

4. APIPA メカニズムが有効になるように、見つかったキーの値を

すべて 1 に変更します。

Windows のレジストリ内には、この名前のキーがいくつか含ま

れている場合があります。これらは一般的な TCIP/IP サービス

用のものと、個別のネットワークアダプタ用のものです。ETAS
ネットワーク用に使用するアダプタについてのみ値を変更して

ください。

5. レジストリエディタを閉じます。

6. 変更されたレジストリの内容を有効にするため、PC を再起動し

ます。

注記

APIPA メカニズムが無効になっていない場合、レジストリ内

にこのキーは存在しません。このキーが存在する場合のみ、

以下の操作で APIPA メカニズムを有効にしてください。
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7.2 PC に接続されたイーサネットハードウェアが検出できな

い

接続エラーの原因としてはさまざまなものが考えられますが、一般的には

Windows やハードウェアの設定が正しく行われていないことが原因となってい

ることが多く、これらの原因が特定できれば容易にエラーを解決することができ

ます。

以下に原因を特定して解決するためのヒントをいくつかご紹介します。

原因： ハードウェアバージョンと ETAS ソフトウェアのバージョン

に互換性がない

ETAS ハードウェアを ETAS ソフトウェアに接続して使用する場合、ETAS の

HSP アップデートツールを利用して、以下のようにハードウェアのファーム

ウェアバージョンをチェックすることができます。

• 最新の HSP（Hardware Service Pack： ハードウェアサービスパック）

に含まれる HSP アップデートツールを使用します。

• HSP アップデートツールを使用して、ハードウェアのバージョンがソフ

トウェアのバージョンと互換性があるかどうかをチェックします。

• PC ドライバが必要なハードウェアの場合、ドライバが正しくインストー

ルされているかどうかをチェックします。

最新バージョンの HSP は、ETAS ホームページのダウンロードセンター

（https://www.etas.com/ja/products/download_center.php）からダウンロー

ドできます。

最新の HSP アップデートツールでも検出されない場合は、そのハードウェアが

Web インターフェースを実装しているかをチェックしてください。実装してい

る場合は Web インターフェース経由で検索し、それでも見つからない場合は、

以下の原因が考えられます。

原因： パーソナルファイアウォールによる通信のブロック

パーソナルファイアウォールは、ETAS のイーサネットハードウェアへのアクセ

スを妨害する場合があります。そのような場合、ハードウェアの自動検索時に、

コンフィギュレーションが正しく設定されているのにもかかわらずイーサネット

ハードウェアがまったく検出されない、という状態が発生する可能性がありま

す。

また、ファイアウォールが適切に設定されていないと、ETAS ソフトウェアにお

ける特定の操作（例： ASCET で実験を開く、INCA や HSP でハードウェアを検

索する、など）を実行する際に不具合が発生する場合があります。

ファイアウォールによって ETAS ハードウェアとの通信がブロックされる場合

は、ETAS ソフトウェア使用中はファイアウォールソフトウェアを無効にする

か、またはファイアウォールの詳細設定を行って以下のアクセスを許可するよう

にしてください。

ETAS ハードウェアに関するアクセス許可

• UDP を経由する、デスティネーション IP アドレス 255.255.255.255 へ
の送信用 IP ブロードキャスト（デスティネーションポート： 17099 また

は 18001）

• UDP を経由する、ソース IP アドレス 0.0.0.0 からデスティネーション IP
アドレス 255.255.255.255 への受信用 IP ブロードキャスト（デスティ

ネーションポート： 18001）
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• UDP を経由する、ETAS ネットワークへの直接 IP ブロードキャスト（デ

スティネーションポート： 17099 または 18001）

• UDP を経由する、ETAS ネットワーク内のすべての IP アドレスへの送信

用 IP ユニキャスト（デスティネーションポート： 17099 ～ 18001）

• UDP を経由する、ETAS ネットワーク内のすべての IP アドレスからの受

信用 IP ユニキャスト（ソースポート： 17099 ～ 18020、デスティネー

ションポート： 17099 ～ 18020）

• ETAS ネットワーク内への送信用 TCP/IP 接続（デスティネーションポー

ト： 18001 ～ 18020）

XCP on Ethernet に関するアクセス許可

• UDP 経由の XCP スレーブ検知のための、ETAS ネットワーク内のすべて

の IP アドレスへの送信用 IP マルチキャスト（デスティネーション IP 
239.255.0.0、ポート： 5556）

• UDP 経由の XCP スレーブ検知のための、ETAS ネットワーク内のすべて

の IP アドレスからの受信用 IP マルチキャスト（デスティネーション IP 
239.255.37.45、ポート： 3745）

アクセス許可についての詳細（実際にどのような許可が必要か、またその許可を

与えることは可能であるか、など）は、IT 担当の方にご確認ください。

原因： リモートアクセス用クライアントソフトウェアによる通信の

ブロック

ETAS ハードウェアネットワーク外で使用されている PC には、リモートアクセ

ス用クライアントソフトウェアがインストールされているものがあり、それに

よって ETAS ハードウェアへのアクセスが妨害される場合があります。それには

以下のような状況が考えられます。

• イーサネットメッセージをブロックするファイアウォールが使用されてい

る（160 ページの「原因： パーソナルファイアウォールによる通信のブ

ロック」を参照してください）

• トンネリングに使用されている VPN クライアントソフトウェアが誤って

メッセージをフィルタリングしてしまうことがあります。たとえば Cisco 
VPN クライアントの V4.0.x より前のバージョンでは、特定の UDP ブ

ロードキャストを不正にフィルタしてしまう、というケースがありまし

た。

このケースに該当する場合は、VPN クライアントソフトウェアのバー

ジョンをアップデートしてください。

注記

実際のポート番号は、使用するハードウェアに応じて異なります。ポート番号

についての詳しい情報は、ハードウェアのドキュメントを参照してください。

ご注意ください！

ファイアウォール構成の変更によるシステムの安全性の低下への影響

ファイアウォール設定を変更して PC をネットワークに再接続する際には、前

もって社内の IT セキュリティポリシーをご確認ください。その際には IT 担当

の方にご相談いただくことをお勧めします。
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原因： ETAS ハードウェアのフリーズ

ETAS ハードウェアが何らかの理由でフリーズしてしまった可能性もあります。

この場合は、ハードウェアの電源を切ってから再投入してください。これによっ

てハードウェアは再初期化されるので、多くの場合、正常に戻ります。

原因： ETAS ハードウェアがスリープモードになっている

ETAS ハードウェアには、省電力の目的で、他のデバイスは PC に接続されてい

ないときにはスリープモードに切り替わるものがあります。

スリープモードに切り替わらないようにするには、PC のイーサネットケーブル

をハードウェアの “HOST” ／ “Sync In” ポートに接続し、ハードウェアの起動後

に Web インターフェースでハードウェアに接続し、設定を変更してください。

詳しくはハードウェアのマニュアルを参照してください。

原因： ネットワークアダプタへの IP アドレス割り当てが一時的に失

われた

PC の接続を、DHCP が使用されている社内 LAN から ETAS ハードウェアに切

り替える際、PC が ETAS ハードウェアを検知できるようになるまでに約 60 秒

かかります。これはオペレーティングシステムが DHCP プロトコルから ETAS
ハードウェア用の APIPA に切り替わる処理に要する時間です。

原因： ETAS ハードウェアが他の論理ネットワークに接続されている

1 つの ETAS ハードウェアに対して複数の PC からアクセスする場合、各 PC で

使用されるネットワークアダプタは、同じ論理ネットワークを使用するように設

定しておく必要があります。このように設定することが不可能である場合、他の

PC を切り替える前に ETAS ハードウェアの電源を切って再投入してください。

原因： ネットワークアダプタ用のデバイスドライバが起動していな

い

ネットワークアダプタ用のデバイスドライバが起動していない可能性がありま

す。その場合は、ネットワークアダプタを一旦無効にしてから再度有効にしてく

ださい。

操作手順 : ネットワークアダプタを無効にして、再度有効にする

1. Windows の コントロールパネル を開きます。

2. ネットワークと共有センター  を開き、さらに アダプターの設定

の変更 リンクをクリックします。

3. ネットワークの接続 ウィンドウで 、ETAS ネットワーク用に使

用されているデバイスを右クリックし、ショートカットメ

ニューから 無効にする を選択します。

4.続いて同じショートカットメニューから 有効にする を選択し、

アダプタを有効にします。

原因： ラップトップ PC の電源管理システムによってネットワークア

ダプタが無効になっている

ラップトップ PC の電源管理システムにより、ネットワークアダプタが無効に

なっている場合があります。その場合は、ラップトップ PC の電源管理を無効に

してください。
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操作手順 : ラップトップ PC の電源管理を無効にする

1. Windows のスタートメニューから、コントロールパネル > ハー

ドウェアとサウンド > デバイスマネージャ を選択します。

2. デバイスマネージャ ウィンドウで ネットワークアダプタ のツ

リーを展開します。

3. 使用するネットワークアダプタを右クリックし、ショートカッ

トメニューから プロパティ を選択します。

4. 電源の管理 タブを選択し、コンピュータでこのデバイスの電源

をオフできるようにする オプションをオフにします。

5. 詳細設定 タブを選択し、プロパティ に Autosense が含まれて

いる場合は、これを無効（Disabled）にします。

6. OK をクリックして設定を有効にします。

原因： ネットワークの自動切断

ネットワークアダプタのデータトラフィックが一定の時間途絶えると、ネット

ワークアダプタが自動的にイーサネット接続を切断する場合があります。これ

は、レジストリの autodisconnectキーを設定することによって避けること

ができます。

操作手順 : レジストリキー autodisconnectを設定する

1. レジストリエディタを開きます。

2. HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Ser

vices\lanmanserver\parametersというフォルダに

含まれるレジストリキー autodisconnectの値を

0xffffffffに変更します。
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8 お問い合わせ先

製品に関するご質問等は、各地域の ETAS 支社までお問い合わせください。

ETAS 本社

ETAS GmbH

日本支社

イータス株式会社

その他のお問い合わせ先

上記以外のお問い合わせ先につきましては、ETAS ホームページをご覧くださ

い。

Borsigstrasse 24 Phone: +49 711 3423-0
70469 Stuttgart Fax: +49 711 3423-2106
Germany WWW: www.etas.com/

〒 220-6217
神奈川県横浜市西区 Phone: (045) 222-0900
みなとみらい 2-3-5 Fax: (045) 222-0956
クイーンズタワー C 17F WWW: www.etas.com/

各国支社 WWW: www.etas.com/ja/contact.php
技術サポート WWW: www.etas.com/ja/hotlines.php

https://www.etas.com/ja/hotlines.php
https://www.etas.com/
https://www.etas.com/
https://www.etas.com/
https://www.etas.com/
https://www.etas.com/ja/contact.php
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9 用語集

この用語集では、INTECRIO のマニュアルに使用されている専門用語と略語につ

いて解説します。ここに紹介する多くの語は一般的な用語としても用いられてい

ますが、この用語集では、各語が特に INTECRIO について使用される場合の意味

が説明されています。

用語はアルファベット順および 50 音順に並んでいます。

9.1 略語

API　
Application Programming Interface（アプリケーション開発者向けプロ

グラミングインターフェース）

ASAM-MCD　

自動化および測定システムの標準化を行うための、測定、適合、および診

断の作業部会（ドイツ語：Arbeitskreis zur Standardisierung von 
Automations- und Mess-systemen, mit den Arbeitsgruppen Messen, 
Calibrieren und Diagnose）

ASAM-MCD-2MC　

ECU ソフトウェアに含まれる適合変数と測定変数についての情報を記述

するためのファイルフォーマットで、実験用インターフェースについての

情報も保存されます。実験を行う際、このファイル（拡張子は A2L）から

実験に必要な情報を読み込みます。

INTECRIO V5.0 は、ETK AML の V1.1（フックベースバイパスのみ）と

V1.2 ～ V1.7（フックベースバイパス／サービスベースバイパス）、XETK 
AML の V2.5 まで、ASAP1B_Bypass AML の V1.0 以降、SBB AML の

V2.0、V3.0、V3.1 をサポートしています。

詳しい情報は https://www.asam.net を参照してください。

ASCET　

ECU ソフトウェア開発用の ETAS 製品ファミリ － ASCET のモデルを

INTECRIO にインポートできます。

ASCET-MD　

ASCET Modeling & Design（ASCET 製品ファミリに含まれる BMT）

ASCET-RP　

ASCET Rapid Prototyping（ASCET 製品ファミリのラピッドプロトタイ

ピングツール）

AUTOSAR　

Automotive Open System Architecture（自動車用オープンシステムアー

キテクチャ、 https://www.autosar.org を参照してください）

BMT　

Behavioral Modeling Tool（挙動モデリングツール） － BMT では、モデ

ルの挙動を編集し、シミュレーションやアニメーションを行い、ファンク

ションコードを生成することができます。

BR_XETK　

車載イーサネットインターフェースを採用した ETK（エミュレータテスト

プローブ）

BR_XETK を使用するには、ES882 ／ ES886 を含む ES800 ハードウェア

システムが必要です。
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BSW

Basic software（基本ソフトウェア） － 通信や I/O の機能のほか、各種ソ

フトウェアコンポーネントに必要な諸機能を提供します。

CAN　

Controller Area Network（コントロールエリアネットワーク） － 強靭な

車両バス規格のひとつ。ホストコンピュータがなくてもマイクロコント

ローラと各種デバイスのアプリケーション同士が互いに通信し合うことが

できます。

CANdb　

CAN database －  Vector Infomatik 社の CANdb データ管理プログラム

で作成された CAN ディスクリプションファイル

INTECRIO V5.0 は CANdb V2.3 以降をサポートしています。

CPU

Central Processing Unit（中央演算処理装置） － INTECRIO では、マイク

ロコントローラを意味します。

DISTAB　

Display Table － ETK バイパス実験において実験ターゲットと ECU との

間のデータ交換に使用されるデータ交換メソッド

INTECRIO V5.0 は、DISTAB12 以降（XETK AML： DISTAB13）を用い

たフックベースバイパスと、DISTAB13 を用いたサービスベースバイパス

をサポートしています。

INTECRIO V5.0 では、ES830 または ES910.3 を使用することにより

DISTAB17 を用いたバイパスも利用可能です。

ECU　

Electronic Control Unit（電子制御ユニット） － CPU と周辺機器からな

る、小型の組み込み型コンピュータシステム

一般的に、すべてのコンポーネントが 1 つの筐体に収められています。

ETK　

Emulator-Taskopf（「エミュレータテストプローブ」を表すドイツ語）

FETK　

ES89x ECU ／バスインターフェースモジュール対応の ETK
FIBEX　

Field Bus Exchange － XML スキーマをベースとするデータ交換フォー

マットで、車載通信ネットワーク全体を記述するものです。

FIBEX はさまざまなネットワークタイプ（CAN、LIN、MOST、FlexRay）
用に定義されていて、バスアーキテクチャ、信号、ネットワークノードの

プロパティなどについての情報を記述できるようになっています。

FIBEX ファイルフォーマットは ASAM（Association for Standardization 
of Automation and Measuring Systems：自動化／測定システム標準化

委員会）により標準化されています。

INTECRIO V5.0 は FIBEX ベースラインバージョンの FIBEX V2.0.x と

V3.1.0（V3.1.0 については制限事項がありますので、詳しくはオンライ

ンヘルプを参照してください）をサポートしています。

詳しい情報は https://www.asam.net を参照してください。

FIFO　

First in、first out（先入れ先出し）
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HBB　

hook-based bypass（フックベースバイパス）

HC　

Hardware Configurator（ハードウェアコンフィギュレータ）

IER　

INTECRIO Embedded Coder Real-Time Target（INTECRIO に Simulink
モデルをインポートするための Embedded Coder リアルタイムターゲッ

ト）

INCA　

Integrated Calibration and Acquisition Systems（ETAS の測定／適合シ

ステム）

INTECRIO V5.0.1 には INCA V7.2.17 以降が対応しています。

INCA-EIP　

INCA のアドオンです。 INCA からラピッドプロトタイピングターゲット

（ES910、ES830）や仮想プロトタイピングターゲット（VP-PC）へのア

クセスを実現します。

INTECRIO V5.0.1 には INCA-EIP V7.2.17 以降が対応しています。

INTECRIO-RP　

INTECRIO Rapid Prototyping パッケージ － ラピッドプロトタイピングへ

の接続機能を提供します。

INTECRIO-VP　

INTECRIO Virtual Prototyping パッケージ － 仮想プロトタイピングへの

接続機能を提供します。

IRT　

INTECRIO Real-Time Target（INTECRIO に Simulink モデルをインポー

トするための Simulink Coder リアルタイムターゲット）

LDF　

LIN description File（LIN ディスクリプションファイル） － LIN コント

ローラ用コンフィギュレーションファイル

INTECRIO V5.0.1 は LDF V1.3、V2.0、V2.1、V2.2 をサポートしていま

す。

LIN　

Local Interconnect Network（ローカル相互接続ネットワーク） － 車載コ

ンポーネント間の相互通信に使用されるシリアルネットワークプロトコル

CAN ほどの帯域幅や汎用性を必要としない用途において使用され、一般

的な例としては、電気自動車のドアやシートのネットワーク接続などが挙

げられます。

LSB および lsb　

大文字表記の場合は最下位バイト（Least Significant Byte） － 小文字表記

の場合は最下位ビット（least significant bit）
MDA　

Measure Data Analyzer（測定データアナライザ） － 保存された測定デー

タを表示して分析するための ETAS オフラインツール

MSB および msb　

大文字表記の場合は最上位バイト（Most Significant Byte） － 小文字表記

の場合は最上位ビット（most significant bit）
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OIL　

OSEK Implementation Language（OSEK 実装言語） － ECU ネットワー

ク用記述言語

OIL はオペレーティングシステムを間接的に構成するパーツで、ECU ネッ

トワークの静的情報（通信接続や ECU のプロパティなど）の記述に使用

されます。

OS　

Operating System（オペレーティングシステム）

OSC　

Operating System Configurator（OS コンフィギュレータ）

OSEK　

Offene Systeme für die Elektronik im Kraftfahrzeug（自動車エレクトロ

ニクス向けオープンシステムのための作業部会のドイツ語表記）

PDU　

Protocol data unit（プロトコルデータユニット） － プロトコルスタック

内のレイヤ間で受け渡しされる情報の単位で、ペイロードと制御情報が含

まれます。

INTECRIO V5.0 では、FlexRay の PDU はシグナルグループに相当しま

す。

RE

Runnable Entity（ランナブルエンティティ） － 実行時において RTE から

トリガされる一連のコード。INTECRIO で扱われる従来の「プロセス」に

相当します。

RP

Rapid prototyping( ラピッドプロトタイピング ):173 ページ「ラピッド

プロトタイピング」 を参照してください。

RTA-OSEK　

ETAS のリアルタイムオペレーティングシステム － AUTOSAR-OS V1.0
（SC-1）と OSEK/VDX OS V2.2.3 を実装し、MISRA コンポーネントに完

全準拠しています。

RTA-OS　

ETAS のリアルタイムオペレーティングシステム － AUTOSAR R3.0 OS
と OSEK/VDX OS V2.2.3 を実装し、MISRA コンポーネントに完全準拠し

ています。

RTA-RTE　

ETAS が提供する AUTOSAR ランタイム環境

RTE

AUTOSAR runtime environment（AUTOSAR ランタイム環境） － SWC
（ソフトウェアコンポーネント）、BSW（基本ソフトウェア）、OS（オペ

レーティングシステム）間のインターフェースとなるものです。

RTIO　

Real-Time Input-Output（リアルタイム I/O）

SBB　

Service-based bypass（サービスベースドバイパス）

SBC

Sensotronic Brake Control（電気油圧式ブレーキシステム）
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SCOOP　

Source Code, Objects, and Physics（ソースコード、オブジェクト、お

よび物理的現象）

SCOOP-IX　

SCOOP Interface Exchange language（SCOOP インターフェース交換言

語）

INTECRIO V5.0 は SCOOP-IX の V1.0、V1.1、V1.2、V1.4、V1.5 をサ

ポートしています。

SP　

Service point： 171 ページ「サービスポイント」 を参照してください。

SWC

AUTOSAR Software Component（AUTOSAR ソフトウェアコンポーネン

ト） － AUTOSAR アプリケーションにおけるソフトウェアの最小単位

UDP　

User Datagram Protocol

UML　

Unified Modeling Language（統一モデリング言語）

VFB　

AUTOSAR の Virtual function bus（仮想ファンクションバス） 
VP

Virtual prototyping （仮想プロトタイピング）171 ページ「仮想プロトタ

イピング」 を参照してください。

XCP　

Universal measurement and calibration protocol（汎用測定／適合プロ

トコル） － x は、さまざまな種類の転送層を使用できることを表します。

正式名称は ASAM MCD-1 XCP です。

INTECRIO V5.0 は XCP V1.0 のほか、V1.0 に互換なすべての上位バー

ジョンをサポートしています。さらに、V1.1 以降の XCPplusキーワー

ドもサポートしています。

XETK　

イーサネットインターフェースを採用した ETK（エミュレータテストプ

ローブ）

XML　
Extensible Markup Language（拡張可能なマークアップ言語）

9.2 用語

AUTOSAR ソフトウェアコンポーネント

「SWC」を参照してください。

Embedded Coder®　

Simulink® CoderTM 用アドオン。Simulink Coder の機能を拡張して、組

み込み型ターゲット上での量産アプリケーションの記述、統合、デプロ

イ、およびテストを可能にします。
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FlexRay　
FlexRay は高い伝送速度で決定論的データ交換を行うための、拡張可能な

耐障害性の通信システム。時分割の手続きにより、モジュール性に優れ安

全性の高い分散システムを構築でき、2 チャンネル上で 10MBaud の高周

波数帯域を実現します。現代の自動車は革新的な電子システムの搭載量が

年々多くなり、ネットワーク負荷も増大しつつありますが、高周波数帯域

の使用によって、このような状況への対応も可能となります。

この通信システムの仕様は、世界中の自動車メーカーとサプライヤに広く

サポートされている「FlexRay コンソーシアム」という委員会により策定

されました。

INTECRIO　

各種 BMT（挙動モデリングツール）で作成された制御アルゴリズムの

パーツを統合し、プロトタイピング実験の環境を構築するツール。ハード

ウェアシステムのコンフィギュレーションを設定し、実験用ハードウェア

と制御アルゴリズムを接続することができます。

MATLAB®　

技術計算用の高性能言語。1 つの環境に、数学計算、視覚化、プログラミ

ングなどの機能が備わっています。

MATLAB® CoderTM　

MATLABコ ード用のコードジェネレータ

OS コンフィギュレータおよび OSC　

オペレーティングシステムに含まれるタスクは、INTECRIO 内の OS コン

フィギュレータによって設定されます。OSC エディタは、この設定を行

うためのエディタです。このエディタでは、システム構成を素早く把握で

き、アプリケーションからの視点で表示されたソフトウェアの要素を、容

易にオペレーティングシステムに組み込むことができます。

RTA-Trace　
ECU への汎用インターフェースを介してシステム挙動を監視できるソフ

トウェアトレースツール。現在、生産中止していますが、既存のインス

トーラーは現在も使用できます。

Simulink®　

動的システムのモデリング、シミュレーション、分析を行うためのツー

ル。Simulink のモデルを INTECRIO にインポートできます。

Simulink® CoderTM　

Simulink ／ Stateflow モデル用のコードジェネレータ。MATLAB® 
CoderTM が必要です。

Stateflow®　

複雑なイベントドリブンシステムのモデリングとシミュレーションを行う

ためのツール。MATLAB/Simulink にシームレスに統合されています。

X パス実験

バイパス実験とフルパス実験を組み合わせた実験。実験ターゲット

（ES900、ES800）は、バイパスフックを持つ ECU を外部インターフェー

スとして利用します。

アクチュエータ

実行ハードウェアユニット。電子信号処理とメカニクスとの物理的なイン

ターフェースです。
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アプリケーションモード

アプリケーションモードはオペレーティングシステムの実行モードです。

EEPROM プログラミングモード、初期化モード、通常運転モードなど、

システムのさまざまな状態に対応します。

イベント

オペレーティングシステムのアクション（タスクなど）を開始するための

外部トリガ。

イベントインターフェース

「プロセス」を参照してください。

インプリメンテーション

物理的に定義されたモデル値から、実際に実行されるプログラム用の固定

小数点値への変換規則を記述したもの。1 つの線形変換式とモデル値の範

囲制限とで定義されます。

仮想プロトタイピング

自動車の電子制御ファンクションの仮想プロトタイプを作成することによ

り、PC 上で制御ロジックのテストを行えます。

環境システム

環境システムは、仮想プロトタイピングにおいてプラントモデルをモデリ

ングするためのものです。ソフトウェアシステムと同様、モジュールと

ファンクションで構成され、作成方法もソフトウェアシステムの場合と同

じです。

基本ソフトウェア

「BSW」を参照してください。

グラフィカルフレームワーク

INTECRIO のメインウィンドウ。このウィンドウでさまざまな INTECRIO
コンポーネントを統合します。

クロスバー

AUTOSAR に該当しないモジュール、ファンクション、ハードウェアの間

で行われる通信について、その管理と制御を行うものです。

検証

ある開発フェーズの成果が、そのフェーズの仕様を満たしているかどうか

を判断するために、システムまたはコンポーネントを評価するプロセス。

ソフトウェアの検証においては、特定の開発ステップについて定義された

仕様がソフトウェアに正しく実装されているかを検証します。

コネクション（静的）

静的コネクションとして定義されたシグナルソースとシグナルシンク間の

接続は、ランタイムにおいて変更できません。

コネクション（動的）

動的コネクションとして定義されたシグナルソースとシグナルシンク間の

接続は、ビルド処理を行わなくてもランタイムにおいて変更できます。

サービスポイント

ECU ソフトウェア内のプロセスをカプセル化したもので、ターゲットシ

ステムとのデータ転送アクションを行います。これらのアクションはユー

ザーが有効化したり設定したりすることができます。
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サービスポイントクラスタ

ECU において同じ優先度で実行される複数のサービスポイントのグルー

プ（同じ ECU タスク内に配置された複数のサービスポイント）

サービスポイントクラスタグループ

複数のサービスポイントクラスタのグループ。グループには、ECU 内で

同時に呼び出される可能性のあるすべてのタスクのすべてのサービスポイ

ントが含まれます。

システムプロジェクト

ハードウェアシステム、ソフトウェアシステム、環境システム（仮想プロ

トタイピングの場合）、シグナルのマッピング、およびオペレーティング

システムのコンフィギュレーションを、1 つのプロジェクトとして一体化

したもの。実行コードは、システムプロジェクト単位で生成されます。

センサ

センサは、物理的または化学的な量（通常は電気的でない量）を電気的な

量に変換します。

ソフトウェアシステム

ソフトウェアシステムには ECU ファンクションの汎用部分（モジュール、

ファンクション、接続情報）が含まれています。

タスク

タスクは複数のプロセスの実行シーケンスを定義するもので、オペレー

ティングシステムにより起動されます。タスクの属性には、アプリケー

ションモード、起動トリガ、優先度、スケジューリングモードなどがあり

ます。タスクが起動されると、タスクに割り当てられた一連のプロセス

が、指定の順序で実行されます。

妥当性確認

作成されたシステムまたはコンポーネントが、アプリケーションに対する

ユーザー要件を満たすものであるかどうかを判断するための評価プロセ

ス。ここでは、ユーザーの承認がとれるシステムまたはコンポーネントが

作成されたかどうかを確認します。

統合

複数の会社においてさまざまなツールを用いて開発されたモデルコードを

結合して制御アルゴリズムを構築し、ターゲットハードウェア用にそのア

ルゴリズムを調整して、最終的に実行ファイルを作成すること。

ハードウェアシステム

ハードウェアシステムは実験に使用するハードウェア全体を定義するもの

で、ECU（実験ターゲット）についての定義や ECU 間インターフェース

（バスシステム）の記述などで構成されます。

バイパス実験

バイパス実験においては、ECU プログラムの一部が実験ターゲット

（ES900、ES800）上で実行されます。バイパス実験を行うためには、

ECU プログラム内に専用のフックルーチンを挿入する必要があります。

INTECRIO V5.0 は、CAN ／ UDP を用いた XCP バイパスや、フックド

ベース／サービスベースの ETK ／ XETK ／ FETK バイパスをサポートし

ています。
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ファンクション

ソフトウェアシステムをグルーピングするためのアイテムで、ファンク

ション自体に機能はありません。1 つのファンクション内には複数のモ

ジュールが組み込まれ、接続されています。関連するモジュールをファン

クションにまとめることにより、モデル機能を明確に把握でき、再利用も

しやすくなります。

フルパス実験

フルパス実験においては、ECU プログラム全体が実験ターゲット上で実

行されます。

プロジェクトインテグレータ

プロジェクトインテグレータは、システムのすべてのコンポーネント（モ

ジュールとファンクション、ハードウェアインターフェース、OS コン

フィギュレーションなど）を結合して 1 つの実行ファイルを生成します。

プロジェクトコンフィギュレータ

INTECRIO の統合プラットフォームの一部。ソフトウェアシステムとシス

テムプロジェクトを設定する際に使用されます。

プロセス

オペレーティングシステムにより起動され、並行的に実行できる機能単

位。プロセスはモジュール内に記述し、引数（入力）や戻り値（出力）を

持ちません。

プロセッサ

「CPU」を参照してください。

プロトタイプ

実験ターゲットシステム用の実行ファイル。プロトタイプには ECU ファ

ンクションが実行可能なコードとして書き込まれていますが、その構成と

目的は、最終的な製品用のものとは異なります。

モジュール

INTECRIO のモジュールは、ECU ファンクションが汎用的に記述された

ものです。1 つのモジュールは、1 つの ASCET プロジェクトや Simulink
モデルに相当します。

ラピッドプロトタイピング

実験ターゲット（車両インターフェースを持つコンピュータ）上でソフト

ウェアを実行して、制御アルゴリズムの検証と妥当性評価を行うこと。

ランタイム環境

「RTE」を参照してください。

ランナブルエンティティ

「RE」を参照してください。

レガシー AUTOSAR モジュール（または レガシー SWC）

V5.0.0 以前の INTECRIO にインポートされた AUTOSAR モジュール

ワークスペース

ワークスペースにおいて、INTECRIO での作業で生成されたすべてのデー

タが管理され、結合されます。WS ブラウザ（ワークスペースブラウザ）

のツリービューから、INTECRIO のすべてのアイテムを開くことができま

す。
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